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The Living Image® software controls image acquisition on the IVIS® Imaging System. 
The application provides tools for optimizing image display and analyzing image data.

1.1 What’s New In the Living Image 3.1 Software

Improvements in the Living Image software include:

New Feature or Tool Description See Page

Auto exposure for 
luminescent or 
fluorescent imaging

The Living Image software determines the required 
settings to produce an image with a signal that 
achieves, as closely as possible, a user-specified count. 
You select the imaging parameters, the order of the 
parameters used, and the range of parameter 
adjustment for the auto exposure. 

13

185

Imaging Wizard Guides you through the steps to set up an application-
specific bioluminescent or fluorescent image sequence. 
The wizard includes a powerful graphical editor for 
selecting excitation and emission filters. 

23

Colorize tool Renders luminescent or fluorescent data in color 
enabling the display of intensity and spectral data in the 
same view.

63

Transillumination 
Overview tool

The software creates a single view of each excitation/
emission filter pair of images in a FLIT sequence (one 
image per filter pair). The software displays the 
overview in photons or counts. The ROI tools are 
available in the transillumination overview.

65

New Image Sequence 
Views

Apply an individual color scale to each thumbnail of the 
sequence.

182

New ROI features Display ROI measurements in photons or counts. 183

Choose the default ROI line color on a luminescent or 
fluorescent image.

186

Automatically draw ROIs on sequence thumbnails. 76

Export grid ROI measurements to a spreadsheet 
application such as Microsoft® Excel®.

93

Set user-modifiable auto-ROI parameters. 72

New Living Image 
browser features

Show or hide image data preview. 32

Remove user-selected data from the browser (unless 
the data is open in the Living Image software).

37

Open data is highlighted in green in the browser. 37
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1.2  About This Manual

This user manual explains how to acquire images on an IVIS® Imaging System and 
analyze image data. The manual provides detailed instructions and screenshots that 
depict the system response.

NOTE
Sometimes the screenshots in the manual may not exactly match those displayed on 
your screen.

For more details on the IVIS Imaging System, please see the appropriate IVIS Imaging 
System Hardware Manual.

Conventions Used In 
the Manual Convention Example

Menu commands are bolded. To open image data, select File ➞Open Dataset on the 
main bar.

Toolbar button names are bolded. To open image data, click the Open Dataset button 
.

Numbered steps explain how to 
carry out a procedure.

1. To start the Living Image software, click the  
icon on the desktop.

A dash (—) precedes the 
description of the system 
response to a procedure.

— The main window appears.

Document names are italicized. Living Image Software User’s Guide

Note information NOTE
A note presents pertinent details on a topic.

or 

Note: Notes also appear in this format.

Caution information CAUTION!
CAUTION!  A caution note warns you that your 
actions may have nonreversible consequences 
or may cause loss of data.

Important information IMPORTANT!
ALERT!  Important information advises you of 
actions that are essential to the correct 
performance of the instrument or software.
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Living Image Help There are several ways to obtain help on the software features:

• To view a tooltip about a button function, put the mouse cursor over the button.

• To view a brief description about an item in the user interface, click the  toolbar 
button, then click the item.

• Press F1 or select Help → User Guide on the menu bar to display the Living Image 
3.1 Software User’s Manual (.pdf).

1.3 Contacting Caliper Technical Support

If you need technical support, please contact Caliper at:

Telephone: 1.877.LabChip (877.522.2447) Toll Free in the United States)

1.508.435.9761 

E-mail: tech.support@caliperls.com

Fax: 1.508.435.0950

Address: Caliper Life Sciences

68 Elm Street

Hopkinton, MA 01748

USA
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2 Getting Started

Overview of Imaging & Image Analysis .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  5
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Living Image Help .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 10

This chapter provides a brief overview of images and image analysis. It also explains 
how to start the Living Image® software.

2.1 Overview of Imaging & Image Analysis

For bioluminescence imaging, the imaging system acquires a photographic image and a 
bioluminescence image. The Living Image software automatically coregisters the 
images to generate an overlay image (Figure 2.1). For fluorescence imaging, the IVIS® 
imaging system acquires a photographic and fluorescence image that are used to 
generate an overlay image. 

Figure 2.3 shows an example workflow on an IVIS® Imaging System.

Table 2.1  Images used to generate an overlay image

Image Type Description

Photographic A short exposure of the subject illuminated by the lights located at the 
top of the imaging chamber (Figure 2.2). The photographic image is 
displayed as a grayscale image.

Bioluminescence A longer exposure of the subject taken in darkness to capture low level 
bioluminescence emission. The bioluminescence image is displayed in 
pseudocolor that represents intensity (Figure 2.1). For more details on 
bioluminescence image data, see Appendix D, page 197.

Fluorescence An exposure of the subject illuminated by filtered light. The target 
fluorophore emission is captured and focused on the CCD camera. 
Fluorescence image data can be displayed in units of counts or photons 
(absolute, calibrated), or in terms of efficiency (calibrated, normalized). 
For more details on fluorescence image data, see Appendix F, 
page 209
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Figure 2.1  Example bioluminescence overlay image 
The Living Image® software automatically coregisters the photographic and bioluminescence 
images to generate the overlay image.

Figure 2.2  IVIS® Imaging System 100 Series, interior view. 

Photographic image Bioluminescent image Overlay image

Illumination LEDs

Camera lens opening

Sample stage
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Figure 2.3  Example imaging and analysis workflow

➊ Start the Living Image® software. In the control panel 
that appears, initialize the IVIS® imaging system.

➌ To set up a single image, choose Auto exposure and 
set the other imaging parameters in the control panel.

➍ Acquire the image(s).
➎ View the image(s). Use the tool palette to: 

• Analyze an image (Table 2.2)

• Analyze an image sequence (Table 2.3)

To set up an image sequence, 
step through the imaging wizard.

or

➋ Confirm the default user preferences or specify 
new preferences.

Tool 
palette
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Table 2.2  Image analysis tools

Tool Palette Use The Tools to... See Page

Image Adjust • Tune the photograph brightness, gamma (similar to contrast), or opacity
• Set the image display color scale min and max
• Select a color table for image display

52

Corrections/Filtering • Subtract dark background from the image data
• Apply flat field correction to the image data
• Specify pixel binning
• Smooth the pixel signal

55

Image Information • Display x,y coordinates and intensity data at a user-selected location on the image
• Display a histogram of pixel intensities in an image
• Plot the intensity (y-axis) at each pixel (x-axis) along a user-specified line in the image
• Measure distance in an image

56

ROI • Measure counts or photons in a user-specified region of interest (ROI) and compute 
measurement statistics (for example, average, min, max, standard deviation)

• Measure efficiency in the ROI and compute measurement statistics (for fluorescent 
images only)

69

Table 2.3  Analyzing image sequences

Analysis Description Wizard Setup See Page

Planar Spectral Image 
Analysis

Determines the average depth and total photon flux of a 
bioluminescent point source in a user-specified region of interest. 
Analyzes a sequence of bioluminescent images acquired using 
different emission filters.

Yes 107

Image Math A method for mathematically combining two images (add, multiply, or 
subtract). Use image math to:

• Remove autofluorescence from a fluorescent image
• Display multiple bioluminescent or fluorescent images on the same 

photographic image so that you can view multiple reporters in one 
image

No 104

Spectral Unmixing Removes tissue autofluorescence from a fluorescence image. 
Analyzes a sequence of fluorescence images acquired using the 
fluorophore excitation filter and several different emission filters. 
Spectral unmixing can be applied to images acquired using epi-
illumination (excitation light above the stage) or transillumination 
(excitation light below the stage).

Yes 113

Point Source Fitting Estimates the optical properties of tissue, the location and power of 
a point source, or the fluorescent yield of fluorophores.

Yes 129

3D Fluorescence 
Imaging Tomography 
(FLIT™)

A 3-dimensional reconstruction of the image (tomographic analysis) 
that estimates the location and intensity of a fluorescent light-
emitting source. Analyzes a sequence of fluorescent images acquired 
on the IVIS Spectrum at different transillumination points (excitation 
light below the stage).

Yes 138

3D Diffuse 
Luminescence 
Tomography (DLIT™)

A 3-dimensional reconstruction of the subject (tomographic analysis) 
that estimates the depth and intensity of a bioluminescent light-
emitting source.

Yes 142



9

Living Image® Software User’s Manual

2.2 Starting the Living Image® Software

For information on installing the software, see the Installation Guide included on the 
Living Image CD ROM. By default, the software is installed at:

PC: C:Programs:Xenogen:Living Image 3.1

Macintosh: Applications:Xenogen:LivingImage 3.1

NOTE
All components of the IVIS® Imaging System should be left on at all times due to the 
long cooling time required to reach operating (demand) temperature. It is also 
important to leave the system on to enable automatic overnight electronic background 
measurements. Periodically rebooting the computer is permissible and does not affect 
the camera operation.

To start the software:

1. PC Users: Click the Windows Start menu button  and select All Programs → 
Living Image. Alternatively, click the Living Image® software desktop icon .

Macintosh Users: Click the Living Image software desktop icon  or run the 
software from the application folder.
- The main window appears.

2. Select a user ID from the drop-
down list or enter a new User ID 
(up to three letters), and click OK.
- The control panel appears if the 

workstation controls the IVIS 
Imaging System (see next page).
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NOTE
The Living Image® software on the PC workstation that controls the IVIS® Imaging 
System includes both the acquisition and analysis features. The Living Image software 
on other workstations includes only the analysis features. Macintosh users have 
access to only the analysis features of the Living Image software.

2.3 Living Image Help
There are several ways to obtain help on the software features:

• To view a tooltip about a button function, put the mouse cursor over the button.

• To view a brief description about an item in the user interface, click the  toolbar 
button, then click the item.

Press F1 or select Help → User Guide on the menu bar to display the Living Image 3.1 
Software User’s Manual (.pdf).

Menu bar (for more details, see Appendix I, page 243)

Toolbar 

If the workstation controls the IVIS Imaging System, the acquisition 
control panel (for more details, see Appendix A, page 177).
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3 Initializing the System & Acquiring Images

Initializing the IVIS Imaging System  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 11
Checking the System Temperature   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 12
About the IVIS Acquisition Control Panel & Auto Exposure Feature   .  .  .  .  .  .  .  .  .  .  . 13
Acquiring a Single Bioluminescence Image   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 14
Acquiring a Single Fluorescence Image With Epi-Illumination .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 17
Acquiring a Fluorescence Image With Transillumination .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 19
Setting Up an Image Sequence .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 21
Acquiring an Image Sequence  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 30
Manually Setting the Focus  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 32
Manually Saving Image Data  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 33
Exporting Image Data   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 34

The IVIS® Imaging System is ready for image acquisition after the system is initialized 
and the operating (demand) temperature of the CCD camera is reached (locked). The 
Living Image® software on the PC workstation that controls the IVIS Imaging System 
includes both the acquisition and analysis features. The Living Image software on other 
workstations includes only the analysis features.

3.1 Initializing the IVIS Imaging System

The imaging system must be initialized each time the Living Image® software is started 
or if the power has been cycled to the imaging chamber or the camera controller (a 
component of some IVIS systems). The initialization procedure moves every motor-
driven component in the system (for example, stage and lens) to a home position, resets 
all electronics and controllers, and restores all software variables to the default settings. 
Initialization may be useful in error situations. For further details on instrument 
operation, see the hardware manual for your IVIS Imaging System.

To initialize the imaging system:

1. Start the Living Image software (double-click the  icon on the desktop).

2. In the control panel that appears, click Initialize.
- You will hear the motors move.
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NOTE
The control panel is only available on the workstation that controls the imaging 
system. The items available in the IVIS System control panel depend on the particular 
IVIS Imaging System and the imaging mode selected (luminescent or fluorescent, 
Image Setup or Sequence Setup mode).

3.2 Checking the System Temperature

The temperature box in the IVIS acquisition control panel indicates the temperature 
status of the charge coupled device (CCD) camera (Figure 3.1). After you initialize the 
system, the temperature box turns green when the temperature is locked at the demand 
temperature (-90°  C or -105°  C for IVIS Systems cooled by a Cryotiger® unit), 
indicating the instrument is ready for operation.

The demand temperature for the CCD camera is fixed. Electronic feedback control 
maintains the CCD camera temperature to within a few degrees of the demand 
temperature. 

The default stage temperature on the IVIS® imaging system is 37°  C, but may be set to 
a temperature from 25-40°  C.

Figure 3.1  IVIS acquisition control panel

Temperature box color indicates:

System not initialized.

System is initialized, but CCD camera 
temperature is out of range.

System is initialized and CCD camera is at or 
within acceptable range of the demand 
temperature and locked. The system is ready 
for imaging.

Click the temperature box to 
view the demand and 
measured temperatures of 
the CCD camera and stage.
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NOTE
The items in the IVIS System control panel depend on the particular IVIS Imaging 
System and the imaging mode selected (luminescent or fluorescent, Image Setup or 
Sequence Setup mode). For more details on 

3.3 About the IVIS Acquisition Control Panel & Auto Exposure Feature

The control panel (Figure 3.2) provides the image acquisition functions. For details on 
the imaging parameters in the control panel, see Appendix A, page 177.

The auto exposure setting is useful in situations where the signal strength is unknown or 
varies widely, for example during a time course study. When you choose auto exposure 
(Figure 3.2), the system acquires an image at maximum sensitivity, then calculates the 
required settings to achieve, as closely as possible, an image with a user-specified target 
max count. If the resulting image has too little signal or saturated pixels, the software 
adjusts the parameters and takes another image.

In most cases, the default auto exposure settings provide a good bioluminescence or 
fluorescence image. However, you can modify the auto exposure preferences to meet 
your needs. For more details, see page 185.

NOTE
The options available in the IVIS acquisition control panel depend on the selected 
imaging mode, the imaging system, and the filter wheel or lens option that are 
installed.

Figure 3.2  IVIS acquisition control panel, auto exposure selected

To acquire an image using auto exposure, 
click the  arrow and select Auto.

Luminescence 
imaging settings

Fluorescence 
imaging settings

Photographic 
imaging settings

Structured light 
imaging settings
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3.4  Acquiring a Single Bioluminescence Image

3. Put a check mark next to Luminescent.

4. Confirm that Excitation Filter setting is Block and the Emission Filter setting is 
Open.

5. Select the Auto exposure time (click the  arrow). Alternately, manually set the 
exposure, binning, and F/Stop. (For more details on the control panel settings, see 
page 177.)

6. Set the FOV: To adjust the field of view (FOV), make a selection from the Field of 
View drop-down list. For more details on FOV, see page 160.

NOTE
To view the subject(s) inside the chamber before image acquisition, take a 
photographic image (clear the luminescent or fluorescent option, choose the 
Photographic and Auto options, and click Acquire).

7. Set the focus: 

• Select use subject height from the Focus drop-down list and use the  arrows 
or the keyboard arrows to specify a subject height (cm). 
or

• Select Manual focus from the Focus drop-down list. (For more details on manual 
focusing see page 32.)

8. Set the photographic image settings:

a. Choose the Photographic option.

b. Enter an exposure time or choose the Auto option.

c. Confirm the binning and f/stop defaults or specify new settings for the photographic 
image.

1. Start the Living Image software (double-click the  icon on the desktop).

2. Initialize the IVIS System and confirm or wait for the CCD temperature to lock. (For 
more details, see page 11.)
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9. If necessary, click  in the control panel to operate in single image mode.

NOTE
In single image mode, the  button appears in the control panel. Click this 
button to set up sequence acquisition. (For more details on setting up a sequence, see 
page 21.)

10. When you are ready to acquire the image, click Acquire. During image acquisition, 
the Acquire button becomes a Stop button. To cancel the acquisition, click Stop. 
- The image window appears (Figure 3.3). If this is the first image of the session, you 

are prompted to choose an autosave location.

11. To specify a folder for autosaved data, click Yes in the prompt and choose a folder 
in the dialog box that appears.
- All images acquired during the session are automatically saved to this folder. You 

can choose a different folder at any time (select Acquisition → Auto-Save on the 
menu bar).

12. In the Edit Image Labels box that appears, enter information for the image label and 
click OK (Figure 3.3). If you do not want to enter label information, click Cancel.
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Figure 3.3  Image window & Edit Image Labels box

Tool 
palette

Color bar

Image 
label

Edit Image Labels box

In the color bar, check the image min and max to determine whether the signal of 
interest is above the noise level and below CCD saturation. A signal greater than 
600 counts and less than ~60,000 counts is recommended. If the signal level is 
unacceptable, adjust the exposure time or binning level. For more details on the 
image window, see Table 3.1, page 17.

Edit the label information here.
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3.5 Acquiring a Single Fluorescence Image With Epi-Illumination

Epi-illumination uses a excitation light source located above the stage. For more details 
on fluorescence imaging, see page 169.

1. Start the Living Image software (double-click the  icon on the desktop).

2. Initialize the IVIS System and confirm or wait for the CCD temperature to lock. (For 
more details, see page 11.)

3. Put a check mark next to Fluorescent.

4. Confirm that the Fluorescent Lamp Level is set to the appropriate level (High or 
Low).

5. Select the Auto exposure time (click the  arrow). Alternately, manually set the 
exposure, binning, and F/Stop. (For more details on the control panel settings, see 
page 177.)

6. Set the FOV: To adjust the field of view (FOV), make a selection from the Field of 
View drop-down list. For more details on FOV, see page 160.

Table 3.1  Image window

Item Description

Units Select the measurement units for the image display (counts or photons) from 
this drop-down list

Display Select the image type (for example, overlay) that you want to display from this 
drop-down list. For more details on the different types of image displays, see 
Figure 4.5, page 47.

Info Click to display or hide the image label information.

Opens a dialog box that enables you to export the active view as a graphic file.

Color bar Shows the minimum and maximum pixel intensities in the image as well as the 
color bar. Pixels less than the color bar minimum or greater than the color bar 
maximum are not displayed in the image.

Image label Information about the image that the software automatically records and user-
specified information entered in the Edit Image Label dialog box.
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NOTE
To view the subject(s) inside the chamber before image acquisition, take a 
photographic image (clear the luminescent or fluorescent option, choose the 
Photographic and Auto options, and click Acquire).

7. Set the focus: 

• Select use subject height from the Focus drop-down list and use the  arrows 
or the keyboard arrows to specify a subject height (cm). 
or

• Select Manual focus from the Focus drop-down list. (For more details on manual 
focusing see page 32.)

8. Set the photographic image settings:

a. Choose the Photographic option.

b. Enter an exposure time or choose the Auto option.

c. Confirm the binning and f/stop defaults or specify new settings for the photographic 
image.

9. If necessary, click  in the control panel to operate in single image mode.

NOTE
In single image mode, the  button appears in the control panel. Click this 
button to set up sequence acquisition. (For more details on setting up a sequence, 
see page 21.)

10. When you are ready to acquire the image, click Acquire. During image acquisition, 
the Acquire button becomes a Stop button. To cancel the acquisition, click Stop. 
- The image window appears (Figure 3.3). If this is the first image of the session, 

you are prompted to choose an autosave location.

11. To specify a folder for autosaved data, click Yes in the prompt and choose a folder 
in the dialog box that appears.
- All images acquired during the session are automatically saved to this folder. You 

can choose a different folder at any time (select Acquisition → Auto-Save on the 
menu bar).

12. In the Edit Image Labels box that appears, enter information for the image label and 
click OK (Figure 3.3). If you do not want to enter label information, click Cancel.
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3.6 Acquiring a Fluorescence Image With Transillumination

Transillumination uses a excitation light source located below the stage. For more 
details on fluorescence imaging, see page 169.

1. Start the Living Image software (double-click the  icon on the desktop).

2. Initialize the IVIS System and confirm or wait for the CCD temperature to lock. (For 
more details, see page 11.)

3. Put a check mark next to Fluorescent and Transillumination.

4. In the control panel, select an appropriate excitation filter and emission filter from 
the drop-down lists.

5. Click Setup.

6. In the Transillumination Setup box that 
appears, choose the locations for 
transillumination and image 
acquisition and click OK.

For more details on the 
Transillumination Setup box, see 
Table 3.2.
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7. Set the FOV: To adjust the field of view (FOV), make a selection from the Field of 
View drop-down list. For more details on FOV, see page 160.

NOTE
To view the subject(s) inside the chamber before image acquisition, take a 
photographic image (clear the luminescent or fluorescent option, choose the 
Photographic and Auto options, and click Acquire).

8. Set the focus: 

• Select use subject height from the Focus drop-down list and use the  arrows 
or the keyboard arrows to specify a subject height (cm). 
or

• Select Manual focus from the Focus drop-down list. (For more details on manual 
focusing see page 32.)

9. Set the photographic image settings:

a. Choose the Photographic option.

b. Enter an exposure time or choose the Auto option.

c. Confirm the binning and f/stop defaults or specify new settings for the photographic 
image.

10. If necessary, click  in the control panel to operate in single image mode.

NOTE
In single image mode, the  button appears in the control panel. Click this 
button to set up sequence acquisition. (For more details on setting up a sequence, 
see page 21.)

11. When you are ready to acquire the image, click Acquire. During image acquisition, 
the Acquire button becomes a Stop button. To cancel the acquisition, click Stop. 

Table 3.2  Transillumination Setup box

Item Description

Move Motors To 
Selected Spot

Transillumination motors will move to the grid location selected in the 
Transillumination Setup dialog box.

Transillumination 
Lamp Source

Choose this option to turn on the bottom illumination lamp.

Mask Grid points 
To Subject

Choose this option to select only the grid locations within the subject. 
Grid locations outside the subject are masked.

Grid Type Select a grid type from the drop-down list: 15x23, 11x23, 5x10, or 8x12 
wellplate, Xenogen Sparse Mask, 6x8x1cm.

Grid Display Select "Points" or "Cross Hair" to display the grid.

Update Photograph Click to acquire a new photographic image. If the chamber door is opened 
during transillumination setup, you are prompted to acquired a new 
photograph.

Clear Selections Clears selected/ highlighted transillumination locations on the grid.
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- The image window appears (Figure 3.3). If this is the first image of the session, you 
are prompted to choose an autosave location.

12. To specify a folder for autosaved data, click Yes in the prompt and choose a folder 
in the dialog box that appears.
- All images acquired during the session are automatically saved to this folder. You 

can choose a different folder at any time (select Acquisition → Auto-Save on the 
menu bar).

13. In the Edit Image Labels box that appears, enter information for the image label and 
click OK (Figure 3.3). If you do not want to enter label information, click Cancel.

3.7 Setting Up an Image Sequence

A sequence is a collection of images that are grouped together in a single folder. A 
sequence may include images that were acquired during the same session and were 
intended to be grouped together (for example, images taken at different exposure times 
or an image sequence for DLIT™ or FLIT™ 3-D tomographic analysis).

Images that were acquired during different sessions can also be grouped together to form 
a sequence. For example, a time series could be constructed from images acquired on 
different days following an experimental treatment. (For more details, see page 25.)

Some analyses are performed on an image sequence (see Table 3.3). The sequence 
requirements (number and type of images) depend on the analysis. The imaging wizard 
provides a convenient way to set up several types of image sequences (see page 23). 
You can also set up the sequence manually (see page 25). 
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Table 3.3  Application-specific image sequences

Analysis IVIS Imaging System

Lumina 100 
Series

200 
Series

Spectrum

Planar spectral image analysis

Computes the total flux and average depth of a 
bioluminescent source below the surface.

Optional T T

Display multiple fluorescent or bioluminescent 
reporters.

Uses the Image Overlay function to display multiple 
luminescent or fluorescent images on one 
photographic image.

T T T T

Subtract tissue autofluorescence using blue-
shifted background filters.

Uses the image math feature to subtract a 
background image from the primary image.

T T T T

Point Source Fitting

Estimates the optical properties of tissue, the 
location and power of a point source, or the 
fluorescent yield of fluorophores.

T T T

Spectral unmixing 

Removes tissue autofluorescence from a 
fluorescence image.

T

DLIT™ Analysis

Reconstructs the surface topography of the subject 
and the brightness and 3D location of 
bioluminescent sources.

T T

FLIT™ Analysis 

Reconstructs the surface topography of the subject 
and brightness and 3D location of fluorescent 
sources.

T
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Setting Up a Sequence 
Using the Imaging 
Wizard

The imaging wizard can automatically setup an image sequence for some applications 
that analyze an image sequence (Table 3.3). The wizard guides you through a series of 
steps, prompting you for the information that the software requires to set up the image 
sequence.

Table 3.4  Imaging wizard sequence options

Bioluminescence Acquires... Description  See 
Page

Image Sequence

Open Filter T Acquires an image at maximum sensitivity.

Planar Spectral T Analyze the sequence to compute the average depth and total 
photon flux of a bioluminescent point source in a region of interest 
(ROI).

107

Spectral 
Unmixing

T Analyze the sequence to determine spectral signature of different 
reporters in the same image and calculate the contribution of each 
reporter on each pixel in the image.

113

DLIT T Apply the DLIT™ algorithm to the sequence to reconstruct the 3D 
surface topography of the subject and the position, geometry, and 
strength of the luminescent sources.

137

Fluorescence Description See 
Page

2D T T Use the data to make fluorescence measurements. 

Filter Scan T Helps you determine the optimum excitation and emission filter for 
a probe.

Spectral 
Unmixing

T Analyze the sequence to extract the signal of one or more 
fluorophores from the tissue autofluorescence.

113

FLIT T Apply the FLIT™ algorithm to the sequence to reconstruct the 3D 
surface topography of the subject and the position, geometry, and 
strength of the fluorescent sources.

142
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To set up a sequence using the imaging wizard:

1. Click Sequence Setup in the IVIS acquisition control panel.
- The Sequence Editor appears.

4. If necessary, click  and select All to clear the Sequence Editor.

5. Click Imaging Wizard.

Sequence Editor

To begin setting up a bioluminescence 
image sequence, click here.

To begin setting up a fluorescence 
image sequence, click here.

6. Click Next.

Sequence Editor
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NOTE
The imaging options available in the imaging wizard depend on the IVIS imaging 
system and the installed filter set.

Manually Setting Up a 
Sequence

You can manually set up an image sequence in the control panel and save the 
information to a Xenogen Sequence Setup file (.xsq).

NOTE
To create an image sequence, it may be convenient to edit a sequence setup 
generated by the imaging wizard or an existing sequence setup (.xsq). Save the 
revised sequence setup to a new name.

1. Click Sequence Setup in the control panel.

7. Double-click the type of bioluminescence or fluorescence sequence that you want 
to acquire and step through the rest of the imaging wizard.
- The sequence setup appears in the Sequence Editor.

Imaging wizard - Bioluminescence Imaging wizard - Fluorescence
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2. If it is necessary to clear the sequence editor that appears, click  and 
select All.

3. In the control panel, specify the settings for the first bioluminescence or 
fluorescence image in the sequence and the photographic image. (For details on 
the imaging parameters in the control panel, see page 177.)

NOTE
If you choose the photograph Reuse option in the control panel, the IVIS® System 
acquires only one photographic image for the entire sequence. If this option is not 
chosen, the system acquires a photographic image for each image in the sequence.

4. Click .
- The acquisition parameters are added to the table. 

Sequence Editor

Reuse option
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5. Repeat step 3 to step 4 for each image in the sequence.

6. To specify a time delay between each acquisition, enter a time in the Delay (min) 
box in the Sequence Editor.

7. If you want to save the sequence setup information (.xsq):
a. In the sequence editor, click the Save button .

b. In the dialog box that appears, select a directory for the file, enter a file name, and click 
Save.

Click to include the parameter settings 
for the photographic image in the editor.

Each row in the editor specifies the acquisition 
parameters for one image in the sequence

The image(s) in the sequence editor comprise one segment. You can acquire multiple 
segments with a user-specified time delay between acquisitions. This is useful for 
acquiring data for kinetic analysis.
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Editing an Image 
Sequence

You can edit a parameter value, as well as add or remove images from the sequence. A 
shortcut menu of edit commands is available in the 

Table 3.5  Sequence Editor

Item Description

Starts the imaging wizard.

Displays a dialog box that enables you to select and open a sequence 
setup (.xsq), sequenceinfo.txt, or clickinfo.txt file.

Displays a dialog box that enables you to save a sequence setup (.xsq).

Display Photographic 
Settings

Choose this option to include the photograph exposure time, binning, 
and F/Stop in the sequence editor.

Number of Segments Choose this option to set the number of segments to acquire and the 
time delay between segments. One segment = the sequence 
specified in the sequence editor.

Delay Specifies a time delay between each segment acquisition.

Applies the selected cell value to all cells in the same column.

Deletes the selected row from the sequence editor.

Updates the selected row in the sequence editor with the acquisition 
parameters in the control panel.

Changing an Imaging Parameter

1. In the sequence editor, double-click the cell that you want to edit.

2. Enter a new value in the cell or make a selection from the drop-down list.

3. To apply the new value to all of the cells in the same column, click .

4. Click outside the cell to lose focus.

Editing a parameter using the control panel
1. In the sequence editor, select the row that you want to modify.

2. In the control panel, choose new parameter values and/or imaging mode.

3. Click .

Control panel Sequence editor

For details on these functions, see Table 3.5.



29

Living Image® Software User’s Manual

Adding or Deleting Images From a Sequence

Alternate method to add a row:

1. In the sequence editor, select the row next to where you want to insert the image.

2. Set the imaging mode and parameters in the control panel.

3. To insert the new image above the selected row, click . To insert the new 
image below the selected row, click .

Inserts a row above the currently selected row using the information 
from the control panel.

Adds a new row below the currently selected row using information 
from the control panel.

Table 3.6  Sequence editor, shortcut menu edit commands

Command Description

Copy row(s) Copies the selected row(s) to the system clipboard.

Select All Selects all rows in the sequence editor.

Delete row(s) Deletes the selected row(s) from the sequence editor.

Replace Row(s) Replaces the row(s) selected in the sequence editor with the rows in the 
system clipboard. 

Note: The Replace function is only available when the number of rows in 
the system clipboard is the same as the number of rows selected in the 
sequence editor.

Paste Row(s) Adds copied rows to end of the sequence.

Table 3.5  Sequence Editor

Item Description

1. Select the row(s) of interest and right-click the sequence editor to view a shortcut 
menu of edit commands (see Table 3.6).
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Alternate method to delete one or more rows:

1. Select the row(s) that you want to delete.

2. Click  and choose Selected from the drop-down list.

To clear the sequence editor:

1. Click .

2. Choose All from the drop-down list.

3.8 Acquiring an Image Sequence

The system is ready to acquire the image sequence after you set up the image sequence 
in sequence editor. 

1. Initialize the IVIS® System and confirm or wait for the CCD temperature to lock. (For 
more details, see page 11.)

2. When you are ready to acquire the images, click Acquire Sequence in the control 
panel.
- Thumbnail images appear as the images are acquired. During acquisition, the 

Acquire Sequence button becomes a Stop button. To cancel the acquisition, 
click Stop.

Thumbnail images

Tool palette
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3. If this is the first acquisition of the 
session, you are prompted to 
choose an autosave location. 

4. To specify a folder for autosaved data, click Yes in the prompt and choose a folder 
in the dialog box that appears.
- All sequences acquired during the session are automatically saved to this folder. 

You can choose a different folder at any time (select Acquisition → Auto-Save 
on the menu bar).

5. In the Edit Image Labels box that appears, enter information for the image label and 
click OK (Figure 3.3). If you do not want to enter label information, click Cancel.

Figure 3.4  Image window & Edit Image Label box

Open an image (double-click the thumbnai
determine whether the signal of interest i
above the noise level and below CCD 
saturation. 

Check the image min and max in the color 
A signal greater than 600 counts and less t
~60,000 counts is recommended. If the sig
level is unacceptable, adjust the exposure
time or binning level.

For more details on the image window, see 
Table 3.7

Image label

Edit the label information here.
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3.9 Manually Setting the Focus

The IVIS Imaging System automatically focuses the image based on subject height (see 
page 179). If you do not want to use the automatic focus feature, you can manually set 
the focus.

1. In the control panel, choose Manual Focus in the Focus drop-down list.
- The Manual Focus window appears.

Table 3.7  Image window

Item Description

Units Select the measurement units for the image display (counts or photons) from 
this drop-down list

Display Select the image type (for example, overlay) that you want to display from this 
drop-down list. For more details on the different types of image displays, see 
Figure 4.5, page 47.

Info Click to display or hide the image label information.

Opens a dialog box that enables you to export the image or thumbnails to a 
graphic file (for example, .bmp or DICOM format)

Creates a preview picture of the image or thumbnails that the Living Image 
browser displays when the data is selected.

Color bar Shows the minimum and maximum pixel intensities in the image as well as the 
color bar. Pixels less than the color bar minimum or greater than the color bar 
maximum are not displayed in the image.

Image label Information about the image that the software automatically records and user-
specified information entered in the Edit Image Label dialog box.

Preview picture of the selected data
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2. To mark the center of the camera in the window, put a check mark next to Display 
CCD Center.

3. Select the size of the step increment that the stage moves: Coarse, Normal, or 
Fine. 

4. Click Up or Down to move the stage and change the focus.

5. If necessary, select another F/stop setting from the drop-down list and adjust the 
light level using the  arrows.

6. Click Update to apply the settings.
- The resulting focal plane (cm above the stage) is automatically entered in the 

Subject height box.

7. Click OK when the image is focused.

3.10 Manually Saving Image Data

When you acquire the first image(s) of a session, the autosave feature prompts you to 
choose the folder where you want to save image data. During the session, all images 
will be saved to this folder. You can change the autosave folder at any time (select 
Acquisition → Auto-Save To on the menu bar). If you do not want to use the autosave 
feature, you can manually save data.

1. Turn off the autosave feature: select Acquisition on the menu bar and remove the 
check mark next to Auto Save.

2. After you acquire an image or image sequence, click the Save button . 
Alternatively, select File → Save on the menu bar. 

3. In the dialog box that appears, select a directory of interest and click OK.

NOTE
The software automatically includes the user ID, and a date and time stamp with the 
data.
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3.11  Exporting Image Data

You can export the image data in different file formats (for example, .bmp, .dcm).

1. Click the Export Graphics button .

2. In the dialog box that appears, select a directory, choose a file type, and enter a file 
name.

3. Click Save.

NOTE
When you export to DICOM (.dcm) format, a directory that contains the .dcm files and 
a SequenceInfo.txt is created at the specified location.
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4.1 Browsing & Opening Image Data

The Living Image® Browser provides a convenient way to browse and preview image 
data, view information about the data, and open a single image or an image sequence. 
You can also navigate to an image or sequence of interest and open it without the 
browser (see page 39).

Browsing Image Data

NOTE
The next time you start the Living Image software and open the Browse For Folder 
box, the software automatically returns to the last folder visited.

1. Click the Browse button . Alternatively, select File → Browse from the menu bar.

2. In the Browse for Folder box that appears, select the data of interest and click OK.
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Table 4.1  Living Image® browser

Item Description

Hide Browse View Closes the browser table.

Close Preview Closes the image preview box.

Label Set A drop-down list of the available label sets which specify image 
information (column headers) that is displayed in the Living Image 
browser.

Add to List If you choose this option, the data that you select in the Browse for 
Folder box is added to the Living Image browser. If this option is not 
chosen, the data that you select in the Browse for Folder box replaces 
the contents of the Living Image browser.

Browse Opens the Browse For Folder box.

3. The selected data are displayed in the Living Image browser along with the user ID, 
label information, and camera configuration information. 

 - an image 
 - an image sequence

4. Click the + sign to display the data in a sequence. To view data properties, right-
click an image or sequence and select Properties on the shortcut menu.
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Opening Image Data You can open image data from the Living Image browser, the toolbar, or the menu bar. 
Multiple images or sequences can be open at the same time.

NOTE
To open recently viewed files, select File → Recent Files on the menu bar.

Load as Group Enables you to select particular images that you want to view as a 
sequence. The images may be acquired during different sessions.

To select adjacent images in the browser, press and hold the Shift 
key while you click the first and last file in the selection. 

To select non-adjacent images in the browser: 

PC users: Press and hold the Ctrl key while you click the images 
in the browser
Macintosh users: Press and hold the Cmd key (apple key) while 
you click the images in the browser. 

Note: The Load as Group option is only available when two or more 
images are selected in the browser.

Load Opens the selected image or image sequence.

Remove Removes a user-selected image sequence(s) from the browser.

Close Closes the Living Image browser.

Table 4.1  Living Image® browser

Item Description

To open images using the Living Image browser:

1. To show the images in a sequence, click the + sign next to a sequence ( ).

2. To open an image or a sequence, do one of the following:

•Double-click the image name  or sequence name . 

•Right-click the image or sequence and select Load on the shortcut menu

•Select the image or sequence row and click Load.
- The image(s) and tool palette are displayed. In the browser. 0pen sequences or 

images are highlighted in green in the browser.
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3. To open an image from the image sequence, double-click the thumbnail.
To open all images in a sequence, click the Display All button .
To close all images, click the Hide button .

For more details on working with a sequence in the image window, see page 40.

For more information on the tool palette, see page 40.

The image window displays thumbnails of 
sequence images using a single color table. 

Double-click a thumbnail to open the image
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NOTE
To open a recently viewed files, select File → Recent Files on the menu bar.

To open images from the menu or tool bar:

1. Click the Open button  on the toolbar. Alternately, select File → Open on the 
menu bar.

2. In the Open box that appears, 
double-click the file of interest. 
Alternately, select the data and 
click Open.

File types:
Click*.txt - an image 
(Living Image file format)
Sequence*.txt - am image 
sequence (Living Image 
file format)
*.dcm - DICOM file
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4.2  The Tool Palette

The tool palette contains information about the active image(s) and organizes the image 
analysis tools. The tools available in the tool palette depend on whether an image or an 
image sequence is active. 

4.3 Working With an Image Sequence

An image or image sequence is displayed in an image window. Multiple image 
windows can be open at the same time. The options available in the image window and 
tool palette depend on whether an image or an image sequence is displayed.

When you open an image sequence, the image window displays thumbnails of the 
images in the collection. A single color table is applied to the images. (For details on 
how to open an image sequence using the Living Image browser, see page 37.)

Figure 4.1  Tool palette

Click to expand a tool.
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If DLIT™ or FLIT™ analysis results are loaded, click the 3D View tab to display the 3D 
reconstruction of the luminescent sources (IVIS® Imaging System 200 or Spectrum 
only). For more details on 3D reconstruction, see page 137.

Figure 4.2  Image window, sequence view 

Figure 4.3  Image window, 3D view

For details on these items, see Table 4.2

Choose Individual to 
apply a separate color 
scale to each 
thumbnail in a 
sequence.
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Editing an Image 
Sequence

You can add individual images to a sequence or remove user-specified images from a 
sequence.

Table 4.2  Image window, sequence view tab

Item Description

Units Choose counts or photons for the image data from the drop-down list. For 
more details on counts and photons, see Appendix D, page 199.

Use Saved Colors Choose this option to display an image using the color table that was last 
applied to the image data.

Info Click to show or hide the sequence information.

Click this button to open all images in a sequence.

Click this button to close all open images in the active sequence.

Click this button to open the Edit Sequence window that enables you to 
add or remove images from the active sequence. For more details on 
editing a sequence, see page 42.

Click this button to acquire a preview of the sequence for display in the 
Living Image browser.

1. Open the image sequence that you want to edit. (For details on how to open image 
data, see page 37).

2. If you plan to add images to the sequence, browse for the images that you want to 
add in the Living Image® browser. (For more details on browsing, see page 35.)
Note: Only individual images, not an image sequence, can be added to a sequence.

3. In the image window, click the Edit button .
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7. To restore a retired image to the sequence, select the retired image and click 
Reactivate.

8. When you are finished editing the sequence, click Close.
- The updated image sequence is displayed.

4.4 Creating an Image Sequence from Individual Images

You can create a sequence from images acquired during different sessions.

1. In the Living Image® Browser, browse for the images of interest. (For more details 
on browsing, see page 35.)

NOTE
Browse for individual images (which may or may not be part of a sequence), not image 
sequences.

Single images in the 
Living Image Browser 

Images that have 
been removed from 
the active sequence

Images in the 
active sequence

4. In the Edit Sequence box that appears, choose the image(s) that you want to add or 
remove from the sequence. 

5. To add an image to the 
sequence, select an 
image and click Copy.

6. To remove an image from the sequence, select an image and click Retire.
- The image is removed (retired) from the sequence.
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2. In the browser, select the images that you want to group together.

•To select adjacent images in the browser, press and hold the Shift key while you 
click the first and last file in the selection. 

•To select non-adjacent images in the browser: 
PC users - Press and hold the Ctrl key while you click the images of interest in the 
browser. 

Macintosh users - Press and hold the Cmd key (apple key) while you click the 
images of interest in the browser.

3. Click Load as Group.
- The image thumbnails are displayed together in an image window.
For details on how to save or export the image data, see Chapter 3, page 33.

Individual images (highlighted blue in this example) that may or may not be part of a 
sequence can be selected for grouping into a new sequence.

Images loaded in the browser as part of a sequence (highlighted pink in this 
example). These images cannot be selected for grouping into another sequence.
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4.5 Working With a Single Image

Table 4.3 explains the items in the image window. For details on how to browse data and 
open images, see page 35.

Figure 4.4  Image window, overlay display mode

To display or hide the image 
information, click Info.

Select a display mode from the drop-down list.Choose the image display units.
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Table 4.3  Image window

Item Description

Units Choose counts or photons from the drop-down list for the image data. 
For more details on counts and photons, see Appendix D, page 199.

Display To choose an image display mode in the image window, make a 
selection from the Display drop-down list. See Figure 4.5 for examples 
of the display modes. 

Overlay A pseudocolor image of luminescent or fluorescent image data displayed 
over a grayscale photographic image.

Photograph A grayscale image that is captured when the IVIS® Imaging System 
illumination lights are activated.

Luminescent A pseudocolor image of the luminescent or fluorescent data captured 
during an exposure when the IVIS Imaging System illumination lights are 
off.

Fluorescent A pseudocolor image of the fluorescent data captured during an 
exposure when the IVIS Imaging System illumination lights are off.

Background The CCD camera background acquired with the camera shutter closed. 
(See Appendix E, page 203.)

Bias An electronic offset that exists on every pixel. This means that the zero 
photon level in the readout is not actually zero, but is typically a few 
hundred counts per pixel. The read bias offset is reproducible within 
errors defined by the read noise, another quantity that must be 
determined for quantitative image analysis.

Saturation Map Displays image regions that saturated the CCD digitizer (>65535 counts) 
in red. ROI measurements should not be made on saturated regions. 
ROI measurements made on image regions that do not contain 
saturated pixels are accurate (unless the image is badly saturated).

Structure A structured light image of parallel laser lines scanned across the 
subject. (Available in the IVIS® Imaging System 200 Series and IVIS 
Spectrum.) The surface topography of the subject is determined from 
the structured light image.

Reference A structured light image of a white plate that is acquired and stored on 
disk prior to instrument installation.

3D View A three-dimensional rendering of the subject. For more details see 
Appendix H, page 233.

Export Opens the Export Active View As Image box so that the active image 
data can be exported (bmp, jpg, png, tiff, or postscript format).

Info Click to display or hide information about the image in the image 
window.
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Figure 4.5  Display modes for a single image
The software coregisters the luminescent and photographic image to generate the overlay image.

Overlay Luminescent

Height Map

Structure Reference

3D View

Photograph

Bias
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Tagging an Image An image tag displays the x,y pixel coordinates of the location, and the pixel intensity 
(z, counts or photons). You can apply a tag at a user-specified location in an image. 

Organizing Images When multiple image windows are open, you can organize them in a cascade or tile 
arrangement.

To apply a tag:

1. Right-click a location in the image. 

2. Select Insert Tag on the short cut menu.

To remove a tag: 

1. Position the pointer over the tag.

2. Right-click the image and select Remove 
Tag on the shortcut menu. 

3. To remove all tags, right-click the image and 
select Remove All Tags on the shortcut menu.

To move a tag: 

1. Position the pointer over the tag.

2. When the hand tool appears , use a click-
and-drag operation to move the tag, then 
click the mouse to set the tag location.
- A line between the pixel and the tag identifies 

the location associated with the tag.

To tile the open 
image windows, 
choose Window → 
Tile on the menu 
bar.
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4.6 Viewing Image Information

At acquisition, the software captures image information that includes all of the text 
information that is associated with every image (for example, camera parameters and 
user labels).

To organize the image 
windows in a 
cascade, choose 
Window → Cascade 
on the menu bar.

Click Info to display the label set information and acquisition information for the image.

Label set 
information 
& 
acquisition 
parameters
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To view information about an image:

1. Open the image or image sequence of interest. (For details on how to open data, 
see page 35).

2. Select View → Image Information on the menu bar.
- The Image Information window appears.

3. To choose an image, make a selection from the Sequences drop-down list and the 
Images drop-down list.

Drop-down list of images in the selected 
sequence. Or a list of single images if 
“Individual Images” is selected in the 
Sequences drop-down list.

Drop-down list of open sequences. 
Choose Individual Images from the 
list to show the open single images 
in the Images drop-down list.

4. To view information of interest, select a category in the upper box to show the 
associated information in the lower box. For example, select luminescent image in 
the upper box to show the luminescent image acquisition parameters in the lower 
box.
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Editing the Image 
Label

You can edit the image label information after acquisition.

1. Open an image.

2. Select Edit → Image Labels on the 
menu bar.

3. In the Edit Image Labels box that appears, 
edit the information of interest. You can 
also select a new label set to apply to the 
image or sequence.

4. When you are finished, click OK.
- The image information is updated.
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4.7  Adjusting Image Appearance

Use the image adjust tools to adjust the appearance of an image (Figure 4.6).

NOTE
Not all tools are available for all image display modes.

Figure 4.6  Tool palette, Image Adjust tools 

Table 4.4  Image Adjust tools

Item Description

Click this button to incrementally zoom out on the image (reduces the 
image dimensions in the image window). Note: The zoom tools are also 
available in the shortcut menu when you right-click the image (Ctrl-click 
for Macintosh users).

Click this button to incrementally zoom in on the image (incrementally 
magnifies the image in the image window).

Click this button to magnify the area inside a rectangle that you draw using 
a click-and-drag operation. (Sets the dimensions of the magnified area 
equal to image window dimensions.)

Click this button to return the image to the default display magnification.

Click this button to move a magnified image (pan) in the image window. 
For more details, see page 54.

Click this button to hide or display the image min/max information in the 
image window

Image data 
Min & Max

Color bar 
Min & Max

Color bar
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Click this button to hide or display the color scale in the image window

Click this button to hide or display the color scale min/max information in 
the image window

Photo 
Adjustment

Brightness Click and move the slider left or right to adjust the brightness of an image 
displayed in overlay or photograph mode. Alternatively, enter a brightness 
value.

Gamma Click and move the slider left or right to adjust the gamma of a image 
displayed in overlay mode. Alternatively, enter a gamma value. (Gamma is 
related to image contrast.)

Opacity Click and move the slider left or right to adjust the opacity of the 
pseudocolor luminescent data of an image displayed in overlay mode. 
Alternatively, enter an opacity value.

Color Scale

Min The minimum pixel intensity associated with the color bar for an image. 
Pixels less than the minimum value are not displayed.

Max The maximum pixel intensity associated with the color bar for an image. 
Pixels greater than the maximum value are not displayed.

Limits

Auto When this option is chosen, the software sets the Min and Max values to 
optimize image display and suppress background noise. The Min and Max 
settings can be manually adjusted to further optimize the image display for 
your needs.

Full Choose this option to set the Max and Min values to the maximum and 
minimum data values in the image.

Manual Choose this option to enter Max and Min values for the image display.

Individual Applies a separate color table to each image in a sequence. Note: This 
option is only available when an image sequence is active.

Color Table Click the drop-down arrow to select a color table for the image data. (For 
more details on color tables, see Pseudocolor Images, page 197.)

Reverse Choose this option to reverse the selected color table.

Logarithmic Scale Choose this option to apply a log scale to the relationship between 
numerical data and the color range in the color table. A log scale increases 
the range of meaningful numerical data that can be displayed.

Table 4.4  Image Adjust tools

Item Description
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Magnifying or Panning 
in the Image Window To incrementally zoom in or out on an image:

•Click the  or  button. Alternatively, right-click the image and select Zoom In or 
Zoom Out on the shortcut menu.

To magnify a selected area in an image:

1. Click the  button. Alternatively, right-click the image and select Area Zoom on the 
shortcut menu.

2. When the pointer becomes a +, draw a rectangle around the area that you want to 
magnify.
- The selected area is magnified when you release the mouse button.

To reset the magnification (remove magnification):

•Click the  button. Alternatively, right-click the image and select Reset Zoom on 
the shortcut menu.

To pan the image window:

1. Click the  button. 

2. When the pointer becomes a ., click and hold the pointer while you move the 
mouse.

Note: Panning helps you view different areas of a magnified image. If the image has 
not been magnified, you cannot pan the image.
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4.8  Correcting or Filtering Image Data

Use the Corrections/Filtering tools (Figure 4.7) to subtract background or apply 
corrections to the image data. (For more details on sources of background, see Appendix 
E, page 203.) You can also apply smoothing and soft binning to the image data. (For 
more information on binning and smoothing, see Appendix C, page 191.)

Figure 4.7  Tool palette, Corrections/Filtering tools

Table 4.5  Tool palette, Corrections/Filtering tools

Tool Description

Read Bias Subtraction Select this check box to subtract dark background from the image 
data. For more details on background, see Appendix E, page 203. 
Note: In photons mode, dark background subtraction is a mandatory 
default. In counts mode, the check box can be cleared.

Flat Field Correction Select this check box to apply a lens correction factor to the image 
data. For more details on flat field correction, see Appendix D, 
page 202. Note: In photons mode, flat field correction is a mandatory 
default. In counts mode, the check box can be cleared.

Cosmic Correction Select this check box to correct image data for cosmic rays or other 
ionizing radiation that interact with the CCD. For more details on 
cosmic correction, see Appendix D, page 202.

Adaptive FL 
Background 
Subtraction

Opens the Photo Mask Setup box that enables you to set the photo 
mask for adaptive fluorescent background subtraction. For more 
details on adaptive fluorescent background subtraction, see Appendix 
F, page 221.

Binning Specifies the number of pixels in the image data that are grouped 
together to form a larger pixel (called soft binning). Binning changes 
the pixel size in the image (Figure 4.8). For more details on binning, 
see Appendix C, page 192.

Smoothing Computes the average signal of the specified number of pixels and 
replaces the original signal with the average signal (Figure 4.8). 
Smoothing removes signal noise without changing pixel size.

Note: This type of smoothing is defined differently from the 
smoothing performed in the Living Image® 2.5 software.

Read Bias Subtraction and Flat Field 
Correction are default mandatory 
corrections in photons mode. In counts 
mode, these corrections can be cleared.
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4.9 Image Information Tools

You can view information about the active image using the Image Information tools 
(Figure 4.9). 

Click this button to return the binning or smoothing to the previous 
setting and update the image.

Figure 4.8  Example of binning and smoothing image data

Table 4.5  Tool palette, Corrections/Filtering tools

Tool Description

Binning at acquisition = 8, no smoothing Binning = 2, smoothing = 5x5

Figure 4.9  Tool palette, Image Information tools
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Table 4.6  Tool palette, Image Information tools

Tool Description See Page

Click this button to display a histogram of pixel intensity. 59

Click this button to display a line profile. 60

Click this button to display the distance measurement cursor in 
the image window.

61

Click this button to draw and measure a rectangle on an image. 62

Click this button to display/hide a scale on the x and y-axis of the 
image window.

Click this button to display/hide a grid the image window.

Choose the units (cm or pixels) for distance measurements in 
the image window.

Image

Binning The binning applied to the image. Note: If soft binning is applied 
to the image data, and the binning level is changed from 8 to 16, 
the new binning is indicated as 8x2.

58

Image X,Y The x,y pixel coordinates of the mouse pointer location in the 
image.

Image Data The intensity (counts or photons) at the pixel location of the 
mouse pointer.

Crop/Distance

The x,y pixel coordinates at the upper left corner of the crop 
tool.

OR

The x,y pixel coordinates at the “A” end of the distance 
measurement cursor.

62

The x,y pixel coordinates at the lower right corner of the crop 
tool.

OR

The x,y pixel coordinates at the “B” end of the distance 
measurement cursor. 

The width and height of the image crop tool.

OR

Δx, Δy from the A to B end of the distance measurement tool.

Distance The length of the diagonal from corner A to corner B in the 
image crop tool.

OR

The length of the distance measurement cursor.
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Use the tools to make measurements in an image and view pixel data in different 
formats:

Viewing X,Y 
Coordinates & Intensity 
Data

Image Information Description See Page

 x,y coordinates and 
associated intensity

The x,y pixel coordinates of the mouse pointer location in 
the image and the intensity (counts or photons) at that 
location.

58

Histogram Histogram of pixel intensities in an image. 59

Line profile Plots a line graph of intensity data at each pixel along a 
user-specified horizontal or vertical line in the image

60

1. In the Image Information tools, choose Cm or Pixels from the Units drop-down list.

2. Put the mouse pointer over the location of interest in the image.
- The x,y coordinates and intensity data are displayed in the tool palette.

Note: The information is updated when you change the pointer position.
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Viewing an Image 
Histogram

The image histogram plots a frequency distribution of the pixel intensities in an image. 
The software sorts the intensities into groups or bins (x-axis) and plots the number of 
pixels per bin (y-axis). 

Table 4.7  Histogram window

Item Description

Full Displays the histogram using the full intensity range of the image.

Min Bin The lowest intensity bin.

Max Bin The highest intensity bin.

# Bins The total number of bins.

Opens a dialog box that enables you to export the histogram (.csv).

Copies the histogram to the system clipboard.

Opens the print dialog box.

To display the image histogram:

1. Open an image.

2. In the Image Information tools, click the Image 
Histogram button .

Note: By default the Auto min/max range of the image data determines the histogram 
range and bins (the software sets the min and max values to optimize image display 
and suppress background noise). To display the histogram using the full intensity 
range of the image, click Full in the Histogram window.

3. To edit the minimum or maximum bin intensity, enter a new value in the Min Bin 
or Max Bin box, or click the  arrows.

4. To edit the number of bins, enter a new value in the # Bins box or click the  
arrows.

NOTE
In the Overlay display mode, the histogram plots the luminescent data. To obtain a 
histogram of the photograph, select Photograph from the Display drop-down list.
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Viewing a Line Profile The line profile plots intensity (y-axis) at each pixel (x-axis) along a user-specified line 
in the image. The line profile is automatically updated when you change the line 
position.

NOTE
In the Overlay display mode, the line profile plots the luminescent data. To obtain a 
histogram of the photograph, select Photograph from the Display drop-down list.

Table 4.8  Line Profile window

Item Description

Line 
Orientation

Choose Vertical, Horizontal, or Free Hand from the drop-down list to set the 
orientation of the line in the image window. The Free Hand orientation enables 
you to drag each line segment endpoint to a user- selected position.

Width Sets the line width.

To display the line profile:

1. Open an image, and in the Image Information tools, click the Line Profile button .
- A blue line appears on the image and the Line Profile window appears.

2. To view the line profile at another location in the image, put the mouse pointer over 
the line. When the pointer becomes a , drag the line over the image. The blue line 
determines the pixel intensities that are plotted in the line profile graph.
- The line profile is updated as you move the blue line move over the image.
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Making Image 
Measurements

To measure distance with the measurement cursor:

1. Open an image, and in the Image Information tools, click the Distance 
Measurement Cursor button .

- A measurement cursor ( ) appears on the image. The tool palette shows 
the position and length of the cursor.

Position Line position (pixels).

X Min

X Max

Displays the minimum and maximum value of the x-axis. Use the  arrows to 
change the x-axis min or max. If photons is selected in the image window, the 
x-axis units = pixels. If counts is selected in the image window, the x-axis units 
= cm. To display the range available for the Min or Max, place the mouse pointer 
over the Min or Max edit box.

Y Min

Y Max

Displays the minimum and maximum value of the y-axis. Use the  arrows to 
change the y-axis min or max. To display the range available for the Y Min or Y 
Max, place the mouse pointer over the Min or Max edit box.

Click to reset the X and Y Min and Max values to the defaults.

Full Scale Select this option to display the full X and Y-axis scales. If 

Logarithmic 
Scale

Select this option to apply a log scale to the y-axis.

Enables you to choose the grid line pattern to display in the line profile window. 

Exports the line profile data to a .csv or .txt file.

Copies the line profile graph to the system clipboard.

Opens the Print dialog box.

Table 4.8  Line Profile window

Item Description

Measurement cursor
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2. To change the cursor position or size, drag the A or B end of the cursor to a new 
location on the image.
- The measurement information in the tool palette is updated.

3. To hide the cursor, click the  button.

To measure distance using the crop box:

1. Open an image, and in the Image Information tools, click the Image Crop button .

2. When the mouse pointer changes to a +, draw a rectangle on the area of interest.

3. To change the size or position of the crop box, drag a handle  at a corner or side 
of the box.

4. To delete the crop box from the image, click the  button.

Table 4.9  Measurement cursor position & length

Item Description

Pixel x,y coordinates of position A on the cursor.

Pixel x,y coordinates of position B on the cursor.

Length of the cursor from A to B (number of pixels), vertical distance 
from A to B (number of pixels).

Distance Length of the cursor from A to B (number of pixels).

Crop box

Crop box 
position & 
dimensions
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4.10 Rendering Intensity Data in Color

The colorize tool renders luminescence or fluorescence data in color, enabling you to 
see both intensity and spectral information in a single view. The tool provides a useful 
way to visualize multiple probes or scale probe signals that are not in the visible range.

NOTE
The colorize tool is only available if Show Advanced Options is selected in the general 
preferences (see page 182).

To view colorized intensity data:

1. Open an image sequence.

2. Select Tools → Colorize “sequence name”_SEQ on the menu bar.
- The software renders each luminescent or fluorescent image in color and 

combines them into a single image.

Table 4.10  Crop box position & dimensions

Item Description

x,y coordinates at the upper left corner of the box.

x,y coordinates of lower right corner of the box.

Box width and height.

Distance Length of the diagonal from the upper left to lower right corner of the 
box.

In this example, images 
were acquired using 
different combinations of 
excitation and emission 
filters. The samples are 
quantum dot nanocrystals 
(700 or 800 nm).
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Table 4.11  Colorize tools

Item Description

Colorize 

Color Range The color map indicates the color range of the selected camera setup 
from short to long wavelength. The two sliders determine the lower 
and upper limits of the color range that is used to render color. The 
parts of the color map outside the selected range are not used in the 
color rendering process. By default, the entire color range is 
selected.

Filter Range The wavelength range of the luminescent images in the sequence. 
The two sliders determine the lower and upper end of the filter 
range. Only the parts of the image that are within the selected 
wavelength range are colorized. By default, the entire filter range is 
selected.

Color Camera

VIS Regular camera setup that mainly renders color in the visible range. 
It is similar to the color response of a commercial digital camera. NIR 
fluorophores appear dark red to invisible using the VIS camera setup.

NIR A special camera setup that extends the color response into the near 
infrared range. Near infrared fluorophores appear red to purple using 
the NIR camera setup.

Log Scale If this option is chosen, the dynamic range of the brightness in the 
image is compressed using a log scale. This improves the visibility of 
dark areas in the image.

Real Color If this option is chosen, the colors are rendered using the 
wavelengths that directly correspond to the camera setup. For 
example, GFP appears green using real color rendering.

If this option is not chosen, the original wavelength range of the 
image is modified to include the entire visible wavelength range of 
the camera setup. This helps improve the color contrast.

3. To access controls for manually 
adjusting the color rendition, click 
Colorize.
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4.11 Viewing Transillumination Data

The transillumination overview feature combines the images of a FLIT sequence (a 
fluorescence sequence acquired in transillumination mode) into a single image. All of 
the individual fluor signals are stacked over one photograph and the intensity is 
summed. One overview is created per filter pair. If two filter pairs were used during 
acquisition, then two overview images will be created. All transillumination locations 
are displayed simultaneously; a tool tip displays the transillumination position when 
you mouse over a transillumination point.

An overview image is displayed in photon units and can be analyzed using the tools in 
the tool palette.

1. Open a sequence acquired in fluorescence transillumination mode.

2. Select Tools → Transillumination Overview for xx_SEQ on the menu bar.
- The overview appears.

Sequence view Transillumination overview
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4.12 Image Layout Window

The Image Layout window provides a convenient way to annotate and save an image 
to a graphic file.

Table 4.12  Image layout window

Item Description

Clears the Image Layout window. 

Note: If you do not clear the layout (click the button) before you close the 
Image Layout window, the same window contents are displayed the next 
time the window is opened

Opens a dialog box that enables you to save the Image Layout window 
contents to a graphic file.

Pastes the active image in the Image Layout window.

Copies the contents of the Image Layout window to the system 
clipboard.

Pastes the contents of the system clipboard to the Image Layout 
window.

Rectangle drawing tool

Ellipse drawing tool

Pointer tool

Arrow and line drawing tool

1. To open the Image Layout 
window, select View → 
Image Layout Window on 
the menu bar.

2. To paste the active image into 
the Image Layout window, 
click the  button.

3. To resize the image, drag a 
handle  at a corner of the 
image.

4. To reposition the image in the 
window, drag the image.
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Select an the item in the Image Layout window. To move the item to the 
front or back in the window, choose an option from the  drop-down list.

Deletes the selected image.

A drop-down list of formatting options for the Image Layout window. For 
example, the 2x2 layout style provides 4 separate layout areas in the 
window. A different image can be pasted into each layout area. 

To apply notes to an image, enter text in the annotation box and press 
Enter. Drag the text to the location of interest in the image.

Opens a dialog box that enables you to select a font or edit the font style 
and size.

Opens a color palette that enables you to select a font color or specify a 
custom font color.

Opens a text editor that enables you to edit the selected text.

Table 4.12  Image layout window

Item Description
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5 Working With ROI Tools
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Managing the ROI Measurements Table   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 91

5.1 About ROIs

A region of interest (ROI) is a user-specified area in an image (Figure 5.1). The ROI tools 
enable you to create three types of ROIs: measurement, average background, or subject 
ROI (Table 5.1). During a session, the Living Image® software records information about 
the ROIs you create and computes statistical data for the ROI measurements. The ROI 
Measurements table displays the data and provides a convenient way to review or export 
ROI information (Figure 5.1). (For more details, see Managing the ROI Measurements 
Table, page 91.)

Figure 5.1  Example measurement ROIs and ROI measurements table

ROI Measurements table
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NOTE
For a quick guide to drawing a measurement ROI, see page 73. 

Table 5.1  Types of ROIs

Type of ROI

Measurement ROI Average Background ROI Subject ROI

Description

Measures the signal 
intensity in an area of an 
image. 

Measures the average signal intensity 
in a user-specified area of the image 
that is considered background. 

Note: Using this type of ROI is optional. 
If the animal has significant 
autoluminescence or autofluorescence, 
you can determine a background-
corrected signal in a measurement ROI 
by subtracting an average background 
ROI from a measurement ROI. 

Identifies a subject animal in an 
image. 

Note: Using this type of ROI is 
optional. It provides a convenient 
way to automatically associate (link) 
a measurement and average 
background ROI for background-
corrected ROI measurements when 
there is significant 
autoluminescence or 
autofluorescence. 

Available ROI 
Drawing Methods 

• Manual 
• Automatic
• Free draw 

• Manual
• Free draw 

• Manual 
• Automatic
• Free draw

Available Shapes Circle, square, grid, or 
contour

Circle or square Square
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5.2  ROI Tools

Table 5.2  Tool palette, ROI tools

Item Description

Click to select the number of circle ROIs to add to the active image. 

Click to select the number of square ROIs to add to the active image.

Click to specify the grid pattern for a measurement ROI that you want to add 
to the active image. This tool is useful for an image of a multi-well culture 
plate or microtiter plate.

Click and select Auto All to automatically draw ROIs in the image using the 
auto ROI parameters. Click and select Auto 1 to automatically draw one ROI 
at a user-selected location using the auto ROI parameters. For more details 
on using the auto ROI features, see page 76.

Click to display the ROI Measurements table or compute intensity signal in an 
ROI.

Click to display a drop-down list of options to delete an ROI(s) in the active 
image. For more details, see page 90.

Note: These commands do not delete the ROIs that are saved to the system 
(listed in the Menu Name drop-down list).

Apply to 
Sequence

Choose this option to apply the selected ROI to all images in a sequence.

To display the ROI tools:

1. Open an image or image sequence and click ROI Tools in the tool palette.

ROI 
tools
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Type Choose the ROI type from the drop-down list: 

Measurement - Measures the signal intensity in an area of an image.

Average Bkg - Measures the average signal intensity in a user-specified area 
of the image that is considered background.

Subject ROI - Identifies a subject animal in an image. The software 
automatically associated a measurement and average bkg ROI included in the 
same subject ROI. Using this type of ROI is optional.

Save ROIs

Name The name of the selected ROI set or the default name for a new ROI set.

Delete Deletes the selected ROI set from the system. Note: This permanently 
removes the ROI from the system.

Load Applies the ROI set selected from the Name drop-down list to the active 
image.

Save Saves the ROI set in the active image. 

Note: This is a global save (the ROI is saved to the system) and the ROI set 
can be loaded onto any image. If you use the File ➞ Save commands to save 
an image that includes an ROI, the ROI is saved with the image only (not a 
global save) and is not available for loading onto other images. For more 
details, see Saving ROIs, page 89.

Auto ROI 
Parameters

Parameters that specify how the auto ROI tool draws an ROI. Note: These 
are advanced options that are only available if “Show Advanced Options” is 
selected in the general preferences.

Threshold % If the Auto All or Auto 1 method is selected, the Threshold % specifies the 
minimum per cent of peak pixel intensity that a pixel must have to be included 
in an ROI identified by the software.

Note: After ROIs are drawn on an image, if you modify the Threshold% (move 
the slider or enter a new value) the software automatically updates the ROIs.

Lower 
Limit

Specifies a multiple (1 to 10) of the color bar minimum that sets the lower 
threshold for identifying an ROI. For example, if the lower limit = 2 and the 
color bar minimum = 1000 counts, then the auto ROI tool will only draw an 
ROI on areas of 2000 counts or greater. This helps create ROIs only in the 
visible range.

Minimum 
Size

Sets the minimum size of an ROI (measured in pixels). For example if the 
minimum size is set at 50, then ROIs created on the image must be greater 
than 50 pixels in size.

Preview If this option is chosen, the software draws the ROI each time a parameter is 
changed. ROI parameters can be saved without drawing the ROI.

Use Bkg 
Offset

Choose this option to measure background-corrected signal. For more details, 
see page 79.

Replace 
ROIs

If this option is chosen, all auto ROIs are replaced when new ROI(s) are 
created.

Restore 
Defaults

Restores the factory-set defaults for the auto ROI parameters.

Save/Load Click to display or hide the tools that enable you to save, load, or delete auto 
ROIs in the active data. Note: The save function saves parameters, the not 
actual ROIs. This means that when you load saved auto ROI parameters, the 
software draws a new ROI using the saved values (Threshold%, Lower Limit, 
Minimum Size).

Table 5.2  Tool palette, ROI tools

Item Description
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5.3  Quick Guide to Drawing a Measurement ROI

These steps provide a quick guide on how to obtain the intensity signal in a measurement 
ROI. For more details about measurement ROIs, see page 74.

1. Open an image or image sequence and click ROI Tools in the tool palette.

NOTE
After the ROIs have been created, right-click an ROI to view a shortcut menu of ROI 
commands (Ctrl-click for Macintosh users). The shortcut menu provides easy access 
to many functions for managing ROIs and viewing ROI properties.

5. To show the ROI Measurements table, click the Measure button .

2. In the ROI tools, select Measurement ROI from the Type drop-down list.

3. Click the Contour button  and select Auto All from the drop-down list.

- The software automatically draws measurement ROIs on the image. The ROI 
label shows the total intensity in the ROI. If you are working with a sequence, 
open an image to view the intensity label.

4. If it is necessary to adjust the ROI boundaries, change any of the auto ROI 
parameters (use the slider or  arrows):

• Threshold % - Specifies the minimum per cent of peak pixel intensity that a pixel 
must have to be included in an ROI identified by the software
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The ROI Measurements table displays data for all ROIs created during a session (one 
ROI per row). The table provides a convenient way to review and export ROI data. For 
more details on the table, see Managing the ROI Measurements Table, page 91.

5.4 Measurement ROIs

To obtain the intensity signal in a user-specified area of an image, draw a measurement 
ROI on the image. There are three ways to draw measurement ROIs:

Drawing 
Method Description See 

Page

Manual Places one or more ROIs (circular, square, or grid shape) on the image. 75

Automatic The software automatically locates and draws a contour ROI(s) on the 
image. To do this, the software locates the peak pixel intensities in the 
image and searches the neighborhood around a peak pixel. A pixel is 
included in the ROI if the pixel intensity is greater than the threshold%, 
a user-specified percentage of the peak pixel intensity.

76

Free draw Draw line segments that define the ROI. 78
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Manually Drawing a 
Measurement ROI 1. Open an image or image sequence, and in the ROI tools, select Measurement ROI 

from the Type drop-down list.

2. To specify the ROI shape:
a. Click the Circle , Square , or Grid button . 

The grid shape is useful for drawing a grid of ROIs on an image of a microplate 
plate.

b. On the drop-down list that appears, select the number of ROIs that you want to add to 
the image or the grid ROI dimensions. 

- The ROI(s) and intensity label(s) appear on the image. If you are working with a 
sequence, open an image to show the ROI intensity.

3. Adjust the ROI position:
a. Place the mouse pointer over the ROI. When the pointer becomes a , click the 

ROI.

b. Drag the ROI.

4. Adjust the ROI dimensions:
a. Place the mouse pointer over the ROI. When the pointer becomes a , click the 

ROI.

b. Place the mouse pointer over an ROI handle  so that it becomes a . Drag the handle 
to resize the ROI.

Note: You can also change the ROI position or size using the adjustment controls in the 
ROI Properties box (see Moving an ROI, page 85 and Editing ROI Dimensions, 
page 86).
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Automatically Drawing 
Measurement ROIs

The Living Image® software can automatically identify all of the ROIs in an image or 
image sequence that meet the auto ROI parameter thresholds or draw one ROI at a user-
specified location.

5. Click the Measure button . 
- The ROI measurements and table appear. For more details on the table, see 

Managing the ROI Measurements Table, page 91.

Note: For information on how to save ROIs, see page 89.

To automatically draw all ROIs detected by the software:

1. Open an image or image sequence, and in the ROI tools, select Measurement ROI 
from the Type drop-down list.

2. Click an ROI shape button (Circle , Square , or Contour ) and select Auto 
All from the drop-down list. 

- The ROIs appear on the image or thumbnails.

3. Click the Measure button . 
- The ROI table appears. For more details on the table, see Managing the ROI 

Measurements Table, page 91.
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4. Double-click a thumbnail to view the 
ROI measurements in the image.

To automatically draw an ROI at a user-specified location:

1. Open an image.

2. Click an ROI shape button and select 
Auto 1 from the drop-down list.

- The create tool appears on the 
image.

3. Use the ring  to move the create 
tool to the location for the ROI.

4. Click Create on the ring tool.
- The ROI appears on the image and 

the ROI label displays the 
intensity signal.

5. To draw another ROI, repeat step 3 
to step 4.

Note: For information on how to save 
ROIs, see page 89.
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Drawing an ROI Using 
the Free Draw Method

Drawing a Subject ROI A subject ROI identifies a subject animal in an image. It provides a convenient way to 
automatically associate (link) a measurement and average background ROI for 
background-corrected ROI measurements when there is significant autoluminescence 
or autofluorescence. (For more details on background-corrected ROI measurements, 
see page 79.) Using a subject ROI is optional.

To draw a subject ROI using the auto ROI feature:

1. Select Subject ROI from the Type drop-down list.

2. Click the  button. 

3. Select Auto All.

1. Open an image, and in the ROI tools, select the type of ROI that you want to draw 
from the Type drop-down list.

2. Click an ROI shape button (Circle , Square , or Contour ) and select Free 
Draw from the drop-down list. In this example, the Contour shape  was selected 
for the free draw method. 
Note: The ROI shapes that are available depend on the type of ROI selected.

3. If you selected:
 or  - Use the pointer (+) to draw the ROI.

 - Use the pointer (+) to click around the area of interest and draw line segments 
that define the ROI. Right-click when the last point is near the first point in the ROI.
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To manually draw a subject ROI:

1. Select Subject ROI from the Type drop-down list.

2. Click the  button, and select 1. 

3. Position the subject ROI so that it includes the measurement ROI(s) and the 
associated average background ROI.

5.5 Measuring Background-Corrected Signal

If a subject has significant autoluminescence or autofluorescence, you can obtain a 
background-corrected ROI measurement by subtracting an average background ROI 
from a measurement ROI. The software computes:

Background-corrected intensity signal = Average signal in the measurement ROI - 
Average signal in the average background ROI

The Image Adjust tools and zoom feature are helpful for selecting an appropriate area 
for an ROI. By setting the image minimum close to zero and zooming in on a 
background area in the image, you can determine where naturally occurring background 
luminescence or autofluorescence is present. For more details on the Image Adjust tools 
and the zoom feature, see Adjusting Image Appearance, page 52 and Magnifying or 
Panning in the Image Window, page 54.

To measure background-corrected signal:

1. Draw one or more measurement ROIs on the subject. (For more details, see 
page 78.)

2. Draw an average background ROI on the subject:
a. Select Average Bkg ROI from the Type drop-down list.

b. Click the Square  or Circle  button and select 1.
- The ROI is added to the image.

For more details on adjusting the ROI position or dimensions, see page 85 and 
page 86.

Note: The average background ROI and measurement ROI do not need to be the 
same shape or size because the software computes the average intensity signal in 
each ROI.

3. Use one of the following three methods to associate the average background ROI 
with one or more measurement ROIs.
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Method 1
Draw a subject ROI that 
includes the measurement 
ROI and the average 
background ROI. For details 
on how to draw a subject ROI, 
see page 78.

Method 2
Right-click the measurement 
ROI and select Set BkG ROI 
to Bkg X on the shortcut 
menu that appears.
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Method 3:

1. Right-click a background ROI and select Properties on the shortcut menu.

2. In the ROI Properties box that appears, click the Bkg ROI tab and put a check mark 
next to Use as BKG for future ROIs in.

3. Choose the image name or the Entire sequence option.
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5.6  Managing ROIs

In the ROI Properties box, you can view information about an ROI, change the position 
of the ROI on the image, and edit the ROI label or line characteristics

Viewing ROI Properties To view ROI properties, do one of the following:

• Double-click the ROI of interest. 

• Right-click the ROI and select Properties from shortcut menu that appears.

• Select the ROI, then select View → Properties on the menu bar.
- The ROI Properties box appears (for more details see Figure 5.2).

To view properties for another ROI:

• Click another ROI in the image. Alternately, select an ROI from the ROI drop-down 
list in the ROI Properties dialog box (Figure 5.2).

ROI selected in 
the image. To 
view properties 
for another ROI, 
select another 
ROI from the 
drop-down list.
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Figure 5.2  ROI properties
The items in the ROI Properties box depend on the type of ROI selected. For more details see 
Table 5.3, page 84.

Enter label information 
here for the subject ROI 
selected above

Subj ROI tab

Drop-down list 
of subject ROIs 
in the image

Bkg ROI tab 
(average background ROI 
selected in the image)

Bkg ROI tab 
(measurement ROI 
selected in the image)

Drop-down list of 
average background 
ROIs in the image

Label name of the ROI 
selected above. 
Double-click to edit.

Selected image 

Information about the 
ROI selected from the 
drop-down list above

Info tab

ROI selected 
in the image 
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Table 5.3  ROI properties

Item Description

ROI A drop-down list of ROIs in the active image or image sequence. To select 
an ROI, double-click the ROI in the image or make a selection from the drop-
down list.

ROI Label Click to edit the selected ROI label name.

Click Number A drop-down list of open images.

ROI The Subject ROI tab shows a drop-down list of all subject ROIs in the click 
number selected above that can be linked to a user-specified measurement 
ROI or average background ROI (selected from the drop-down list at the top 
of the dialog box).

The Bkg ROI tab shows a drop-down list shows all average background 
ROIs in the click number selected above that can be linked to a user-
specified measurement ROI or subject ROI (selected from the drop-down 
list at the top of the dialog box).

ID User-entered information about a subject ROI.

Label Label name of the selected subject ROI.

Lock Position Choose this option to lock the position of the ROI selected in the image.

Xc X-coordinate of the ROI selected in the image.

Yc Y-coordinate of the ROI selected in the image.

Lock Size Choose this option to lock the dimensions of the ROI selected in the image.

Width Width (pixels or cm) of the ROI selected in the image (for more details on 
setting the units, see ROI Dimensions, page 92).

Height Height (pixels or cm) of the ROI selected in the image.

Line Size Specifies the ROI line thickness. To change the line thickness, enter a new 
value or click the up/down arrows .

Line Color Specifies the color of the ROI line. To select a line color, click the Browse 
button .

Done Click to close the ROI Properties box and apply any new settings, including:

• Linkage between a measurement ROI and subject ROI (for more details, 
see Drawing an ROI Using the Free Draw Method, page 78).

• ROI size dimensions or position
• Subject ROI ID information
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Moving an ROI There are two ways to move an ROI on an image:

• Drag the ROI to a new location

• Edit the settings in the ROI Properties box 

NOTE
You cannot move ROIs created using the auto ROI feature.

To drag an ROI:

1. Put the mouse pointer over the 
ROI so that it becomes a  
arrow.

2. Drag the ROI.

3. Release the mouse button when 
the ROI is properly positioned.

To move an ROI using the ROI Properties box:

1. Double-click the ROI in the image.
- The ROI Properties box appears and displays the 

position and dimensions of the selected ROI.

2. To set ROI position, enter new Xc (pix) and Yc (pix) 
values in the ROI Properties box.

3. To rotate the ROI clockwise, enter the degrees in the 
Angle (deg) box and click outside the box.

4. To lock the current ROI position, choose the Lock 
Position option.

Note: The ROI position cannot be changed until the 
Lock Position option is cleared.

Position of the ROI selected in the image
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Editing ROI 
Dimensions 

There are two ways to resize a circle or square ROI:

• Drag a handle on the ROI.

• Edit the settings in the ROI Properties box.

NOTE
You cannot change the size of an ROI that was created using the auto ROI or free 
draw tool. 

To resize an ROI using a handle:

1. Select the ROI and place the 
pointer over a handle ( )on the 
ROI.

2. When the pointer becomes a  
arrow, drag the handle.

To resize an ROI using the ROI Properties box:

1. Double-click the ROI in the image.
- The ROI Properties box appears and displays the 

positions and dimensions of the selected ROI.

2. Enter a new width or height value in the ROI 
Properties box.

3. To lock the current ROI size, choose the Lock Size 
option.

Note: The ROI size cannot be changed until the 
Lock Size option is cleared.
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Editing the ROI Line
1. Double-click the ROI that you want to edit.

- The ROI Properties box appears.

2. To edit the ROI line thickness, enter a new value in 
the Line Size box. Alternately, click the  arrows.

3. To change the ROI line color:
a. Click the Browse button .

- The Select Color box appears.

b. To select a basic color for the ROI line, click a basic 
color swatch, and click OK.

c. To define a custom color, drag the crosshair in the 
custom color field, adjust the brightness slider, and 
click Add to Custom Colors.

d. To select a custom color for the ROI line, click a 
custom color swatch, and click OK.

Brightness slider

Cross hairs in the custom color field
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Moving or Editing an 
ROI Label To move an ROI label:

1. Place the pointer over the 
ROI label.

2. When the pointer becomes 
a , drag the label.

3. Click to release the label at 
the new location.

To edit an ROI label:

1. Double-click the ROI. Alternately, right-click the ROI (Ctrl-click for Macintosh users) 
and select Properties on the shortcut menu.

2. In the ROI Properties box that appears, edit the name in the ROI Label box and click 
Done.
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Saving ROIs The software automatically saves ROIs with an image. The ROI measurements are 
saved to the AnalyzedClickInfo.txt file associated with the image. ROIs are saved per 
user and can be applied to other sequences. 

-

To save ROIs to the system:

1. In the Name drop-down list, confirm the default name or enter a new name for the 
ROI(s).

2. Click Save. 
- The ROI(s) from the image are saved to the system and can be selected from the 

Name drop-down list.

To load ROIs on an image:

1. Open an image.

2. In the ROI tools, make a selection from the Name drop-down list and click Load.

Note: If you load ROI(s) onto an image, then draw additional ROIs, the Save button 
changes to Overwrite. If you want to save this collection of ROIs using the existing 
name, click Overwrite.



5. Working With ROI Tools

90  

Deleting ROIs You can delete ROIs from an image or permanently remove ROIs from the system.

To delete ROIs from an image:

1. In the ROI tools, click the  button. 

2. Make a selection from the drop-down list of delete commands.
- The specified ROIs are deleted from the image. 

Note: This does not delete ROIs saved to the system (global save).

To permanently remove ROIs from the system:

1. Select the ROI(s) that you want to delete from the 
drop-down list of saved ROIs.

2. Click Delete.
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5.7  Managing the ROI Measurements Table

The ROI Measurements table shows information and data for the ROIs created during a 
session. The ROI measurements can be displayed in units of counts or photons, or in 
terms of efficiency. For more details, see Quantifying Image Data, page 199.

To view the ROI Measurements table, click the  button. Alternately, select View → 
ROI Measurements on the menu bar. 

Column headers in the table include ROI information, ROI 
measurements and dimensions, and information about the 
image recorded at acquisition.

Select the type of ROI or image data to include in the tableSelect the type of ROI or image data to include in the table

Grid ROIs are displayed 
in a separate table.
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Table 5.4  ROI Measurements table

Item Description

Measurement 
Types

Make a selection from the drop-down list to specify the type of ROI 
measurements to include in the table.

None Exclude ROI measurements from the table.

Counts Includes Total Counts, Avg Counts, Stdev Counts, Min Counts, and Max 
Counts in the table. 

Total Counts = the sum of all counts for all pixels inside the ROI.

Avg Counts = Total Counts/Number of pixels or super pixels.

Stdev Counts = standard deviation of the pixel counts inside the ROI

Min Counts = lowest number of counts in a pixel inside the ROI.

Max counts = highest number of counts in a pixel inside the ROI.

(For more details on count units, see page 199.)

Note: These numbers are displayed if the units selected in the ROI 
Measurements table and the image are the same. Otherwise, N/A appears in 
each column.

Photons Total Flux = the radiance (photons/sec) in each pixel summed or integrated 
over the ROI area (cm2) x 4π.
Average Radiance = the sum of the radiance from each pixel inside the ROI/
number of pixels or super pixels (photons/sec/cm2/sr).

Stdev Radiance = standard deviation of the pixel radiance inside the ROI

Min Radiance = lowest radiance for a pixel inside the ROI.

Max Radiance = highest radiance for a pixel inside the ROI.

(For more details on photon units, see page 199.)

Efficiency Available for fluorescent images only. Includes Total Efficiency, Average 
Efficiency, Stdev Efficiency, Min Efficiency, and Max Efficiency in the table. 
(For more details on efficiency, see page 199.)

Click 
Attributes

Make a selection from the drop-down list to specify the click number (image 
file) information to include in the table. Click attributes include label name 
settings and camera settings.

None Excludes click attributes from the table.

All 
Possible 
Values

Includes all of the click attributes (label name settings and camera settings) 
in the table.

All 
Populated 
Values

Includes only the click attributes with values in the table.

Xenogen 
Defaults

Includes all Xenogen Default label name settings in the table.

ROI 
Dimensions

Make a selection from the drop-down list to specify the ROI dimensions to 
include in the table.

None Excludes the ROI area, x,y-coordinates, and dimensions from the table.

Pixels Includes ROI area, x,y-coordinates, and dimensions (in pixels) in the table.

cm Includes ROI area, x,y-coordinates, and dimensions (in cm) in the table.

Copy

Selected Copies the selected row(s) in the table to the system clipboard.
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Configuring the ROI 
Measurements Table

You can customize the data and information (column headers) in the ROI 
Measurements table. Several predefined categories are available in the Measurement 
Types, Click Attributes, and ROI Dimensions drop-down lists.

All Copies all rows in the table to the system clipboard.

Refresh Updates the table.

Configure Displays the Configure Measurements box that enables you to specify and 
organize the data categories (column headers) for the table.

Export Displays the Save Measurements box so that the data can be saved to a .txt 
or .csv file. 

Note: Grid ROI measurements exported to a .csv file can be opened in a 
spreadsheet application like Microsoft® Excel®.

Close Closes the ROI Measurements table.

Table 5.4  ROI Measurements table

Item Description

1. To reorder the columns, drag a column header (left or right) in the table.

2. To change the measurement units, make a selection from the Measurement Types 
drop-down list.

3. To include image information in the ROI table, make a selection from the Image 
Attributes drop-down list.

4. To include ROI dimensions in the table, select units (Pixels or cm) from the ROI 
Dimensions drop-down list. 
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2. Do either of the following:

•Select a configuration that you want to modify from the User Lists drop-down 

OR

•Select Customized (Unsaved) from the User Lists drop-down to create a new 
configuration

3. To add an item to the table, click an item in the Available Item list and then click 
Add. 

4. To remove an item from the table, select the item that you want to remove in the 
Selected Items list, and click Remove.

To create & save a custom table configuration:

1. In the ROI Measurements table, click Configure.
- The Configure Measurements box appears.

Items (column headers) 
currently in the table

Available items (column headers) 
that can be added to the table

Click to reorder the 
available items in 
ascending or descending 
alphabetical order
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5. To reorder an item in the Selected Items list, select the item and click Move Up or 
Move Down.
- The columns in the ROI Measurements table are updated.

6. To save the table configuration, enter a name in the Name box and click Save.
Note: You cannot overwrite a factory loaded configuration. If you modify a factory 
loaded configuration, save it to a new name. 

To delete a custom table configuration

1. Select the configuration from the User Lists drop-down and click Delete.

2. Note: Factory loaded table configurations cannot be deleted.

Copying or Exporting 
the ROI Measurements 
Table

To export the table:

1. Click Export.

2. In the dialog box that appears, select a folder and enter a name for the file (.txt), 
then click Save.

To copy the table to the system clipboard:

• Selected rows - Select the rows of interest and click Selected. Alternatively, select 
the rows then right-click the table and choose Copy Selected on the shortcut menu.

• All rows - Click All. Alternately, right-click the table and select Copy All on the 
shortcut menu.
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6 Image Math

Using Image Math to Create a New Image  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 98
Subtracting Tissue Autofluorescence  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 101
Overlaying Multiple Images .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 104

The Living Image® software provides tools that enable you to mathematically combine 
two images to create a new image. The primary use of image math is to subtract tissue 
autofluorescence background from signal.

To perform image math, open an image sequence (see page 37) or a group of images 
(see Creating an Image Sequence from Individual Images, page 43).

LIving Image Tool Use This Tool To... See Page

Image Math Mathematically combine (add, multiply, subtract, or divide) 
two user-specified images.

98

Image Math Remove autofluorescence from a fluorescent image. 101

Image Overlay Coregister multiple fluorescent or luminescent images on the 
same photographic image to view multiple reporters in a 
single image. 

104
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6.1 Using Image Math to Create a New Image

To create a new image using image math:

1. Load an image sequence.
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2. Select Tools → Image Math for xx_SEQ on the menu bar.

3. In the Image Math window that appears, select an image of interest from box A and 
box B.
- The Image Math window shows a thumbnail of image A, image B, and the new 

image.

Note: For more 
details on items in 
the Image Math 
window, see Table 
6.1, page 100.

4. Select a mathematical function from the Result drop-down list.

5. To include a scaling factor (k) in the function, enter a value for k.

6. To view the new image, click Display Result for Measuring.

New image generated 
by the Result function
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Table 6.1  Image Math window

Item Description

Color Ranges for A and B

Full Choose this option to set the Max and Min values to the 
maximum and minimum data values in the image.

Auto When this option is chosen, the software sets the Min and 
Max values to optimize image display and suppress 
background noise. The Min and Max settings can be manually 
adjusted to further optimize the image display for your needs.

Note: The color bar scale does not affect the image math 
result.

Color Ranges for Result 
Image

Full See above.

Auto See above.

Min = 0 Choose this option to set the minimum data value to zero.

Results Drop-down list of mathematical functions that can be used to 
generate the new image, including:

A - B*k
A + B*k
A * B*k
A/B if Counts(B)>k (Useful for fluorescence tomography.)

k, Image Math window A user-specified scaling factor applied in the results function. 

k, Fluorescent Background 
Subtraction window

The software computes k = the ratio of the autofluorescent 
signal measured using the background filter to the 
autofluorescent signal measured using the excitation filter in a 
region on the animal where no fluorophore is present.

Compute ‘k’ from ROI This option is useful for subtracting fluorescence background. 
Draw the same ROI in both images on an area considered 
background. In the “Compute ‘k’ from ROI” drop-down list, 
select the same ROI in each image.

with Photo from Choose this option to display the new image in overlay mode 
using the selected photographic image. (This option is only 
available if one of the selected images is an overlay.

To save the new image:

1. Click the Save button . Alternatively, select File → Save on the menu bar.

2. In the dialog box that appears, select a directory, and click Save.
- A folder of data is saved to the selected location (AnalyzedClickInfo.txt, 

ClickInfo.txt, luminescent and photographic TIF images).

To export the image to a graphic file:

1. Click the Export button .

2. In the dialog box that appears, select a directory, enter a file name, and select the 
file type from the Save as type drop-down list.

3. Click Save.
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6.2 Subtracting Tissue Autofluorescence

To remove tissue autofluorescence from image data, the IVIS® Imaging System 
implements a subtraction method using blue-shifted background filters that emit light at 
a shorter wavelength (Table 6.2). 

The objective of using a background filter is to excite the tissue autofluorescence 
without exciting the fluorophore. To reduce autofluorescence signal in the primary 
image data, use the image math tool to subtract the background filter image from the 
primary excitation filter image. For more details on tissue autofluorescence, see 
Appendix F, page 223

The software computes:

Background-corrected signal = (A - B) ×  k, where:

After you acquire an image sequence that includes a primary and background image, use 
the image math tool to subtract tissue autofluorescence. (For more details on acquiring 
an image sequence, see Chapter 3, page 30.)

Display Result for Measuring Opens the image generated by image math in an image 
window.)

Table 6.1  Image Math window

Item Description

Table 6.2  Emission, excitation, and background filters used to acquire data that can be corrected 
for tissue autofluorescence

Emission Filter Excitation Filter (Primary 
Image)

Background Filter 
(Background Image)

Fluorophore Passband (nm)

GFP 515-575 445-490 410-440

DsRed 575-650 500-550 460-490

Cy5.5 695-770 615-665 580-610

ICG 810-875 710-760 665-695

A = primary image (acquired using the excitation filter)

B = background image (acquired using the background filter)

k = (primary signal/background signal) 

The background signal is obtained from a measurement ROI that is 
located in an area where no fluorophore signal is present. The scale factor 
k accounts for different levels of tissue autofluorescence due to different 
excitation wavelengths and filter transmission characteristics.
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To subtract tissue autofluorescence:

1. Load the image sequence that includes the primary and background fluorescent 
images. 

2. Open either the primary or background image and:
a. Optimize the image display using the color scale Min and Max sliders in the Image 

Adjust tools.

b. Draw a measurement ROI on an area of the animal that represents background signal 
(area where no fluorophore signal is present).

Note: You only need to draw the ROI on one of the images. The software copies 
the ROI to the other image.

3. Select Tools → Image Math for xx.SEQ on the menu bar.
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4. In the Image Math window that appears, select the primary image in box A. Select 
the background image in box B.

Note: For more details on items in the Image Math window, see Table 6.1, page 100.

5. Select the math function 'A-B*k' in the Result drop-down list.

6. Click  and select the ROI (created in step 2) from the drop-down list.
- The background-corrected signal is displayed.

7. To view the mathematical result (overlay mode) in a separate image window, click 
Display Result For Measuring.

Note: If necessary, use the Color Scale Min and Max sliders in the Image Adjust 
tools to adjust the image display.

To save the new image:

1. Click the Save button . Alternately, select File → Save on the menu bar.

2. In the dialog box that appears, select a directory, and click Save.
- A folder of data is saved to the selected location (AnalyzedClickInfo.txt, 

ClickInfo.txt, luminescent and photographic TIF images).

To export the new image to a graphic file:

1. Click the Export button .

2. In the dialog box that appears, select a directory, enter a file name, and select the 
file type from the Save as type drop-down list.

3. Click Save.
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6.3 Overlaying Multiple Images

The image overlay tool provides a convenient way to view multiple reporters in one 
image. You can use the image overlay tool to display multiple luminescence or 
fluorescence images on one photographic image. To do this:

To coregister multiple images:

1. Acquire an image sequence using the appropriate filters for each reporter. 
Alternately, create a sequence form images acquired during different sessions. (For 
more details, see page 43.)

2. Open the image sequence.

Note: To view all 
images in the sequence, 
click the Display All 
button  to open each 
image (overlay mode) in 
a separate image 
window.

3. Open one of the images and optimize the image display using the color scale Min 
and Max sliders in the Image Adjust tools.

4. Select Tools→ Image Overlay for xx_SEQ on the menu bar.
- The image overlay window appears and shows the first photographic image in the 

sequence.
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5. Select a photographic 
image in the upper box.

6. To select all of the fluorescent or luminescent images in the lower box, click the  
button.
Alternately, to select particular images, do either of the following:

• To select non-adjacent images in the list, press and hold the Ctrl key while you 
click the images.

OR

• To select adjacent images in the list, press and hold the Shift key while you click 
the first and last image in the selection.

- In the overlay that is generated, the signal in each image is assigned a different 
color table. The photographic image is at the bottom of the stack and the last 
fluorescent or luminescent image selected from the list is at the top of the stack.
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7. To remove all fluorescent or luminescent images from the overlay, click the  
button.

8. To change the display of a fluorescent or luminescent image in the overlay:
a. Select the image in the lower box.

b. Choose the Edit Layer Properties option.

c. Adjust the opacity, select a different color table, or edit the color table properties. When 
finished, clear the Edit layer Properties option.

9. To reorder the images in the list:
a. Choose the Edit Layer Properties option.

b. Select an image.

c. Click the  or  arrows. 

10.To copy the overlay image to the system clipboard, click the Copy button .

11.To export the overlay image to a graphic file, click the Export button .

Select white or black for the 
low end of the color scale

Set the number of color scales 
displayed per column
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7 Planar Spectral Image Analysis
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The Living Image® software enables you to apply planar spectral image analysis to a 
sequence to determine the average depth and total photon flux of a bioluminescent point 
source in a user-specified region of interest. For more information on planar spectral 
image analysis, see Appendix G, page 225.

Use the imaging wizard to setup the image sequence required for planar spectral image 
analysis. (For more details on the imaging wizard, see page 23.) At a minimum, the 
sequence must include a photographic and luminescent image at the first wavelength 
and a luminescent image at a second wavelength (560-660).

7.1 Planar Spectral Image Analysis
1. Open the image sequence that you want to analyze. 

2. In the tool palette, click Planar Spectral Imaging.
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3. In the Analyze tab, select the emission filter 
wavelengths for the analysis.

It is recommended that you do not include a 
wavelength in the analysis if the signal is less than 
or equal to the autoluminescent background. If 
autoluminescent background is a concern, you can 
create a background ROI and link it to the 
measurement ROI prior to planar spectral analysis. 
(For more details, see Measuring Background-
Corrected Signal, page 79.)

4. In the ROI List drop-down, select All or a particular 
ROI for the analysis. If there is no measurement 
ROI, draw an ROI that includes the area for 
analysis. (For more details on drawing ROIs, see 
Measurement ROIs, page 74.) 

You only need to draw the ROI(s) on one image in 
the sequence. The software copies the ROI(s) to all 
other images of the sequence during the analysis. 
The ROI should include as much of the light 
emission from a single source as possible.

5. Choose the tissue properties:
a. In the Properties tab, make a selection from the 

Tissue Properties drop-down list. 

b. Choose the tissue type most representative of the 
area of interest. Muscle is a good choice for a 
generic tissue type.

- The software automatically sets the internal medium index of 
refraction based on the selection in the Tissue Properties list.

6. Make a selection from the Source Spectrum drop-
down list.

7. Click Analyze in the Analyze tab.
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7.2 Planar Spectral Imaging Tools

The planar spectral imaging tools are displayed in three tabs.

The Results tab displays the computed average depth 
(mm) and total flux (photon/sec) of the bioluminescent 
point source in the specified ROI(s).

Figure 7.1  Tool palette, planar spectral imaging tools
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Table 7.1  Planar spectral imaging tools & results

Item Description

Analyze Tab

Sequence Name of sequence used for the analysis.

Tissue, Source The tissue properties and source spectrum selected in the 
Properties tab.

Select Filters In the Filter box, select the acquisition wavelengths for the images 
in the selected sequence. To select non-adjacent wavelengths, 
press and hold the Ctrl key while you click the wavelengths. 
(Macintosh users, press and hold the Cmd key while you click the 
wavelengths.)

ROI List A drop-down list of the ROIs in the active image.

Analyze Click to perform the spectral analysis.

Properties Tab

Tissue Properties Drop-down list of the absorption and scattering properties of 
various tissues.

Internal medium 
index of refraction

Tissue index of refraction that is automatically specified when you 
select a tissue property.

Source Spectrum Drop-down list of bioluminescent sources.

Plot  

Tissue Properties Click to display graphs (cm-1 vs nm) of the absorption coefficient 
(μa), effective attenuation coefficient (μeff), and reduced scattering 
coefficient (μ’s).

Source Spectrum Click to display the spectrum of the selected bioluminescent source 
(intensity versus wavelength, normalized to one).

Results Tab

Spectral Results

ROI Name of the analyzed ROI.

Depth (mm) Estimated depth of the point source.

Total Flux (phot/s) Estimated total photon flux from the point source.

Plot Linear Fit Displays a graph of normalized intensity versus the effective 
attenuation coefficient (μeff, the optical property of the tissue 
selected in the Tissue Properties drop-down list) along with the 
linear fit to these data determined by the spectral analysis code.

Plot Intensity Displays a graph of normalized intensity versus wavelength. 
Intensity is normalized by the selected source spectrum and filter 
transmission properties.

Export Opens a dialog box that enables you to save the results to a text file 
(.txt).

Save Results

Name A drop-down list of saved results. Includes the default name for 
new unsaved analysis results (SpIm_xx). 

Delete Deletes the selected results.

Load Opens the selected results.

Save Saves the analysis results (results name appears in the Name drop-
down list).
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7.3 Viewing & Exporting Graphical Results

To view a graph of the results:

1. In the Results tab, select an ROI.

2. Click Plot Intensity or Plot Linear Fit.

The linear fit graph plots the logarithm of the intensity, normalized to the selected 
source spectrum and the filter transmission properties, against the optical property of 
the tissue (μeff). The slope of the line is the source depth. If any of the measured points 
(in red) deviate significantly from the straight line fit, then the analysis results may be 
suspect. The horizontal error bars represent the uncertainty in the optical properties 
(usually estimated at ±10%). The vertical error bars represent noise in the image.

The intensity graph displays a graph of the measured intensity in the selected ROI at 
each wavelength in the analysis. The intensity is normalized to the selected source 
spectrum and the filter transmission properties.

To export graph data:

1. Click the Export Data button .

2. In the dialog box that appears, select a directory for the data and enter a file name
(.csv). 

The data can be opened in a spread sheet application such as Microsoft® Excel®.
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7.4 Managing Planar Spectral Imaging Results

To save results:

1. Select the results of interest (Splm_xx) from the 
Name drop-down list

2. Click Save.
- The planar spectral imaging results are saved 

with the image.

To view results:

1. Select the results of interest from the Name drop-
down list.

2. Click Load.

To delete results:

1. Select the results that you want to delete from the 
Name drop-down list.

2. Click Delete.

To copy selected results:

1. Right-click the results (row) of interest and select 
Copy Selected from the shortcut menu that 
appears. 
- The selected results are copied to the system 

clipboard.

To copy all results:

1. In the Results tab, right-click the results table and 
select Copy All from the shortcut menu that 
appears.
- All of the results table is copied to the system 

clipboard.

To Export Results:

1. Right-click the results table and select Export 
Results from the shortcut menu that appears.

2. In the dialog box that appears, choose a folder for 
the results, enter a file name (.txt), and click Save.
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8 Spectral Unmixing
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The Living Image® software uses spectral unmixing to distinguish the spectral 
signatures of different fluorescent or bioluminescent reporters and calculate the 
respective contribution of each on every pixel of an image. Use spectral unmixing to:

• Extract the signal of one or more fluorophores from the tissue autofluorescence. 
Images can be acquired using epi-illumination (excitation light above the stage) or 
transillumination (excitation light below the stage)

• Analyze bioluminescence images when more than one reporter is used in the same 
animal model

Use the imaging wizard to setup the image sequence required for spectral unmixing. 
(For more details on the imaging wizard, see page 23.) If you do not use the imaging 
wizard to set up the image sequence, it is recommended that the image sequence include 
images acquired using several filters that sample the emission or excitation spectra at 
multiple points across the entire range. Make sure that the band gap between the 
excitation and emission filters is sufficiently large (for example, >40 nm) so that the 
excitation light does not leak through the emission filter where it can be detected by the 
CCD.
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8.1  Spectral Unmixing

1. Load the image sequence.

In this example, the fluorophore is Quantum Dots 800. Images were acquired using 
a 675 nm excitation filter and emission filters from 720 to 820 nm in 20 nm 
increments.

2. In the Analyze tab of the Spectral Unmixing tools, put a check mark next to the emission 
wavelengths that you want to include in the analysis.

3. In the Components drop-down list, select the 
number of spectral components to unmix in the 
images (the number of fluorophores +1 since 
tissue autofluorescence accounts for 1 
component). 

For example, if the image data includes one 
fluorophore, then there are two components to 
unmix−the fluorophore signal and the tissue 
autofluorescence.

Excitation 
wavelength

Emission 
wavelengths of 
the sequence
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4. Make a selection from the Mask drop-down list:

• Photo - Opens the Photo Mask Setup window. 
The purple mask specifies the area for 
analysis. 

a. Use the Threshold slider or  arrows to 
adjust the mask so that it matches the 
underlying subject photograph as closely as 
possible without including any area outside 
the subject image.

b. Click Set.

• All - The entire image is analyzed. This option 
is not recommended. It introduces many off-
target pixels that might mislead and 
significantly slow down the analysis

• ROI - ROIs applied to the sequence are available in the drop-down list. Select an 
ROI to analyze just the area in the ROI. This option is recommended for well 
plates or dark objects where it is hard to achieve a good mask from the 
photograph.

5. In the tool palette, click Unmix Spectra.
- The spectral unmixing results appear. The Distribution tab shows a photon 

density map of each unmixed result and a composite image that includes all of 
the fluorescent signals, each displayed in a different color.

Composite = Unmixed 1 + Unmixed 2

Unmixed 1 = Autofluorescence 

Unmixed 2 = 
Fluorophore signal
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Item in the 
Concentration Plot

Description

Click to show the controls to adjust the fluorescence opacity and the 
color table display in the concentration plot. Click anywhere in the 
window to hide the controls.

Show Labels Choose this option to display image labels on the concentration plot 
and composite image.

6. To analyze an unmixed image, double-click the image.
- The image appears in a separate image window and the tool palette is available. 

This enables you to make ROI measurements and image adjustments that are 
saved with the image.

7. To view the composite image 
separately, double-click the 
composite image. 
- The Composite tab displays the 

composite image. This enables 
you to export, print, or copy the 
composite image to the system 
clipboard.
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8.2  Spectral Unmixing Results Window

The results are displayed in the three tabs of the Spectral Unmixing Results window.

Spectra Tab The spectrum plot shows the normalized spectra of the unmixed results. You can edit 
the appearance of the spectrum plot using the tools in the spectral unmixing tool palette 
(Spectrum tab) (Figure 8.1). 

Figure 8.1  Spectral unmixing tools and spectrum plot

Table 8.1  Tool palette, spectral unmixing tools

Item Description

Opens a dialog box that enables you to select a spectrum to add to the 
spectrum plot.

Opens a dialog box that enables you to edit a spectrum in the spectrum 
plot. Note: You can also double-click a spectrum row in the tool palette 
(Spectrum tab) to open the dialog box.

Deletes the spectrum from the spectrum plot

Type The type of spectrum.

A list of the spectra in the results. Add/remove a check mark to show/hide the 
spectrum in the spectrum plot. Click a spectrum (row) to display in the preview pane.

Spectrum Plot
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8.3 Spectral Unmixing Parameters

The Results tab in the Spectral Unmixing tool palette shows the optimized fit 
parameters used by the software to derive the spectral unmixing results (Figure 8.2).

SOL A spectrum generated by the spectral unmixing algorithm.

ROI A spectrum calculated for a user-selected ROI.

LIB A user-selected library spectrum. The library includes spectra obtained of 
different sources obtained using excitation and emission filters. 

Name The spectrum identifier used by the unmixing algorithm. The name 
cannot be modified.

Label The spectrum name in the spectrum plot key. The label can be edited.

Color The color of the spectrum in the spectrum plot. For the SOL type 
spectrum, it is also the color in the composite image.

Spectrum Preview Shows the spectrum selected above (click a row above the preview 
pane).

Use this tool to pick up a pixel in an opened image and plot the spectrum 
at this pixel in the spectrum preview.

Table 8.1  Tool palette, spectral unmixing tools

Item Description

Figure 8.2  Tool palette, Spectral unmixing tools, Results tab

Table 8.2  Spectral unmixing tools, Results tab

Item Description

Number of Iterations The number of iterations that the algorithm used.
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Number of 
Components

The number of components unmixed.

Number of 
Wavelengths

The number of wavelength pairs used in the analysis.

Number of Samples The number of pixel samples used in the analysis

Lack of Fit (%PCA) The fitting residue compared to the data filtered by principal 
component analysis.

Lack of Fit (% EXP) The fitting residue compared to the experimental data.

Divergence Counter The number of divergences that occurred.

Maximum Iterations The maximum number of iterations allowed.

Denoise (PCA) Indicates how much of the data was filtered by principal component 
analysis.

Normalization The normalization method used in the analysis.

Non-negativity 
Method

The non-negativity method used in the analysis.

Weighting Mode The weighting method applied to the data.

Column Weighting 
Mode

Indicates if column-wise weighting was used.

Row Weighting 
Mode

Indicates if row-wise weighting was used.

Click to display the spectrum plot tab.

Click to display the concentration plot tab.

Table 8.2  Spectral unmixing tools, Results tab

Item Description
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8.4  Spectral Unmixing Options

In the spectral unmixing tools, the Options tab shows the user-modifiable parameters 
in the spectral unmixing algorithm (Figure 8.3). It is recommended that you first perform 
spectral unmixing using the default settings. Then, if necessary, change the option 
settings and reanalyze the data.

Figure 8.3  Tool palette, spectral unmixing options

Table 8.3  Spectral unmixing options

Option Description

Constraints The constraints for unmixing the components. 

Init The method for generating the initial guess of the spectrum for the 
selected component. “Auto” means this is automatically 
determined by the software. Alternatively, you can used a loaded 
spectrum as the initial guess.

Lock The lock option determines whether the spectrum is allowed to 
change. If this option is chosen, the spectrum of that component is 
not updated during unmixing.

Unimod Choose this option to apply the unimodality constraint. Unimodality 
forces the spectrum to have only one peak (one extremum). 
however, small magnitude extrema are allowed if they are less than 
the Unimod Tolerance value. This tolerance value limits the rising 
slope of the second spectral peak. For example, 5% tolerance 
means that the increase in magnitude of the neighboring nodes 
cannot exceed 5%.
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HP Sets a high pass filter for the spectrum. Signal below the HP cut-off 
frequency is forced to zero. Choose N/A to turn off the high pass 
filter. Otherwise, the value represents the high pass cut-off 
frequency. This constraint can help isolate components that are 
physically mixed and difficult to distinguish.

LP Sets a low pass filter for the spectrum Signal above the LP cut-off 
frequency is forced to zero. Choose N/A to turn off the low pass 
filter. Otherwise, the value represents the cut-off frequency of the 
low pass cut-off frequency. This constraint can help isolate 
components that are physically mixed and difficult to distinguish.

Sort Choose this option to automatically sort the unmixed spectra in 
ascending order of their center wavelength.

Force Choose this option to force the first component to non-zero 
throughout the image.

Denoise by PCA Determines how much of the data will be filtered by principal 
component analysis. Stronger denoising means less principal 
components will be used in the data and more details will be lost. 
Stronger denoising also may slow down the unmixing.

Unimod Tolerance (%) The threshold for the unimodality constraint. It is the percentage of 
overshoot allowed for the second spectral peak.

PCA

Mode PCA can be performed on the original data, the correlation matrix of 
the original data, or the covariance matrix of the original data.

Click to display the explained variance.

Click to display the biplot graph.

Table 8.3  Spectral unmixing options

Option Description
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PCA Biplot The PCA biplot is a visualization tool for principal component analysis. It shows a 
simultaneous display of n observations (pixels) and p variables (wavelengths) on a two-
dimensional diagram.

PCA 

Figure 8.4  PCA biplot
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PCA Explained 
Variance

The PCA Explained Variance histogram shows the part of variance (y-axis) that can be 
explained by a number of principal components (x-axis). 

Figure 8.5  PCA explained variance
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9 Generating a Surface Topography
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A surface topography (surface) is a reconstruction of the animal surface derived from 
structured light images. (For additional details on the surface topography, see page 233.) 
A surface is required for point source fitting and 3D reconstruction of bioluminescent 
sources (DLIT analysis) or fluorescent sources (FLIT analysis) inside a subject. 

9.1 Generate the Surface Topography

4. Draw a crop box that includes a one cm margin around the subject, if possible.

Figure 9.1  Tomography analysis box

1. Load the image sequence that you want to 
analyze. (For details on how to load a sequence, 
see page 37).

2. In the tool palette, click Surface Topography.

3. Click Reconstruct.
- The tomography analysis box appears (Figure 

9.1).

Crop 
box

Mask (purple)
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5. Click Next to display the mask.

The mask is a purple overlay on the subject image that defines the area of interest 
for the surface topography reconstruction. The mask should match the underlying 
photograph of the subject as closely as possible without including any area outside 
the subject image.

6. If you want to smooth the surface, confirm the default surface generation options 
and surface smoothing parameters or enter new values. (For more details on the 
parameters, see Table 9.1).

7. If you want to save the results, confirm the default name for the results or enter a 
new name.

8. If necessary, adjust the threshold value so that the mask fits the subject image as 
closely as possible without including any area outside of the subject. To change the 
threshold, do one of the following:

• Press the left or right arrow keys on the keyboard.

• Move the Threshold slider left or right.

• Click the  arrows or enter a new value in the box.

9. Click Finish.
- The surface and 3D tools appear. For more details on the tools, see page 150.

f

Surface
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Table 9.1  Surface topography options & parameters

Item Description

Surface Reconstruction

Structured Light A drop-down list of structured light images in the 
sequence. Select one for use in reconstructing the 
surface.

SL Binning The binning level applied to the pixels that are used to 
construct the surface topography from the structured light 
image. If Auto is chosen, the software automatically 
determines the appropriate binning level. The higher the 
binning level, the lower the mesh resolution. For more 
details on binning, see page 192.

Reconstruct Click to generate the surface.

Surface Smoothing 

Smoothing Level The amount of smoothing to apply to a reconstructed 
surface.

Restore Removes smoothing that was applied to a surface.

Loss Recovery Smoothing can cause loss in the surface volume or 
height. Make a selection from the drop-down list to 
reduce losses. 'Height' is recommended for IVIS 200 or 
IVIS Spectrum surfaces.

Smooth Initiates the smoothing specified.

Save Results

Name The name of the surface. 

Delete Click to delete the surface selected from the Name drop-
down list.

Load Click to load the surface selected from the Name drop-
down list.

Save Click to save the surface to the name entered in the Name 
drop-down list.
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9.2  Managing Surfaces

The generated surface can be saved for shared use by the Point Source Fitting, DLIT, 
or FLIT tools. 

Saving a Surface 1. Confirm the default name or enter a new name.

2. Click Save.

Loading a Surface 1. Select the surface that you want to use (for point source fitting, DLIT analysis, or 
FLIT analysis) from the Name drop-down list.

2. Click Load.

Deleting a Surface 1. Select the surface that you want to delete from the Name drop-down list.

2. Click Delete.

Figure 9.2  Tool palette, Surface topography tools

Surface name
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10 Point Source Fitting
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The point source fitting algorithm is a tool for advanced users that can be used to 
estimate the optical properties of tissue, the location and power of a point source, or the 
fluorescent yield of fluorophores. The software analyzes the images in a sequence 
acquired in one of the following imaging modes:

• Bioluminescence

• Transillumination fluorescence (bottom-illuminated fluorescence)

• Epi-illumination fluorescence (top-illuminated fluorescence)

• Transmission

NOTE
The point source fitting algorithm requires an image sequence that includes one or 
more images and a structured light image.

10.1 Displaying the Point Source Fitting Tools

The default tool palette does not include the point source fitting tools.

To display the point source fitting tools in the tool palette:

1. Select Edit → Preferences on the menu bar.

2. In the dialog box that appears, put a check mark next to Show Advanced Options, and 
click OK.
- The point source fitting tools appear in the tool palette (Figure 10.1).
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Figure 10.1  Tool palette, point source fitting tools & results
If the image sequence does not include a structure light image, the point source fiting tools 
do not appear in the tool palette.

Analyze tab

Analysis tab shows the
active image sequence.

Click the + sign to display 
the position of the bottom 
illumination source read 
from the click info (x,y or 
x,y,z, depending on the 
image model). 

Starting parameter values.

Select other starting 
values for the optical 
properties here.

Point source fitting results.

Params tab

Properties tab Results tab
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Table 10.1  Tool palette, point source fitting 

Item Description

Analysis Tab

Image # Image number in the active sequence.

ExWL Excitation wavelength

EmWL Emission wavelength

MinRadiance Minimum surface radiance used for model fitting.

x,y x- and y-coordinates of the bottom illumination source.

Params Tab

Model Type The image acquisition mode.

Angle Limit (deg) The angle limit refers to the angle between the object surface 
normal and the optical axis. (For more details, see page 240.)

Spatial Filter Filters out the noisy data at the mouse edges. A setting of 0.1 
means that the analysis includes 90% of the data from the 
center of mass to the edges.

Parameter starting values Note: Selecting a tissue Properties tab automatically updates 
MuaEm, MusEm/ MuaEx, and MusEx in the Params tab.

x, y, or z Source coordinates.

F-yield/Power Fluorescence yield/strength of illumination or bioluminescence 
source.

MuaEm Absorption coefficient at the emission wavelength.

MusEm Reduced scattering coefficient at the emission wavelength.

MuaEx  Absorption coefficient at the excitation wavelength.

MusEx  Reduced scattering coefficient at the excitation wavelength.

Restore Defaults Resets the model type, algorithm starting parameters and 
algorithm options to the default values.

Mask A drop-down list of ROIs in the selected image. Select an ROI 
to compute only the source in the ROI.

Statistics Weighting Choose this option to apply a statistical weighting technique to 
help reduce the error associated with high radiance 
measurements.

LM Fitting Click to begin the point source fitting.

Properties Tab

Tissue Properties Make a selection from this drop-down list to specify starting 
values for the parameters other than the defaults. Note: 
Selecting a tissue property automatically updates MuaEm, 
MusEm/ MuaEx, and MusEx in the Params tab.

Internal medium index of 
refraction

The internal medium index of the tissue selected from the 
Tissue Properties drop-down list. You can also enter a user-
specified value.

Results Tab

MuaEm Absorption coefficient at the emission wavelength.

MusEx Reduced scattering coefficient at the excitation wavelength.

Mueff Effective attenuation coefficient 

Mueff = 

Diff Diffusion coefficient, Diff = (Mua +Mus)/3

3Mua Mua Mus+( )
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10.2 Point Source Fitting

Point source fitting is performed separately on each image in a sequence.

X location of the source X-coordinate of the source location.

Y location of the source Y-coordinate of the source location.

Z location of the source Z-coordinate of the source location.

Starting ChiSqure Error between the measured and simulated photon density at 
the start of the analysis.

Ending ChiSqure Error between the measured and simulated photon density at 
the end of the analysis.

Table 10.1  Tool palette, point source fitting 

Item Description

1. Open the image sequence that you want to analyze.

2. In the Analysis tab, select an image in the sequence.

3. In Surface Topography tools, generate or load a surface. For more details on generating 
the surface, see page 125.
Note: It is recommended that you use the smoothing tool to generate a good 
quality surface.
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4. Click the Params tab.
- The default starting values for the source location, power, and tissue optical 

properties are displayed.
Note: The software automatically selects the correct model type for the image data.

5. If you want to fix a parameter starting value, click the unlocked icon  so that it 
becomes a closed lock .

6. If you want to construct the source only in a region of interest, make a selection from 
the Mask drop-down list.

7. Confirm the angle limit and spatial filter defaults or enter new values.

8. To specify different starting values for the optical properties:
a. Click the Properties tab.

b. Make a selection from the Tissue Properties drop-down list.

c. Confirm the internal medium index of refraction or enter a new value.

9. In the Params tab, click LM Fitting.
- The source appears on the mesh and the Results tab displays the point source 

fitting results.
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10.3 Checking the Point Source Fitting Results

10.4 Exporting Results

1. In the Results tab, click 
Photon Density Maps.
- The Photon Density Maps 

window appears.

2. Select the image from 
the Image sources 
drop-down list.

3. Compare the simulated 
and measured photon 
densities.

To export all results:

1. In the Results tab, click Export results.

2. In the dialog box that appears, select the 
destination folder for the results and click OK.
- The results include a .txt, .csv, .xsc (source 

information), and a .xmh (surface mesh) file.

To export user-selected results:

1. Right-click the item of interest in the results list, and 
select Export Results on the shortcut menu.

2. In the dialog box that appears, choose a folder for 
the results, enter a file name (.txt), and click Save.
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10.5  Managing Point Source Fitting Results

To save results:

1. Select the results of interest (LMFIT_xx) from 
the Name drop-down list

2. Click Save.
- The point source fitting results are saved with 

the image.

To view results:

1. Select the results of interest from the Name 
drop-down list.

2. Click Load.

To delete results:

1. Select the results that you want to delete from 
the Name drop-down list.

2. Click Delete.

To copy selected results:

1. Right-click the results (row) of interest and select Copy Selected from the 
shortcut menu that appears. 
- The selected results are copied to the system clipboard.

To copy all results:

1. In the Results tab, right-click the results table and select Copy All from the 
shortcut menu that appears.
- All of the results table is copied to the system clipboard.
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The Living Image® software includes algorithms for 3D reconstruction of 
bioluminescent or fluorescent sources (tomographic analysis):

• Diffuse Tomography (DLIT™) algorithm - For tomographic analysis of 
bioluminescent sources. Analyzes a bioluminescent image sequence obtained on 
the IVIS® Imaging System 200 or IVIS Spectrum. 

• Fluorescent Tomography (FLIT™) algorithm - For tomographic analysis of 
fluorescent sources. Analyzes a fluorescent image sequence obtained on the IVIS® 
Spectrum imaging system.

The steps to perform 3D reconstruction of bioluminescent/fluorescent sources include:

1. Acquire an image sequence.

2. Generate the surface topography (surface) of the subject. 

3. Set the user-modifiable DLIT/FLIT algorithm parameters (for example, analysis 
wavelengths, source spectrum, and tissue properties) and reconstruct the position, 
geometry, and strength of the luminescent sources.

For more details on the DLIT/FLIT algorithm, see 3D Reconstruction of Light Sources, 
page 233.
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11.1  3D Reconstruction of Bioluminescent Sources

General 
Considerations

Animal Requirements

The best surface topography reconstruction is obtained from nude mice. It is possible 
to perform 3D imaging on white or light-colored furred mice if the fur is reasonably 
smooth over the mouse surface. Therefore it is recommended that you comb the fur 
before imaging to eliminate any "fluffy" areas that may trigger artifacts during the 
surface topography reconstruction. 3D reconstructions are currently not possible on 
black or dark-colored furred mice. In this case, it is recommended that you shave the 
animals or apply a depilatory.

Luminescent Exposure vs. Luciferin Kinetic Profile

It is important to consider the luciferin kinetic profile when you plan the image 
sequence acquisition. The DLIT algorithm currently assumes a flat luciferin kinetic 
profile. Therefore, to optimize the signal for DLIT 3D reconstruction, carefully plan the 
start and finish of image acquisition and ration the exposure time at each emission filter 
so that the sequence is acquired during the flattest region of the luciferin kinetic profile. 

Generate a Surface 
Topography

For details on generating the surface, see page 125

Set Up & Acquire an 
Image Sequence

Use the imaging wizard to setup the image sequence required for DLIT™ analysis. (For 
more details on the imaging wizard, see page 23.) If you plan to manually set up the 
sequence, Table 11.1 shows the recommended image sequence. Analyzing more 
images usually produces more accurate results. At a minimum, the sequence must 
include data from at least two different emission filters (560-660 nm):

• Emission filter #1: Photographic, luminescent, and structured light image.

• Emission filter #2: Luminescent image.

NOTE
The binning level must be the same for all of the luminescent images.

After the surface is generated, the 3D reconstruction of the light sources can proceed. 
Figure 11.1 shows example results. For more information on the DLIT algorithm and 
user-modifiable parameters, see Appendix H, page 238.

Table 11.1  Recommended image sequence for DLIT analysis 

Image Type Emission Filter Options

560 580 600 620 640 660

Photographic ✓ Select the Reuse Photographs 
option in the control panel. 

Structured light ✓

Luminescent ✓ ✓ ✓ ✓ ✓ ✓
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1. In the tool palette, click DLIT 3D Reconstruction.

2. In the Properties tab, make a selection from the 
“Tissue Properties” and “Source Spectrum” 
drop-down lists.

“Muscle” is usually the best choice of tissue 
properties for general in vivo reconstructions.

Note: The internal medium index of refraction is 
automatically entered when you select a tissue.

3. If you want to view the “Tissue Properties” (μa, 
μeff, μ’

s) or “Source Spectrum” for the tissue and 
light source selected above, make a selection 
from the Plot drop-down list in the Properties 
tab.

4. In the Analyze tab, select the acquisition 
wavelengths (560-660 nm).

5. If necessary, edit the minimum radiance 
associated with an acquisition wavelength or 
angle. For more details on the minimum 
radiance, see page 239.

Note: It is recommended that you only analyze 
images that have signal well above the noise. 

6. To edit the minimum radiance, double-click the 
entry and enter a new value. 

Note: The minimum radiance level can be 
observed by looking at individual images and 
adjusting the min level on the color bar, in 
radiance units (photons/sec/cm2).
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7. In the Params tab, confirm the parameter defaults or enter new values. 

For more details on the parameters, see Appendix H, page 238.

8. In the Analyze tab, click Reconstruct.

The reconstruction requires about 1-5 minutes, depending on the parameter 
settings and the processor speed.

Figure 11.1 shows example 3D reconstruction results.

Params tab

Angle limit default is 70° for 
IVIS® Imaging System 200 
Series or IVIS® Spectrum data.

DLIT algorithm 
user-modifiable 
parameters



141

Living Image® Software User’s Manual

Figure 11.1  Viewing DLIT 3D reconstruction results, Results tab (top) and 3D tools (bottom)

The 3D View in the 
image window 
displays the surface, 
the 3D reconstruction 
of the bioluminescent 
light sources inside 
the subject (voxels), 
and the photon 
density map (photons/
mm3 just below the 
surface). 

Results tab displays the 
results data and the DLIT 
parameter values.

To best view the light 
sources (voxels):

1. In the 3D tools, 
move the slider or 
enter an opacity 
value to adjust the 
surface opacity.

2. Clear the Render 
Photon Density 
Map option to 
display the surface 
without the photon 
density map.

Light sources (voxels)

Image window, 3D view
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11.2 3D Reconstruction of Fluorescent Sources

Set Up & Acquire an 
Image Sequence on the 
IVIS® Spectrum

Use the imaging wizard to setup the image sequence required for FLIT™ analysis. (For 
more details on the imaging wizard, see page 23.) If you plan to manually set up the 
sequence, Table 11.2 shows the recommended image sequence. Acquire the images 
using transillumination on the IVIS Spectrum using the same excitation and emission 
filters from at least four source locations.

Generate the Surface 
Topography

For instructions, see page 137.

Set the FLIT 
Parameters & 
Reconstruct the 
Sources

After the surface is generated, the 3D reconstruction of the light sources can proceed.

1. In the tool palette, click FLIT 3D Reconstruction.

2. In the Properties tab, make a selection from the Tissue Properties drop-down list. 
“Muscle” is usually the best choice of tissue properties for general in vivo 
reconstructions.

Note: The internal medium index of refraction is automatically entered when you 
select a tissue.

Table 11.2  Example image sequence for FLIT analysis

Image Type Source Location

First location Subsequent locations

Photographic ✓ Use previous photo

Structured light ✓

Fluorescent ✓ ✓

Source 01 corresponds to the first 
image of the sequence, source 02 
corresponds to the second image, 
and so on

Analyze tab
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3. In the Params tab, confirm the parameter defaults or enter new values. 

For more details on the parameters, see Appendix H, page 238. It is recommended 
that you start with the default parameter settings. If necessary, fine tune the 
settings in the parameters tab. For more details on the parameters and options, see 
Appendix H, page 233.

4. In the Analyze tab, select the source locations to include in the analysis and click 
Reconstruct. 
- Figure 11.1, page 141 shows example 3D reconstruction results

Properties tabParameters tab
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11.3  DLIT & FLIT Results

The Results tab displays information about the photon density, voxels, and DLIT or 
FLIT algorithm parameters.

NOTE
For more details on the DLIT and FLIT algorithm parameters, see Appendix H, 
page 233. Sometimes adjusting the DLIT algorithm parameters improves the fit of the 
simulated photon density to the measured photon density data.

Figure 11.2  3D reconstruction results, FLIT (left) and DLIT (right)

Table 11.3  3D reconstruction results

Item Description

Optimized fit parameters

Total source flux (phot/s) (DLIT 
result)

The sum of the bioluminescent source intensities.

Total fluorescence yield (N mm2) 
(FLIT result)

The total sum of the fluorescent yield. The quantity 
measured is:

(Fluorescence quantum efficiency for the excitation 
wavelength to emission wavelength photons)*(Excitation 
wavelength photon absorption cross section)*(Fluorophore 
number density)*(Volume of voxel size). To convert the 
'Fluorescence Yield' measurement to the number of 
fluorescent compounds, divide the 'Fluorescent Yield' 
values by measured quantities of [Fluorescence quantum 
efficiency of excitation wavelength conversion to emission 
wavelength]*[Excitation photon absorption cross section] 
for the fluorophore.
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Final vsize The voxel size (length of a side, mm) that produces the 
optimum solution to the DLIT or FLIT analysis.

Number of sources The number of voxels that describe the light source(s).

Reduced Chi2 A measure of the difference between the computed and 
measured photon density maps at the optimum solution. A 
smaller χ2 value indicates a better quality of fit. 

Starting vsize The voxel size at the start of the analysis.

Kappa (best) (DLIT result) The kappa value that produces the optimum solution.

N surf (best) The number of surface element data analyzed per 
wavelengths/images.

Total surf samples The total number of surface element data analyzed for all 
wavelengths/images.

Threshold angle The angle that the object surface normal makes with the 
optical axis. The optical axis can be considered to be a line 
perpendicular to the stage. The default setting for this limit 
is 70°  for IVIS Spectrum or IVIS 200 or IVIS Spectrum data. 
For more details, see Angle Limit, page 239.

Kappa limits (DLIT result) The kappa parameter is a parameter that is searched during 
a reconstruction to determine the best fit to the image data. 
For more details, see Kappa Limits (DLIT), page 240.

N surface limits (DLIT result) The maximum number of surface intensity points to use in 
the reconstruction for each wavelength. The range is 200 to 
800 and the default is 200. The reconstruction time is 
shorter for smaller values of N (for example, 200). However 
larger values of N may give a more accurate result because 
more data are included in the fit.

Starting Voxel Size (DLIT/FLIT) The length of the side of the voxel cube in mm units for the 
coarsest initial grid size in the adaptive gridding scheme.

Voxel size limits (DLIT result) The starting voxel size range evaluated by the algorithm to 
determine the optimum solution.

Voxel size increment (DLIT result) The incremental change in voxel size evaluated at each 
iteration during the DLIT analysis.

Uniform Surface Sampling TRUE = the option is chosen and the surface data for each 
wavelength is sampled spatially uniformly on the signal 
area. FALSE = the option is not chosen and the N brighter 
surface elements are used as data in the reconstruction.

NNLS + Simplex Optimization TRUE = the option is chosen and a non-negative least 
squares optimization algorithm is used in addition to the 
SIMPLEX algorithm to seek the optimum solution. FALSE 
= only the NNLS algorithm is used to seek the optimum 
solution.

NNLS Weighted Fit TRUE = the option is chosen and the DLIT or FLIT algorithm 
weights the wavelength data inversely proportional to its 
intensity in the NNLS reconstruction. FALSE = the option is 
not chosen

Min Radiance The wavelength image data minimum radiance [photons/
sec/cm2/sec] to use in the DLIT or FLIT analysis.

Index of Refraction The internal medium index of refraction that is associated 
with the user-selected tissue.

Table 11.3  3D reconstruction results

Item Description
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Viewing Photon 
Density 

Photon density is the steady state measure of the number of photons in a cubic 
millimeter. Light sources inside the tissue contribute to photon density in other portions 
of the tissue. The DLIT or FLIT algorithm first converts the luminescent image of 
surface radiance to photon density just below the animal surface because this is what 
can be observed. Then the DLIT or FLIT algorithm solves for point source locations 
inside the tissue which would produce the observed photon density near the surface. 

To check the quality of the DLIT or FLIT construction, it is useful to compare the 
measured and simulated photon density plots. The photon density is closely related to 
the measured radiance.

Tissue Properties The user-specified tissue in which the 

sources should be located.

Source Spectrum The emission spectrum of the type of bioluminescent 
source.

Photon Density Maps 

Simulated The photon density computed from DLIT/FLIT source 
solutions which best fit the measured photon density (see 
page 147).

Measured The photon density determined from the image 
measurements of surface radiance.

Wavelength The wavelength of the photon density map in the active 
image.

Source Image The image number of the transillumination source image.

Photon Density Maps Click to open the Photon Density Maps window.

Save Results

Name The default name for the active DLIT or FLIT results.

Delete Click to delete the selected DLIT or FLIT results.

Load Click to load the selected DLIT or FLIT results.

Save Click to save the active DLIT or FLIT results.

Overwrite If you reanalyze saved results, click to save the new results 
and overwrite the previous results.

Table 11.3  3D reconstruction results

Item Description
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To view the photon density maps:

1. In the Results tab, click Photon Density Maps.
- The Photon Density Maps window displays the photon density maps for all 

wavelengths.

Note: The voxels are also automatically displayed when the 3D reconstruction is 
completed. For more details on measuring the voxels, see page 158.

2. To display the measured and simulated photon density profiles:
a. Select a wavelength. 

b. Drag the crosshair to the location of interest.
- The horizontal and vertical photon density profiles are updated.

In a good reconstruction, the 
measured (blue) and 
simulated (red) photon 
density curves are close.

Select one or all wavelengths for display.

Move the 
wheel to the 
left or right 
to rotate the 
surface on 
the vertical 
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3D Tools The 3D tools appear in the tool palette when a surface topography (surface) or 3D 
source is reconstructed, or when you open saved results.

For Details on... See Page

3D tool buttons 150

Mesh tab 156

Volume tab 158
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Organs tab 161

Animation tab 168

For Details on... See Page
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11.4  3D Tools

Figure 11.3  3D tools and DLIT results in the 3D view window

Table 11.4  3D Tools

Item Description

Image Tools A drop-down list of tools for viewing and working with the surface or DLIT 
results. 

Select  to:

• Click and display measurement dimensions in the coronal, sagittal, or 
transaxial view (in the 3D view window).

• Drag a measurement cursor in the coronal, sagittal, or transaxial view and 
display measurement dimensions. (For details on measurement cursors, 
see page 159.)

Select  to zoom in or out on the image (use a click-and-drag operation).

Select  to move the subject in the window (use a click-and-drag 
operation).

Select  to rotate the subject around the x, y, or z axis (use a click-and-
drag operation).

to select a tool to work with the surface or 3D results (perspective view only). 

to select a surface drawing style.

to select a shading style for the surface. 

Click:
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Drawing Styles A drop-down list of drawing styles for the surface (for examples, see 
Figure 11.3, page 150). The Surface face drawing style ( ) is the 
default. 

Shading Styles A drop-down list of shading styles for the surface (for examples, see , 
page 152). The Reflect smooth surface face shading style ( ) is the 
default.

Select this tool from the drop-down list to change the view perspective 
(top, bottom, left, right, front, back, or perspective view). For examples of 
the views, see Figure 11.6.

Select this tool from the drop-down list to display the perspective view.

Click to show or hide measurement cursors in the coronal, sagittal, or 
transaxial views.

Click to display the manual transform tool.

Automatic atlas registration tool.

Click a voxel in the 3D reconstruction, then click this button to display 
measurements for the voxel in the 3D tools (source voxel measurements).

Click to hide or show the x,y,z-axis display in the 3D view window.

Click to hide or show coronal, sagittal, and transaxial planes through the 
subject in the 3D view window.

Click to show or hide a bounding box around the subject.

Click to show or hide a grid under the subject.

Table 11.4  3D Tools

Item Description

Point cloud

Wire frame

Surface face

Wire frame and surface face

Smooth face

Smooth surface face

Reflect surface face

Reflect smooth surface face
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Rotate, Move, or Zoom 
on a 3D Image

To rotate the image:

1. Choose the  or  tool.

2. Place the pointer in the 3D View window.

3. Click and drag the pointer in the x, y, or z-axis direction.
- The x,y,z-axis shows the orientation of the image.

To move the image:

1. Select the  arrow in the 3D tools and drag the image. Alternatively, press the 
Shift key while you drag the image.

To zoom in or out on the image:

1. Select the  arrow in the 3D tools. 

2. To zoom in on the image (magnify), right-click (Ctrl+click for Macintosh users) and 
drag the  toward the bottom of the window.

To zoom out on the image, right-click and drag the  toward the top of the window.

Axis shows image orientation.Select a tool from the drop-down list.
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Selecting a Drawing or 
Lighting Style for the 
Surface

You can choose a different drawing and lighting style to change the appearance of the 
surface.

Figure 11.4  Surface drawing styles

 Point cloud surface  Wire frame surface  Surface face surface Wire frame & 
surface face 

To choose a drawing style, make a selection from the Drawing style drop-down list in the 3D 
tools.
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Figure 11.5  Surface shading styles

 Surface face  Smooth surface face  Reflect surface face Reflect smooth 
surface face

To choose a shading style, make a selection from the Shading style drop-down list in the 3D tools.
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Changing the View 
Perspective

You can view a 3D image from different perspectives. Figure 11.6 shows examples of 
the other available views.

To change the view:

• Select  to change the view. 

• Alternatively, click the surface, then press the V key to cycle through the different 
views of the surface (Figure 11.6).

•Select  to display the perspective view.

Note: Only the perspective view (the default view) can be rotated or moved in the 3D 
view window.

View name
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11.5 3D Tools - Mesh Tab

The Mesh tab includes tools for viewing the reconstructed surface, photon density 
maps, and planes through the 3D reconstruction.

Figure 11.6  Alternative views of the surface

Top Bottom Front 

Right Left Back 

Figure 11.7  3D tools, mesh tab
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Table 11.5  Mesh tab

Item Description

Render Mesh Choose this option to display the surface in the 3D view window. It may be 
helpful to turn off the surface to better view the photon source 3D 
reconstruction.

Opacity Controls the surface opacity. A lower number makes the surface more 
transparent. This may be helpful for viewing the photon source 3D 
reconstruction.

Photon Density 
Map

Choose this option to display the photon density map. (If the DLIT 
reconstruction of the bioluminescent source has not been generated, this 
option is not available.)

Apply Select the simulated (computed by the DLIT algorithm) or measured photon 
density for the photon density map.

Images A drop-down list of the images used to reconstruct the surface. Make a 
selection from the list to view the DLIT/FLIT results associated with a 
particular image.

Threshold Choose this option to apply a photon density threshold (photons/mm3) to 
the photon density map.

Intensity Use the Intensity slider, the  arrows or enter a value in the box to set the 
minimum intensity threshold. 

Color Table Specifies the color table for the source intensity scale.

Reverse Choose this option to reverse the color table. For example, the BlackRed 
color table represents the source intensity (photons/sec) from low to high 
using a color scale from black to red. If Reverse is chosen, the source 
intensity (photons/sec) from low to high is represented using the color scale 
from red to black.

Logarithmic 
Scale

Choose this option to apply a logarithmic scale to the color table.

Slice Move a slider to change the position of the coronal, sagittal, or transaxial 
plane through the surface. The intersection of the plane and subject (slice) 
is shown in the coronal, sagittal, and transaxial views in the 3D view 
window.
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11.6  3D Tools - Volume Tab

The voxels are automatically displayed when the 3D reconstruction is complete. In the 
3D tools, the Volume tab displays the voxel intensity and other data, and provides tools 
for voxel measurement and display. 

Figure 11.8  3D tools, Volume tab

Table 11.6  3D tools, Volume tab

Item Description

Render Volume Choose this option to display the voxels.

Min The minimum voxel intensity (photons/sec for DLIT results; N mm2 for 
FLIT results).

Max The maximum voxel intensity (photons/sec).

Render voxels as A drop-down list of shapes for voxel display.

Threshold Choose this option to apply a minimum threshold intensity to the voxel 
display. 

Intensity Use the Intensity slider, the  arrows, or enter a value in the box to 
set the minimum threshold intensity.

Color Table Specifies the color table for the voxel intensity scale.

Reverse Choose this option to reverse the color table. For example, the 
BlackRed color table represents the source intensity (photons/sec) 
from low to high using a color scale from black to red. If Reverse is 
chosen, the source intensity (photons/sec) from low to high is 
represented using the color scale from red to black.

Logarithmic Scale Choose this option to apply a logarithmic scale to the color table.

Source Voxel 
Measurement

Click the  button, then click a voxel in the 3D reconstruction to 
display measurements for the voxel. 

Total Flux (DLIT 
results)

The total flux measured for the voxels selected using the voxel tool.

Total 
Fluorescence 
Yield 
(FLIT results)

N mm2 measured for the voxels selected using the Measure Voxels 
tool .

Volume Volume of the selected voxels (mm3).
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To display voxel measurements:

1. Click the Measure Voxels button .

2. On the surface, click a voxel. Alternately, draw a box around a group of voxels.
- The Voxel tab displays the selected voxel data.

3. Repeat step 2 to display data for other voxels.
- The voxel data is updated.

4. To clear the voxel data, click any where in the 3D view window.

To measure the depth of a source(s):
1. Click the Measure Voxels button .

2. Click a voxel or draw a box around a group of voxels.

3. Click Center of Mass.

The Coronal, Sagittal and Transaxial views display the intersection through the 

Center of mass The weighted average x, y, and z-coordinates of the selected voxels, 
where the weights are the flux of each highlighted voxel.

Host Organ Organ location of the selected voxel(s).

Center of Mass Click to compute the center of mass for the selected voxel(s).

Export Voxels Enables you to export the voxel measurements (.csv).

Figure 11.9  Example 3D reconstruction, FLIT results

Table 11.6  3D tools, Volume tab

Item Description

Voxel 
data

Coronal, sagittal, & transaxial views
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voxels' center of mass.

4. Click the Measurement Cursor button .
- The Sagittal and Transaxial views show the distance between the voxel(s) and the 

dorsal or ventral surface (Figure 11.9).

5. To measure another distance, drag each end of the measurement cursor ( ) to 
a new position.
- The distance measurement is updated.

Viewing X,Y 
Coordinates

1. In the Coronal, Sagittal, or Transaxial 
windowpane, click the position of 
interest. 
- The x,y-coordinates (mm) of the 

position are displayed. 

2. If you drag the mouse cursor, the 
coordinates are updated.

To display planes in the 3D image:
1. Click a voxel

2. Click the  button.
- The Coronal, Sagittal, and Transaxial view shows the plane (slice) through the 

voxel.
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3. To change the location of a plane, move the coronal, sagittal, or transaxial slider left 
or right. Alternatively, click the slider, then press the ← or → keyboard arrow keys.
- The Coronal, Sagittal, or Transaxial windowpane is automatically updated.

11.7 3D Tools - Organs Tab

The Living Image® software provides digital mouse atlases that enable you to display a 
3D skeleton and organs on the 3D reconstruction (Table 11.7). Select the atlas and organs 
that you want to display in the Organs tab. The software automatically aligns the organs 
on the surface. However, you can also manually adjust the scale or location of organs 
on the surface. You can also import a custom organ atlas created from Open Inventor 
files (.iv).

Coronal, sagittal, and transaxial views show the slice 
through the surface taken by the associated plane.

Coronal 
plane

Sagittal plane

Transaxial plane

Figure 11.10  3D tools, Organs tab
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Displaying Organs 1. In the 3D Tools, click the Organs tab.

2. Confirm that the surface is in the perspective view (click the  button or press the 
R key).

3. Choose the Render Organs option.

Table 11.7  Organ atlases

Atlas Description

Mouse Atlas-Female 
or Male

Male or female in a dorsal or ventral orientation. Atlas includes organs 
only, no skeleton.

CT-Female or Male Male or female in dorsal, ventral, or lateral orientation. Atlas includes 
organs and skeleton.

Table 11.8  3D tools, Organs tab

Item Description

Organs Choose this option to enable the selection and display of organs on the surface.

Organ 
database

Choose the male or female organ database from the drop-down list.

Organs A list of the organs in the selected organ database. Select the organ(s) that you 
want to display on the surface.

Reset Click to display the selected organs in their default positions.

Click to select all organs in the database and display them on the surface.

Click to clear the selected organs and remove all organ diagrams from the 
surface.

Update scene Click to display the selected organs on the surface.
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4. Select an organ atlas.
- All of the organs in the selected atlas appear on the surface.

5. To co-register the digital organs and the surface:
a. Click the Fit organs to the mouse button .

b. On the drop-down list that appears, click a button to choose an option:
 Rigid registration - Performs linear transformation, but keeps the shape of the 

atlas surface. 

 Full registration - Performs linear transformation and volume deformation.

NOTE
For an optimum fit when there is a large difference between the orientation or size of 
the atlas organs and surface, first use the transformation tool to manually register the 
surface and atlas organs, then click the  or  tool to automatically fit the organs. 
(For more details on manual registration, see below.)

6. If necessary, adjust the opacity of the organs using the slider or enter a number in 
the box.

The organs are easier to view if you do not select Skin in the Organs list.

7. To clear all organs from the surface, click the Deselect All button . To remove a 
specific organ, remove the check mark next to the organ name.

8. To display a specific organ(s), choose the organ name. To display all organs on the 
surface, click the Select All button .

NOTE
If you manually change the location, orientation, or scale of an organ(s), you can click 
Reset to restore the default size and position of the selected organs. 

Manually Adjusting 
the Scale or Location 
of Organs

1. Follow step1 to step 4 above.

2. Click the Transform tool button .
- The transform tool appears.
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3. To adjust the x,y, or z-position of the organ, drag the transform tool.

4. To return the transform tool to the default location, click Reset.

Transform tool
In this example, “Skin” is 
selected from the organ list.
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5. Press the Tab key to put the transform tool in 
scale mode.
- A red cube  appears at each corner of the 

transform tool.

6. To increase or decrease (scale) the size of the 
organ, drag a red cube at a corner of the 
transform tool. Note: To restrict scaling to a 
particular axis, press the X, Y, or Z key, then 
drag a red cube.

7. Press the Tab key again to put the transform 
tool in rotate mode.
- A red, green, and blue circle appear around 

the surface.

8. To rotate the organ on the x,y, or z-axis, click 
the blue, green, or red circle and drag the 
mouse arrow in the direction of interest.

Note: To return the organ drawing to the 
default position and size, click Reset and the 

 button.

9. To turn off the transform tool, click the  
button.

Circle line is thicker when selected
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To check the organ and surface alignment:

1. Check the organ position in the Coronal, Sagittal, and Transaxial windowpanes.

2. In the 3D View tab, click in the 
windowpane with the surface.

3. Press the V key or the  button to display alternative views of the surface.

Top Bottom Front 

Right Left Back 
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Importing an Organ 
Atlas

You can import an organ atlas (Open Inventor format, one organ per .iv) derived from 
MRI or CT scans.

NOTE
The imported atlas must include a skin file named skin.iv.

To import an organ atlas:

1. Open the DLIT results that are associated with the organ atlas.

2. Select File → Import → Organ Atlas on the menu bar.

3. In the Import Organ Atlas box that appears, click Add Organ Files.

4. In the next dialog box that appears, select all of the Open Inventor files that you 
want to include in the atlas (one .iv per organ) and click Open. 

5. In the Select Skin Mesh drop-down list, select the skin organ file, which must have 
the file name ‘skin.iv’.

6. Click Generate Mesh Coefficients.

7. Enter a name for the atlas and click Save Organ Atlas.
- The organ atlas (.atlas) is created. The atlas name appears in the Organ Atlas drop-

down list (in the 3D tools, Organs tab).
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11.8  3D Tools - Animation Tab

The Living Image software can produce an animation from a sequence of 3D views or 
key frames. For example, an animation can depict:

• Magnifying (zooming in on) the 3D view.

• Spinning the 3D view on an axis.

• The surface or organs fading out (decreasing opacity) or fading in (increasing 
opacity).

The animation can be saved to a movie (.mov, .mp4, or .avi).

In the Animation Tab, You Can: See Page

View a preset animation (generated from a predefined animation setup) 170

Create a custom animation (generated from your custom animation setup) 171

Edit & save an animation setup 172

Figure 11.11  Animation tab

Key frame box shows the key frames 
in the current animation setup

Click a key frame to display the 
associated 3D view and time stamp 
(position in the time scale (0-100) at 
which the frame occurs in the 
animation).
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Table 11.9  3D tools, Animation tab

Item Description

Time Scale% The time stamp of a key frame in the animation on a time scale of 0-100. 
For example, if the animation is 10 sec long and includes five key 
frames:

Key frame 1: Time stamp= 0; first frame of the animation.

Key frame 2: Time stamp = 25%; frame occurs 2.5 seconds after the 
start of animation.

Key frame 3: Time stamp = 50%; frame occurs 5.0 seconds after the 
start of animation.

Key frame 4: Time stamp = 75%; frame occurs 7.5 seconds after the 
start of animation.

Key frame 5: Time stamp = 100%; last frame of the animation.

Presets A drop-down list of predefined animation setups.

Key frame A 3D view. The software interpolates the key frames to create 
intermediate frames in real time, then generates an animated sequence 
from all of the frames. Each successive key frame in a sequence should 
differ slightly from the preceding one, so that motion is smoothly 
depicted when the frames are shown at a proper frame rate (frames/
second). The Living Image software provides preset key frames or you 
can specify the 3D views for the key frames.

Preset Key Frame 
Factor

Determines how many key frames are used to generate one revolution 
in a spinning animation (No. of frames = (4 x Key Frame Factor) + 1). 
Increasing the key frame factor reduces the time period between key 
frames and creates the appearance of finer movement. Decreasing the 
key frame factor increases the time period between key frames and 
creates the appearance of coarser movement.

FPS Frames displayed per second in the animation sequence.

Click to create a new key frame from the current 3D view. 

Click to update the selected key frame to the current 3D view.

Click to delete a selected or all key frames from the key frame box.

Click to move a selected key frame up in the key frame box.

Click to move the selected key frame down in the key frame box.

Total Duration The total time of the animation sequence.

Play Click to view the animation sequence defined by the current key frames 
and animation parameters.

Record Displays a dialog box that enables you to save the current animation to 
a movie (.mov, .mp4, or .avi).

Animation Setup

Load Displays a dialog box that enables you to open an animation setup (.xml).

Save Displays a dialog box that enables you to save the current key frames 
and animation parameters to an animation setup (.xml).
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Viewing a Preset 
Animation

To view a preset animation:

1. Open the DLIT/FLIT results.

2. Confirm that the 3D view shows the properties of interest (for example, organs, 
voxels, surface, or photon density maps).

3. In the 3D Tools, click the Animation tab.

4. If necessary, clear the key frame box (click the  button and select Delete All).

5. To view a preset animation, make a selection from the Presets drop-down list. (See 
Table 11.10 for a description of the preset animations.)
- A list of the key frames appears.

6. To view the animation, click Play. 

NOTE
You can view multiple animations sequentially. For example, if you select Spin CW 
on X-Axis and Spin CW on Y-axis from the Presets drop-down list, the animation 
shows the 3D reconstruction spinning clockwise on the x-axis, then spinning 
clockwise on the y-axis.

To save the animation to a movie:

1. Click Record.

2. In the dialog box that appears, choose a directory, enter a file name (.mov, mp4, 
.avi), and click Save.
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Creating a Custom 
Animation

To create an animation, you must specify a custom animation setup or edit an existing 
setup.

1. Open the 3D results of interest.

2. Confirm that the 3D view shows the properties of interest (for example, position or 
scale of the 3D reconstruction, organs, voxels, surface, or photon density maps).

3. In the 3D tools, click the Animation tab.

4. If necessary, clear the key frame box (click the  button and select Delete All.)

5. To capture the first key frame, click the  button.
- The first key frame is added to the key frame box.

6. To capture the next key frame, adjust the 3D view to show the properties of interest 
and click the  button. 

- The second key frame is added to the key frame box.

7. Repeat Step 6 until all key frames of interest are captured. For details on how to edit 

Table 11.10  Preset animations

Name Choose This Animation Setup to...

Spin CW Rotate the 3D reconstruction clockwise.

Spin CCW Rotate the 3D reconstruction counterclockwise.

Zoom In Magnify the 3D reconstruction.

Fade In Increase opacity from 0-100%.

Fade Out Decrease opacity from 100-0%.
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the key frame sequence, see page 172.

Click a key frame to display the associated 3D view and the time stamp (position 
in the time scale (0-100) at which the frame occurs in the animated sequence).

8. Confirm the defaults for FPS (frames per second) and Total Duration (length of 
animation) or enter new values.

FPS x Total Duration = No. of frames generated to create the animation. The 
number of generated frames should be ≥ to the number of key frames. Otherwise, 
the frames may not be properly animated.

9. To view the animation, click Play. To stop the animation, click Stop.

To save the animation to a movie:

1. Click Record.

2. In the dialog box that appears, choose a directory and enter a file name (.mov, mp4, 
.avi), and click Save.

To save the animation setup:

1. Click Save.

2. In the dialog box that appears, select a directory and enter a file name (.xml).

Editing an Animation 
Setup

Open an animation setup:

1. To select a predefined setup, make a selection from the Preset drop-down list.

or

To select a saved user-defined setup:
a. Click Load. 

b. In the dialog box that appears, select the directory and animation setup (.xml) of 
interest.

To edit the key frame sequence:

1. Add a key frame:
a. Adjust the 3D view to show the properties of 

interest.

b. Click the  button.

2. To reorder a key frame in the sequence, select the key 
frame and click the  or  arrow.

3. Update a key frame:
a. Select the key frame of interest.

b. Adjust the 3D view.

c. Click the  button.
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4. Delete a key frame:
a. Select the key frame that you want to remove.

b. Click the  button and select Delete Current.

To save the animation setup:

1. Click Save.

2. In the dialog box that appears, select a directory and enter a file name (.xml).

11.9 Managing DLIT/FLIT Results

To save results:

1. In the Results tab of the DLIT/FLIT 3D reconstruction tools, confirm the default file 
name or enter a new name.

2. Click Save.
- The results are saved to the sequence click number folder and are available in the 

Name drop-down list.

To open results:

1. In the Results tab, make a selection from the Name drop-down list.

2. Click Load.

To copy user-specified results:

1. In the Results tab, select the results of interest. 

2. Right-click the results table and select Copy Selected from the shortcut menu that 

Figure 11.12  3D analysis results

Default name for the results
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appears. 

To copy all results:

1. In the Results tab, right-click the results table and select Copy All from the 
shortcut menu that appears.
- All of the results table is copied to the system clipboard.

To export results:

1. In the results tab, right-click the results table and select Export Results from the 
shortcut menu that appears.

2. In the dialog box that appears, choose a folder for the results, enter a file name, 
and click Save.
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12 Troubleshooting Guide

12.1 DLIT/FLIT Analysis Troubleshooting

Table 12.1  DLIT/FLIT analysis

Issue Solution

Large voxels (> 2 mm) • The Ndata>Nvoxels is required for an overdetermined problem. It is possible that there are not 
enough data (N Surface). This can occur because it is desired that all wavelengths (DLIT) and all 
trans-illumination source positions (FLIT) are represented in the data equally. In the DLIT case, 
if the signal in a short wavelength is very low, then the sampled data can be too few for sufficient 
refinement of the voxel gridding.
– To increase the data to be included, determine the [photons/sec/cm2/sec] level for ~30 counts 

on the low signal image (this is the level of noise) using Image Adjust in the Tool Palette.   Enter 
in the [photons/sec/cm2/sec] value into the 'Minimum Radiance' column next to the 
wavelength/image number in the 'Analyze Tab' in the DLIT/FLIT 3D Reconstruction menu of 
the Tool Palette.

• It is best to include the low signal data as it adds constraining information to the solution.
Note: Using the Imaging Wizard should reduce the occurrence of low signal images in the data 
sequences.

No sources in solution • In DLIT or FLIT, this can occur if the surface is not correct. That is, if a surface is imported into 
the 3D View from another source other than from the Structured Light Analysis.

• In FLIT, if you choose an emission Source Spectrum in the Properties Tab (an Advanced User 
feature) which is incorrect for the fluorophore of interest, this can also result in no sources.

• In FLIT, if there is very little signal detected at the surface and the 'Background' box is checked 
in the Params tab, then it is possible that only the background fluorescence is simulated.

Surfaces are spiky • The most common source of spiky surfaces are folds in the animal skin or animal fur, which 
corrupt the desired smooth lines projected on the animal from the laser galvanometer.
– Adjusted the 'Path Averaging Size' in the 'Surface Topography' menu in the Tool Palette can 

help reconstruct an improved surface
– Smoothing the surface by using the 'Smooth' feature in the tool palette Surface Topography 

menu can also help improve the surface.
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Appendix A   IVIS Acquisition Control Panel

The control panel provides the image acquisition functions (Figure A.1).

NOTE
The options available in the IVIS acquisition control panel depend on the selected 
imaging mode, the imaging system, and the filter wheel or lens option that are 
installed.

Figure A.1  IVIS acquisition control panel, auto exposure selected

To acquire an image using auto exposure, 
click the  arrow and select Auto.

Luminescence 
imaging settings

Fluorescence 
imaging settings

Photographic 
imaging settings

Structured light 
imaging settings

Table A.1  IVIS acquisition control panel

Item Description

Luminescent Choose this option to acquire a luminescent image.

Fluorescent Choose this option to acquire a fluorescent image.

Exposure time The length of time that the shutter is open during acquisition of a photographic or luminescent image. The 
luminescent or fluorescent signal level is directly proportional to the exposure time. The goal is to adjust the 
exposure time to produce a signal that is well above the noise (>600 counts recommended), but less than 
the CCD camera saturation of ~60,000 counts. 

Luminescent exposure time is measured in seconds or minutes. The minimum calibrated exposure time is 
0.5 seconds. The exposure time for fluorescent images is limited to 60 seconds to prevent saturation of the 
CCD. There is no limit on the maximum exposure time for luminescent images; however, there is little 
benefit to exposure times greater than five minutes.The signal is linear with respect to exposure time over 
the range from 0.5 to 10 minutes. Integration times less than 0.5 seconds are not recommended due to the 
finite time required to open and close the lens shutter. 

Binning Controls the pixel size on the CCD camera. Increasing the binning increases the pixel size and the sensitivity, 
but reduces spatial resolution. Binning a luminescent image can significantly improve the signal-to-noise 
ratio. The loss of spatial resolution at high binning is often acceptable for in vivo images where light emission 
is diffuse. For more details on binning, see Appendix C, page 192.

Recommended binning: 1-4 for imaging of cells or tissue sections, 4-8 for in vivo imaging of subjects, and 
8-16 for in vivo imaging of subjects with very dim sources.
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F/stop Sets the size of the camera lens aperture.The aperture size controls the amount of light detected and the 
depth of field. A larger f/stop number corresponds to a smaller aperture size and results in lower sensitivity 
because less light is collected for the image. However, a smaller aperture usually results in better image 
sharpness and depth of field.

A photographic image is taken with a small aperture (f/8 or f/16) to produce the sharpest image and a 
luminescent image is taken with a large aperture (f/1) to maximize sensitivity. For more details on f/stop, see 
Appendix C, page 191.

Excitation Filter A drop-down list of fluorescence excitation filters. For fluorescent imaging, choose the appropriate filter for 
your application (GFP, DsRed, Cy5.5, or ICG). For bioluminescent imaging, Block is selected by default. If 
you select Open, no filter is present. For systems equipped with spectral imaging capability, choose the 
appropriate emission filter for your application (see Chapter 7, page 107).

Note: The excitation filter selection automatically sets the emission filter position.

Emission Filter A drop-down list of fluorescence emission filters located in front of the CCD lens. The emission filter wheel 
is equipped with filters for fluorescence or spectral imaging applications. The number of filter positions (6 to 
24) depends on the system. For bioluminescent imaging, the Open position (no filter) is automatically 
selected by default.

Photograph Choose this option to automatically acquire a photographic image. The illumination lights at the top of the 
imaging chamber are on during a photographic image so that the system can acquire a black and white 
photograph of the sample(s). 

Note: You can adjust the appearance of the photographic image using the Bright and Gamma controls (see 
Photo Adjustment, page 53).

Structure Choose this option to take a structured light image (an image of parallel laser lines scanned across the 
subject) when you click Acquire. The structured light image is used to reconstruct the surface topography 
of the subject which is an input to the Diffuse Luminescence Imaging Tomography (DLIT™) algorithm that 
computes the 3D location and brightness of luminescent sources. 

When this option is chosen, the f/stop and exposure time are automatically set to defaults for the structured 
light image (f/8 and 0.2 sec, respectively). The spatial resolution of the computed surface depends on the 
line spacing of the structured light lines. The line spacing and binning are automatically set to the optimal 
values determined by the FOV (stage position) and are not user-modifiable.

Overlay If this option is chosen, the system automatically acquires a photographic image followed by a luminescent 
image, then coregisters the two images.

Lights Turns on the lights located at the top of the imaging chamber.

Alignment Grid

Auto If this option is chosen, the software automatically sets the exposure time to produce a good photographic 
image.

Fluor Lamp 
Level

Sets the illumination intensity level of the excitation lamp used in fluorescent imaging (Off, Low, High, and 
Inspect). The Low setting is approximately 18% of the High setting. Inspect turns on the QTH illumination 
lamp so that you can manually inspect the excitation lamp. 

Note: Make sure that the filters of interest are selected in the filter drop-down lists before you select Inspect. 
The Inspect operation automatically positions the selected filters in the system before turning on the lamp. 
Subsequent changes to the filter popup menus will have no effect until another Inspect operation is 
performed.

Field of View Sets the size of the stage area to be imaged by adjusting the position of the stage and lens. The FOV is the 
width of the square area (cm) to be imaged. A smaller FOV gives a higher sensitivity measurement, so it is 
best to set the FOV no larger than necessary to accommodate the subject or area of interest. The FOV also 
affects the depth of field (range in which the subject is in focus). A smaller FOV results in a narrower depth 
of field. Select the FOV by choosing a setting from the drop-down list. For more details on the calibrated 
FOV positions A-E, see Table A.3, page 180. 

Service Click to move the stage to a position for cleaning.

Load Click to move the stage from the cleaning position back to the home position.

Table A.1  IVIS acquisition control panel

Item Description
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XFOV-24 Note: This check box is only available on an IVIS® System that includes the XFO-24 lens option. When the 
XFO-24 lens is installed, choose the XFOV-24 option. For more details on how to install the XFO-24 lens, see 
the XFOV-24 Lens Instructions.

IMPORTANT!
ALERT!  If you remove the XFO-24 lens from the system, be sure to remove the check mark from the XFOV-
24 check box.

Subject height 
(cm) 

Sets the position of the focal plane of the lens/CCD system by adjusting the stage position. The subject 
height is the distance above the stage that you are interested in imaging. For example, to image a mouse 
leg joint, set the subject height to a few mm. To image the uppermost dorsal side of a mouse, set the subject 
height to the 1.5 - 2.0 cm. The default subject height is 1.5 cm.

IMPORTANT!
ALERT!  The IVIS® System has a protection system to prevent instrument damage, however always pay 
close attention to subject height, particularly on the IVIS Imaging System 200 Series. For example, it is 
possible for a large subject (10 cm ventral-dorsal height) to contact the top of the imaging chamber if you 
set the subject height = 0 and choose a small FOV. 

Focus Drop-down list of focusing methods available:

Use subject height - Choose this option to set the focal plane at the specified subject height. 

Manual - Choose this option to open the Focus Image window so that you can manually adjust the stage 
position. For more details on manual focusing, see page 32.

Temperature The temperature box color indicates the temperature and status of the system:

System not initialized.
System initialized, but the CCD temperature is out of range.
System is initialized and the CCD temperature is at or within acceptable range of the demand 
temperature and locked. The system is ready for imaging.

Click the temperature box to display the actual and demand temperature of the CCD and stage. For more 
details, see page 12.

Acquire Click to acquire an image using the settings and options selected in the control panel or to acquire an image 
sequence specified in the Sequential Setup table.

Sequence Setup Click to display the Sequence Editor so that you can access the imaging wizard, specify and manage 
sequence acquisition parameters, or open sequence acquisition parameters (xsq). For more details on 
setting up an image sequence, see page 21.

Image Setup Click to close the Sequence Editor.

Initialize Click to initialize the IVIS Imaging System. For more details on initializing the system, see page 12.

Table A.1  IVIS acquisition control panel

Item Description
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Table A.2  Additional IVIS® System Controls for the IVIS Imaging System 200 Series or IVIS Spectrum

Item Description

Alignment grid Choose this option to activate a laser-generated alignment grid on the stage when the imaging 
chamber door is opened. The alignment grid is set to the size of the selected FOV. The grid 
automatically turns off after two minutes. If subject alignment is not completed in two minutes, 
place a check mark next to Enable Alignment Grid to turn on the grid. 

Note: The horizontal cross hair of the alignment grid is offset appropriately to take into account the 
height entered in the Subject height box.

Focus Scan Mid Image - Choose this option in the Focus drop-down list to set the focal plane at the 
maximum dorso-ventral height of the subject at the middle of the animal. This focusing method uses 
the laser to scan horizontally across the middle of the subject to determine the maximum subject 
height along this line. This option is well suited for animal imaging because the peak height is clearly 
identified as the maximum height on the dorsal side along the mid-plane of the animal.

Note: This focusing method is not recommended for microplates or when using a high 
magnification field of view (FOV A = 4.0 cm). In these situations, Manual or Subject Size focus 
methods are recommended.

Transillumination Setup

(IVIS Spectrum only)

Choose this option to display the transillumination setup window that enables you to select the 
locations for image acquisition using bottom illumination that originates beneath the stage.

Table A.3  Typical field of view (FOV) settings

FOV Setting IVIS Imaging System

Lumina 100 Series 200 Series

FOV (cm)

A 4 10 3.9

B 7 15 6.5

C 10 20 13

D 12 25 19.5

E 26
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You can manage user IDs and specify defaults for some parameters that are associated 
with the user ID selected at the start of a new session. 

1. After you log on, to view the user-modifiable preferences, select Edit 
➞Preferences on the menu bar.
- The Preferences box appears.

NOTE
Any changes made to the Preferences are implemented at the start of the next 
session. The Acquisition tab is only available in the Living Image software that controls 
the IVIS® Imaging System.
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B.1  General Preferences

Figure B.1  General preferences

Table B1  General preferences

Item Description

Start Up Defaults

Dock Tool Palette Sets the position of the tool palette in the application window. 
Choose left or right. 

Note: To undock the tool palette, click on the palette title bar and 
drag it a distance greater than its width.

Window Size Specifies the dimensions of the main application window.

Width, Height Sets the dimensions of the image window.

Restore Defaults Click to apply the default settings.

Apply Individual Color 
Scale for Sequences

Choose this option to apply a separate color scale to each 
thumbnail of a sequence. If this option is not chosen, all of the 
thumbnails are displayed using the same color scale.

Show Transillumination 
Locations

Choose this option to display a cross hair at each transillumination 
location when you load transillumination data. When you mouse 
over a cross hair, a tool tip displays the transillumination 
coordinates. If this option is not chosen, you can choose the 
Transillumination Location option in the sequence view window to 
display the transillumination locations. 

Show Advanced Options If this option is chosen, the tool palette includes the point source 
fitting tools and the image window includes the Colorized View tab.

Show Activity Window on: A drop-down list of options for when to display the activity log 
(Figure B.2).

Save Settings

Color Selections Applies the color settings of the active image data to subsequently 
opened image data.

Folder Locations Sets the default folder path to the current folder path setting. Click 
the Export button  in the image window to view the current 
folder path setting (Figure B.2).
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Some of the general preferences specify how the main application window is organized.

Window Size & 
Position

Applies the active image window size and position settings to 
subsequently opened image data.

Most Recently Used 
Dataset History

Applies the active image window size and position settings to 
subsequently opened image data.

Display ROI Label As 
Measurement

Photons Select the type of measurement (in photons) to show in the ROI 
label.

Counts: Select the type of measurement (in counts) to show in the ROI 
label.

Figure B.2  Main application window
To undock the tool palette, click on the palette title bar and drag it a distance greater than its 
width. To dock the tool palette in the main window, drag the palette to the right or left side of 
the window and release.

Table B1  General preferences

Item Description

Activity window (hidden by default)

Tool palette
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B.2 User Preferences

Figure B.3  User preferences

Table B2  User preferences

Item Description

User’s Settings

Existing User ID The user ID displayed in the log on dialog box at startup.

New User ID Opens the Add New User box. A new user is added to the 
Existing User ID drop-down list.

Delete User ID Deletes the user selected from the Existing User ID drop-down 
list.

Preferences/Defaults

Label Name Drop-down list of factory installed label name sets.

Edit User label 
Choices

Opens a dialog box that enables you to edit a label set.

Default Units Specifies the units (photons or counts) for image display.
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B.3  Acquisition

Figure B.4  Acquisition preferences, Auto Exposure

Table B3  Auto exposure settings

Item Description

Luminescent/Fluorescent Auto 
Exposure Preferences

First Preference
Second Preference
Third Preference

During auto exposure, the software acquires a 
bioluminescence or fluorescence image so that the brightest 
pixel is approximately equal to the user-specified target max 
count. 

If the target max count cannot be closely approximated by 
adjusting the first preference (for example, exposure time), 
the software uses the first and second or first, second and 
third preferences to attempt to reach the target max count 
during image acquisition. 

Target Max Count A user-specified intensity. 

Range Values

Exp Time (sec)
F/Stop
Binning

The minimum and maximum values define the range of 
values for exposure time, F/Stop, or binning that the software 
can use to attempt to reach the target max count during 
image acquisition.
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B.4 Theme

Figure B.5  Theme preferences

Table B4  Theme preferences

Item Description

3D View Background Color

Solid Color Choose this option to apply a non-gradient background color to 
the 3D view in the image window.

Gradient Color Choose this option to apply a gradient background color to the 3D 
view in the image window (Figure B.6). Top = the color at the 
top of the window; Bottom = the color at the bottom of the 
window. 

Preferred Color Palette

Luminescent The color scale that is used to display luminescent images. Click 
Reverse to reverse the color scale.

Fluorescent The color scale that is used to display fluorescent images. Click 
Reverse to reverse the color scale.

Use saved colors while 
loading data

If this option is chosen, data are displayed using a user-specified 
color palette. For example, after you load data, specify a color 
table in the Image Adjust tools, and save the data. The user-
specified color table is automatically applied whenever the data 
are loaded. 

Preferred ROI Line Color

Luminescent Color of the ROI outline on a luminescent image.

Fluorescent Color of the ROI outline on a fluorescent image. 

Click to apply the 
factory set defaults.

Click so select a different color or define a custom color.
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B.5 Tissue Properties

Figure B.6  Image window, 3D view with gradient background

Figure B.7  Set tissue properties preferences (left) for the Properties tab in the Planar Spectral 
Imaging, DLIT, or FLIT tools.

Table B5  Tissue properties preferences

Item Description

Tissue Properties Choose a default tissue type that is most representative of the area 
of interest. 

Source Spectrum Choose the default luminescent source.
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B.6 3D Analysis

Index of Refraction The software automatically sets the internal medium index of 
refraction based on the selection in the Tissue Properties list

Plot

Tissue Properties Choose this option to display a graph of the absorption coefficient 
(μa), effective attenuation coefficient (μeff), and reduced scattering 
coefficient (μ’s or μsp).

Source Spectrum Choose this option to display the source spectrum.

Apply to

DLIT/FLIT Choose this option if the settings are for the Properties tab in the 
FLIT or DLIT tools.

Planar Spectral 
Imaging

Choose this option if the settings are for Properties tab in the Planar 
Spectral Imaging tools.

Table B5  Tissue properties preferences

Item Description

Figure B.8  Set 3D analysis preferences (left) for the DLIT reconstruction tools (right)

Table B6  3D analysis preferences

Item Description

System Select the IVIS Imaging System from the drop-down list.

Angle Limit (deg) The angle between the object surface normal and the optical axis. For 
more details, see page 239.

Kappa Limits Kappa (κ) is a parameter that is searched during a reconstruction to 
determine the best fit to the image data. Small values of kappa tend to 
favor deeper sources, while large values favor more shallow sources. For 
more details, see page 240.
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N Surface Limits The maximum number of surface intensity points to use in the 
reconstruction at a given wavelength. The range is 200 to 800 and the 
default is 200. The time required for reconstruction is shortest for smaller 
values of N (for example, 200). However, a large N value may give a more 
accurate result because more data are included in the fit.

Voxel Size Limits Voxels are the small cubes of space inside a subject, each of which 
contains a light source (much like a pixel in a 2D image). The DLIT 
reconstruction begins with large voxels, specified by the voxel size limit 
(the length of a side of the voxel cube in mm). At each iteration, the 
algorithm reduces the size of the voxel by a factor of two until the 
optimum solution is found.

The voxel size limits are a minimum of five and a maximum of 10. The 
default range is set to 6-9 mm. A larger range of voxel limits ensures a 
more reliable solution, but requires more computational time. The default 
range of 6-9 is usually adequate to determine the optimum solution.

Voxel Size 
Increment

This is the step increment in voxel size, stepping from the minimum voxel 
size limit to the maximum voxel size limit. For example, if the voxel size 
limit ranges from 6-9 mm, a voxel size increment = 1 gives four starting 
voxel sizes (6, 7, 8, and 9 mm).

The default increment of 1 mm is usually adequate, however smaller 
increments can be used if you want to sample finer voxel sizes. Smaller 
increments will significantly increase the time required for 
reconstruction.

Uniform Surface 
Sampling

If this option is chosen, the surface data for each wavelength will be 
sampled spatially uniformly on the signal area. If this option is not chosen, 
the maximum ‘N surface elements’ will be sampled for the data. This 
means that the N brightest surface elements will be used as data in the 
reconstruction. Typically, non-uniform sampling is recommended if there 
is a single bright source, while uniform sampling is preferred if there are 
several scattered sources.

NNLS + Simplex 
Optimization

If this option is not chosen, the software uses a linear programming 
algorithm to seek the solution (Simplex solution). If this option is chosen, 
the software also applies a non-negative least squares optimization 
algorithm at each iteration to provide a better solution for source power. 
The Simplex solution is more robust, but tends to underestimate the 
source flux in each voxel. Therefore, the NNLS + Simplex option is 
recommended.

NNLS Weighted Fit Choose this option to weight the wavelength data proportionally to its 
intensity in the NNLS reconstruction. This option is especially useful if the 
intensity of longer wavelength data is orders of magnitude greater than 
the intensity of shorter wavelength data.

Table B6  3D analysis preferences

Item Description
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Appendix C   Detection Sensitivity
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The parameters that control the number of photons collected (signal) and the image 
background (noise) determine the sensitivity of low light imaging. To maximize 
sensitivity, the goal is to increase signal and decrease background

Several factors affect the number of photons collected, including the lens f/stop, image 
magnification, size and detection efficiency (quantum efficiency) of the CCD, transport 
efficiency of the imaging optics, and the image exposure time. 

C.1 CCD Detection Efficiency

IVIS® Imaging Systems use a back-thinned, back-illuminated CCD cooled to -90°  to -105°  
C (depending on the system). This type of CCD provides high quantum efficiency of over 
80% across the visible and near infrared part of the spectrum.

Figure C.1 shows detection efficiencies for several commonly used photon detectors. The 
back-illuminated CCD has the highest efficiency, particularly in the 600-800 nm region of 
the spectrum, the area of greatest interest for in vivo imaging. 

Lens Aperture IVIS® Imaging Systems are equipped with a high-light-collection f/1 lens. The sensitivity 
of the IVIS Imaging System can be adjusted by changing the f/stop setting that controls the 
lens aperture. The detected signal scales approximately as 1/(f/stop)2. For maximum 
sensitivity, select f/1, the largest aperture setting on the IVIS Imaging System (Figure C.2). 
This provides the greatest light collection efficiency, but results in the minimum depth of 
field for the image. The depth of field refers to the depth over which the image appears to 
be in focus and is determined by the f/stop and the field of view (FOV). 

Figure C.1  Quantum efficiencies
Bialkali photocathode (▲), back-illuminated CCD (◆), and front-illuminated CCD (■). IVIS 
systems use back-illuminated CCDs.
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At f/1, the depth of field ranges from ~0.2 cm at FOV= 3.9 cm (IVIS® Imaging System 
200 Series only) to ~2 cm at FOV= 25 cm. You can use the manual focus option on the 
Control panel to easily assess the depth of field at any f/stop and FOV setting. For more 
details on manual focusing, see page 32. Generally f/1 is recommended for low light 
luminescent images and f/2 or f/4 is recommended for brighter luminescent or fluorescent 
images.

Image Exposure Time The image exposure time also affects sensitivity. The number of photons collected is 
directly proportional to the image exposure time. For example, an image acquired over a 
two minute exposure contains twice as many detected photons as an image acquired over 
a one minute exposure. Longer exposure times are usually beneficial when imaging very 
dim samples. However, this may not always be true because some types of background, 
dark charge in particular, increase with exposure time. (For more details on backgrounds, 
see Appendix E, page 203.) An IVIS® Imaging System has extremely low background 
that enables exposures of up to 30 minutes. However, animal anesthesia issues and 
luciferin kinetics limit practical exposure times for in vivo imaging to 5-10 minutes.

Field of View (FOV) The FOV indirectly affects sensitivity. Changing the FOV without changing the binning 
or the f/stop does not significantly affect sensitivity. However, CCD pixels are effectively 
smaller at a smaller FOV (higher magnification) so that higher levels of binning can be 
applied without loss of spatial resolution. 

For example, an image acquired at binning=4 and FOV=20 cm has the same spatial 
resolution as an image acquired at binning=8 and FOV=10 cm. Due to the increase in 
binning, the latter image has a four-fold increase in sensitivity compared to the former. 

C.2 Binning

A charge coupled device (CCD) is a photosensitive detector constructed in a two-
dimensional array of pixels. After an image is acquired, each pixel contains an electrical 
charge that is proportional to the amount of light that the pixel was exposed to. The 
software measures the electrical charge of each CCD pixel and assigns a numerical value 
(counts). (For more details on counts and other measurement units, see Appendix D, 
page 197.) The resulting image data comprise a two-dimensional array of numbers; each 
pixel contains the counts associated with the amount of light detected. 

Figure C.2  Lens f/stop positions.
Left: lens wide open at f/1; right: lens closed down at f/8.
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The IVIS® Imaging Systems are equipped with a CCD that ranges from 1024× 1024 to 
2048× 2048 pixels in size, and thus have a high degree of spatial resolution. At binning=1, 
each pixel is read and the image size (number of pixels) is equal to the physical number of 
CCD pixels (Figure C.3).

At binning=2, four pixels that comprise a 2× 2 group on the CCD are summed prior to read 
out and the total number of counts for the group is recorded (Figure C.3). This produces a 
smaller image that contains one fourth the pixels compared to an image at binning=1. 
However, due to summing, the average signal in each pixel is four times higher than at 
binning=1. At binning=4, 16 pixels are summed prior to read out.

Binning significantly affects the sensitivity of the IVIS Imaging System. Binning at higher 
levels (for example, ≥ 4) improves the signal-to-noise ratio for read noise, an electronic 
noise introduced into the pixel measurement at readout. If four pixels are summed before 
readout, the average signal in the summed pixel (super pixel) is four times higher than at 
binning=1. 

The read noise for the super pixel is about the same as it was for the individual pixels. 
Therefore, the signal-to-noise ratio for the read noise component of the image noise is 
improved by a factor of four. Read noise is often the dominant source of noise in in vivo 
images, so a high binning level is a very effective way to improve the signal-to-noise ratio.

Unfortunately, binning reduces the spatial resolution in an image. For example, at 
binning=2, a super pixel is twice as wide as a pixel at binning=1. This results in a factor of 
two loss in image spatial resolution. However, for in vivo imaging, the added sensitivity is 
usually more important than the spatial resolution. Further, since in vivo signals are often 
diffuse due to scattering in tissue, little is gained by increasing spatial resolution. (For more 
background on the propagation of light through tissue, see Diffusion Model of Light 
Propagation Through Tissue, page 226.) In such cases, high levels of binning may be 
appropriate (up to 10 or 16, depending on the CCD of the IVIS® Imaging System). If signal 
levels are high enough that sensitivity is not an issue, then it is better to image at a lower 
binning level (two or four) in order to maintain a higher degree of spatial resolution. 

NOTE
For application-specific questions regarding the appropriate binning level, please 
contact Xenogen Corporation.

Figure C.3  A small segment of the CCD.
At binning = 2, 4 pixels are summed together; at binning = 4, 16 pixels are summed.

Binning = 1

Signal 4 times larger.
Spatial size doubled.

CCD pixel

Binning = 2 Binning = 4

Signal 16 times larger.
Spatial size quadrupled.
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The IVIS System Control panel provides several binning options. The actual binning 
numbers associated with these settings depends on the CCD chip and type of image (Table 
C.1). These choices should satisfy most user needs. However, if you want to manually 
control binning, you can specify Manual Binning in the Living Image Tools-Preference-
Camera Settings box.

You can also apply soft binning after an image is acquired. Conceptually, soft binning is 
the same as hardware binning⎯ groups of pixels are summed and a smaller, lower 
resolution image is produced. However, in soft binning the summing is performed 
digitally on the stored image data, not on the electronic charge before readout as in 
hardware binning. 

Although soft binning does not improve the signal-to-noise ratio for read noise, it may 
enhance the signal visibility because it reduces the statistical scatter of nearby pixel 
contents. Usually, hardware binning is preferred, but if it is not possible to take another 
image, applying soft binning to the data may provide a worthwhile solution.

C.3 Smoothing

Smoothing is a filtering method that reduces noise in the image data. To apply smoothing, 
the software replaces the intensity of each pixel with the average intensity of a nearby 
pixel neighborhood that includes the pixel. Figure C.4 shows a 3x3 pixel neighborhood. 

Smoothing does not change the pixel size and helps:

• Eliminate outlier pixel values that are extremely high or low.

• Reduce noise (fluctuations) in the image to help reveal small signals.

Table C.1  Binning settings

Binning Camera

EEV ROPER SITe Andor

Medium Lumin Bin 8 Bin 5 Bin 4 Bin 4

Small (high-resolution) 
Lumin 

Bin 4 Bin 2 Bin 2 Bin 2

Large (high-sensitivity) 
Lumin 

Bin 16 Bin 10 Bin 8 Bin 8

Medium Photo Bin 4 Bin 2 Bin 2 Bin 2

Small (high-resolution) 
Photo 

Bin 2 Bin 1 Bin 1 Bin 1
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Figure C.4  3x3 pixel neighborhood

Center pixel value = the mean value of 
the nine pixels in the 3x3 neighborhood
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Appendix D   Image Data Display & Measurement
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D.1 Image Data

Scientific Image Data Scientific image data is a two-dimensional array of numbers. Each element of the array 
(pixel) is associated with a number that is proportional to the light intensity on the element. 
A charge coupled device (CCD) camera used for scientific imaging is essentially an array 
of photo-sensitive pixels and each pixel collects photons during an image exposure. 

The subsequent electronic readout provides a photon intensity number associated with 
each pixel. In a bright area of the image, more photons are detected and the photon intensity 
number is greater than the number in a dim area of the image.

The image data can be visualized in different ways, including pseudocolor images 
(generated by the Living Image® software), contour plots, or isometric displays.

Graphic Image Data A graphic image is a two-dimensional array of pixels with a color assigned to each pixel. 
There are several schemes for digitally storing the images. For example, a common scheme 
assigns a red-green-blue (RGB) color code to each pixel. The RGB code defines how much 
of each color to apply in order to create the final pixel color. Color photographs or color 
screenshots are examples of RGB images.

An RBG image is also a two-dimensional array of numbers, but unlike a scientific image, 
the numbers are only color codes and are not related to light intensity. A graphic image can 
be exported to a graphic display application.

Pseudocolor Images An image can be generated from scientific image data by assigning a color to each 
numerical value and plotting the array so that each pixel is filled with the color that 
corresponds to its numerical value. A color table defines the relationship between the 
numerical data and the displayed color. For example, a grayscale color table assigns black 
to the smallest number in the array, white to the largest number, and shades of gray to the 
values in between (Figure D.1). The resulting image is equivalent to a black and white 
photograph. An illuminated photographic image acquired on an IVIS® Imaging System is 
an example of a grayscale pseudoimage.

The reverse rainbow color table is also commonly used and assigns violet to the smallest 
number on the array, red to the largest number, and all of the spectral colors of the rainbow 
to the values in between (Figure D.1).
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A pseudocolor scheme is typically used to display the numerical contents of scientific 
image data like the luminescent or fluorescent images acquired on an IVIS® Imaging 
System. The pseudocolor scheme makes it easy to see areas of bright light emission. The 
amount of light emission can be quantified using measurement ROIs. (For more details, 
Measurement ROIs, page 74.)

Measurement data is independent of the colors displayed in the pseudocolor image. You 
can change the appearance of the image data without affecting the underlying numeric 
pixel values. For example, you apply a different color table to the data or adjust the range 
of numeric values associated with the color table. Measurements that quantify pixel data 
produce the same results independent of the appearance of the pseudocolor display. 

A pseudocolor image can be converted to an RGB color code and saved as an RGB image. 
The RGB image looks like a pseudocolor image, but does not include the numerical 
information derived from the light detected in each pixel. Therefore, the amount of light 
in an RGB image cannot be quantified.

Overlays In the overlay display mode, the pseudocolor luminescent or fluorescent image is 
displayed on the associated grayscale photographic image (Figure D.1). Pixels in the 
luminescent or fluorescent image that are less than the minimum color table setting are not 
displayed. As a result, the lowest intensity color in the table is transparent and this enables 
you to view the underlying photographic image in regions where the luminescent light 
emission is low.

Figure D.1  Example pseudoimages

A photographic image is a gray scale pseudoimage. In Overlay display mode, a pseudocolor image of the 
luminescent data is overlaid on a photographic image.

Color table associated with the data.
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D.2  Quantifying Image Data

The Living Image software can quantify and display scientific image data using three types 
of measurements (Figure D.1):

• Counts

• Photons

• Efficiency (for fluorescent images only)

Counts When image data is displayed in counts, the image pixel contents are displayed as the 
numerical output of the charge digitizer on the charge coupled device (CCD) (Figure D.2). 
The counts measurement (also known as analog digitizer units (ADU) or relative 
luminescence units (RLU)) is proportional to the number of photons detected in a pixel. 

Counts are uncalibrated units that represent the raw amplitude of the signal detected by the 
CCD camera. A signal measured in counts is related to the photons incident on the CCD 
camera. The signal varies, depending on the camera settings (for example, integration time, 
binning, f/stop, or field of view setting).

All IVIS® Imaging Systems include a CCD digitizer that is a 16-bit device, which means 
that the signal count range is from zero to 65,535. Sometimes the displayed signal count 
may appear outside of this range due to corrections applied to the image data (for example, 
background corrections).

Data 
Display

Choose This to Display: Recommended For:

Counts An uncalibrated measurement of the 
photons incident on the CCD camera.

Image acquisition to ensure that the 
camera settings are property adjusted.

Photons A calibrated measurement of the photon 
emission from the subject.

ROI measurements on bioluminescent 
images.

Efficiency A fluorescence emission image 
normalized to the incident excitation 
intensity (radiance of the subject/
illumination intensity).

ROI measurements on fluorescent 
images.

Figure D.2  Image window and ROI Measurements table (counts mode)

Select Counts, Photons, or 
Efficiency for the image data 

In counts mode, the ROI measurements 
include:
Total Counts = Sum of all counts for all 
pixels inside the ROI

Average Counts = Total Counts/Number of 
pixels or superpixels 

Quantity ROI Pixels = Number of binned 
pixels inside the ROI

Area (CCD pixels) = Number of unbinned 
CCD pixels inside the ROI
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Photons When image data is displayed in photons, the photon emission from the subject or 
radiance is displayed in photons/sec/cm2/sr. Counts are a relative measure of the photons 
incident on the CCD camera and photons are absolute physical units that measure the 
photon emission from the subject.

The radiance unit of photons/sec/cm2/sr is the number of photons per second that leave a 
square centimeter of tissue and radiate into a solid angle of one steradian (sr) (Figure D.3).

A steradian can be thought of as a three-dimensional cone of light emitted from the surface 
that has a unit solid angle. Much like a radian is a unit of arc length for a circle, a steradian 
is a unit of solid angle for a sphere. An entire sphere has 4π steradians. Lens systems 
typically collect light from only a small fraction of the total 4π steradians.

When image data is displayed in photons mode, the units change to photons/sec/cm2/sr. 
These are units of photon radiance on the surface of the animal. A very important 
distinction between these absolute physical units and the relative units of counts is that the 
radiance units refer to photon emission from the subject animal itself, as opposed to counts 
that refers to photons incident on the detector. 

Measurements in units of radiance automatically take into account camera settings (for 
example, integration time, binning, f/stop, and field of view). As a result, images of the 
same subject acquired during the same session have the same signal amplitude regardless 
of the camera settings because the radiance on the animal surface does not change. The 
advantage of working with image data in photons mode is that camera settings can be 
changed during an experiment without having to adjust the images or the measured ROI 
data. Images or ROI data can be quantitatively compared across different IVIS® Imaging 
Systems.

Xenogen Corporation calibrates the camera settings of each IVIS Imaging System at 600 
nm. The response of the CCD is relatively flat (~10%) over the range from 500-700 nm 
which includes the spectral variation found in bacterial or firefly luciferase. Therefore, 
calibration is accurate over this range. 

Figure D.3  Isotropic radiation 
Isotropic radiation from a cell is called photon flux (photons/sec). When cells occur in tissue, 
photon emission from the tissue surface is called surface radiance (photons/sec/cm2/sr).



201

Living Image® Software User’s Manual

Efficiency The fluorescent signal detected from a sample depends on the amount of fluorophore 
present in the sample and the intensity of the incident excitation light. The excitation light 
incident on the sample stage is not uniform over the field of view (FOV). At FOV=10, there 
is a slightly dished illumination profile due to the close proximity of the stage to the 
illumination reflectors, while the profiles for the other stage locations are peaked near their 
center. The illumination intensity profile varies by up to ±30% across the entire FOV 
(Figure D.4). 

Displaying fluorescent image data in terms of efficiency eliminates the variable excitation 
light from the measurement and enables a more quantitative comparison of fluorescent 
signals. When you select efficiency for the image data (Figure D.2), the software normalizes 
the fluorescent emission image to a reference image and computes:

Efficiency = Radiance of the subject/Illumination intensity

Prior to instrument delivery, Xenogen Corporation generates a reference image of the 
excitation light intensity (no emission filter) incident on a highly reflective white plate for 
each excitation filter at every FOV and lamp power. The data are stored in the Living 
Image folder.

Image efficiency data does not have units. The efficiency number for each pixel represents 
the fraction of fluorescent photons relative to each incident excitation photon and is 
typically in the range of 10-2 to 10-9. When ROI measurements are made, the total efficiency 
within the ROI is the efficiency per pixel integrated over the ROI area, so the resulting units 
of total efficiency is area or cm2.

Figure D.4  Illumination profiles at different FOVs 
Measurements were taken at the center of the FOV on the IVIS Imaging System 100 Series.
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D.3  Flat Fielding

Flat fielding refers to the uniformity of light collected across the field of view (FOV). A 
lens usually collects more light from the center of the FOV than at the edges. The Living 
Image® 3.0 software provides a correction algorithm to compensate for the variation in the 
collection efficiency of the lens. This enables uniform quantitation of ROI measurements 
across the entire FOV.

To apply the correction algorithm, choose the Flat Field Correction option in the 
Corrections/Filtering tools. The algorithm multiplies each pixel by a predetermined scale 
factor. The scale factor for each pixel depends on its distance from the center of the image. 
The scale factor near the center of the field of view is one, but can be up to two or three 
near the corners on the IVIS® Imaging System 100 Series. (The IVIS Imaging System 200 
Series has a larger lens with a smaller flat field correction.) 

You may notice an increase in noise near the edges and corners of the FOV when flat field 
correction is applied– this is normal.

D.4 Cosmic Ray Corrections

Cosmic rays are extraterrestrial high-energy particles that register a false signal on a CCD 
detector. Cosmic rays as well as other sources of ionizing radiation cause infrequent 
interactions (a few per minute) on the CCD. These interactions result in large signals that 
are usually isolated to a single pixel, making them easy to correct.

The Living Image® 3.0 software searches for isolated, high amplitude hot pixels and 
replaces them with a collective average of surrounding pixels. The Cosmic Correction 
option should always be selected for in vivo image data because hot pixels can 
significantly affect an ROI measurement. 

Cosmic ray correction is not recommended when imaging very small objects such as 
individual cells. An individual cell may only light up one or two pixels and can sometimes 
be misinterpreted as a cosmic ray. In this case, clear the Cosmic Correction option in the 
Corrections/Filtering tools to avoid filtering out single-cell images. 
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The background sources of light from bioluminescent images are inherently very low. This 
appendix discusses sources of background and how to manage them. Due to the extreme 
sensitivity of the IVIS® Imaging System, residual electronic background (dark current) and 
luminescent emission from live animals (autoluminescence) are measurable and must be 
taken into account.

For information on fluorescent background, see Appendix F, page 215.

E.1 Electronic Background

The cooled CCD camera used in an IVIS Imaging System has electronic background that 
must be accurately measured and subtracted from the image data before the light intensity 
is quantified. Raw data that is not corrected for electronic background results in erroneous 
ROI measurements. Incorrect background subtraction may also result in serious errors. 
However, it is not necessary to subtract the electronic background when making a simple 
visual inspection of an image.

The types of electronic background include:

• Read bias - An electronic offset that exists on every pixel. This means that the zero 
photon level in the readout is not actually zero, but is typically a few hundred 
counts per pixel. The read bias offset is reproducible within errors defined by the 
read noise, another quantity that must be determined for quantitative image 
analysis.

• Dark current - Electronic background generated by the thermal production of 
charge in the CCD. To minimize dark current, the CCD is cooled during use. 

Read Bias & Drift Prior to a luminescent image exposure, the Living Image® software initiates a series of 
zero-time exposures (image readout) to determine a read bias measurement. 

If a dark charge background is available for the luminescent image, the average bias offset 
for the read bias image stored with the dark charge measurement is compared to the 
average bias offset determined with the read bias measurement made prior to the image. 
The difference, or drift correction, is stored with the luminescent image data, and is later 
used to correct minor drift (typically less than two counts/pixel) that may occur in the bias 
offset since measuring the dark charge background.

If a dark charge background is not available at the time of the luminescent image exposure, 
the software checks to see if the selected image parameters warrant a dark charge 
measurement (large binning and long exposure time). If a dark charge image is not 
required, the read bias will be used. If a dark charge is recommended, the software provides 
the option of using the read bias measurement instead. Since the read bias is by far the 
largest component of background, using a read bias measurement instead of a dark charge 
measurement is often acceptable. If read bias is used instead of a dark charge background, 
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the read bias image is stored with the image data rather than the usual background 
information.

If the amount of dark charge associated with an image is negligible, read bias subtraction 
is an adequate substitute for dark charge background subtraction. Dark charge increases 
with exposure time and is more significant at higher levels of binning. A good rule of 
thumb is that dark charge is negligible if:

τ B2 < 1000

where τ  is the exposure time (seconds) and B is the binning factor. 

Under these conditions, dark charge contributes less than 0.1 counts/pixel and may be 
ignored.

Dark Charge Dark charge refers to all types of electronic background, including dark current and read 
bias. Dark charge is a function of the exposure time, binning level, and camera 
temperature. A dark charge measurement should be taken within 48 hours of image 
acquisition and the system should remain stable between dark charge measurement and 
image acquisition. If the power to the system or camera controller (a component of some 
IVIS Systems) has been cycled or if the camera temperature has changed, a new dark 
charge measurement should be taken.

The dark charge is measured with the camera shutter closed and is usually performed 
automatically overnight by the Living Image® software. The software acquires a series of 
zero-time exposures to determine the bias offset and read noise, followed by three dark 
exposures. The dark charge measurement usually takes more than three times as long to 
complete as the equivalent luminescent exposure.

E.2 Background Light On the Sample

An underlying assumption for in vivo imaging is that all of the light detected during a 
luminescent image exposure is emitted by the sample. This is not accurate if there is an 
external light source illuminating the sample. Any reflected light will be detected and is 
indistinguishable from emission from the sample.

The best way to deal with external light is to physically eliminate it. There are two 
potential sources of external light: a light leak through a crack or other mechanical 
imperfection in the imaging chamber or a source of external illumination. 

IVIS® Imaging Systems are designed to be extremely light tight and are thoroughly 
checked for light leaks before and after installation. Light leaks are unlikely unless 
mechanical damage has occurred. To ensure that there are no light leaks in the imaging 
chamber, conduct an imaging test using the Xenogen High Reflectance Hemisphere 
(Figure E.1). 

A more subtle source of external illumination is the possible presence of light emitting 
materials inside the imaging chamber. In addition to obvious sources such as the light 
emitting diodes (LEDs) of electronic equipment, some materials contain phosphorescent 
compounds.
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NOTE
Do not place equipment that contains LEDs in the imaging chamber.

Phosphorescence is a physical process similar to fluorescence, but the light emission 
persists for a longer period. Phosphorescent materials absorb light from an external source 
(for example, room lights) and then re-emit it. Some phosphorescent materials may re-emit 
light for many hours. If this type of material is introduced into the imaging chamber, it 
produces background light even after the chamber door is closed. If the light emitted from 
the phosphorescent material illuminates the sample from outside of the field of view during 
imaging, it may be extremely difficult to distinguish from the light emitted by the sample.

IVIS® Imaging Systems are designed to eliminate background interference from these 
types of materials. Each system is put through a rigorous quality control process to ensure 
that background levels are acceptably low. However, if you introduce such materials 
inadvertently, problems may arise. 

Problematic materials include plastics, paints, organic compounds, plastic tape, and plastic 
containers. Contaminants such as animal urine can be phosphorescent. To help maintain a 
clean imaging chamber, place animal subjects on black paper (for example, Artagain black 
paper, Strathmore cat. no. 445-109) and change the paper frequently. Cleaning the imaging 
chamber frequently is also helpful. 

IMPORTANT!
ALERT!  Use only Xenogen approved cleaning agents. Many cleaning compounds 
phosphoresce! Contact Xenogen technical support for a list of tested and approved 
cleaning compounds.

If it is necessary to introduce suspect materials into the imaging chamber, screen the 
materials by imaging them. Acquire an image of the material alone using the same settings 
(for example, FOV and exposure time) that will be used to image the sample to determine 
if the material is visible in the luminescent image.

Microplates (white, black, or clear plastic) can be screened this way. Screen all three types 
with a test image. White plates appear extremely bright by IVIS® Imaging System 
standards and interfere with measurements. Black or clear plastic microplates do not 
phosphoresce, making them better choices.

The Xenogen High Reflectance Hemisphere provides a more definitive way to determine 
the presence of an undesirable light source (Figure E.1). It is a small white hemisphere that 
is coated with a non-phosphorescent material. A long exposure image of the hemisphere 
should produce a luminescent image in which the hemisphere is not visible. 
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If any part of the hemisphere exhibits what appears to be luminescent emission, it is 
actually the light reflected from a source illuminating the hemisphere. Observe the side of 
the hemisphere that is illuminated to help determine the source location.

In Figure E.1 the pen appears very bright due to phosphorescent emission that is also 
illuminating the portion of the hemisphere next to the pen. If the pen had been outside the 
field of view, it would not have been imaged, and the source of the phosphorescence 
would be less obvious. However, the illumination of the hemisphere would still be very 
apparent and indicative of a light pollution problem.

IMPORTANT!
ALERT!  Handle the Xenogen High Reflectance Hemisphere by its black base plate 
while wearing cotton gloves provided by Xenogen. Skin oils can phosphoresce and 
will contaminate the hemisphere. Latex gloves and the powder on them may also 
phosphoresce. If the hemisphere becomes contaminated, contact Xenogen technical 
support for a replacement. There are no known agents that can clean the 
hemisphere. To check the hemisphere for contamination, take several images of the 
hemisphere, rotating it slightly between images. A glowing fingerprint, for example, 
will rotate with the hemisphere, while a glowing spot due to external illumination most 
likely will not.

E.3 Background Light From the Sample

Another source of background is the natural light emitted from a sample that is not due to 
emission from the source of interest in the sample. This type of background may be due 
to a material associated with the experimental setup. For example, the cell culture medium 
may phosphoresce. Materials should be screened so you can identify and eliminate 
problematic materials. If a background source is phosphorescent and the phosphorescent 
lifetime is relatively short, you can try keeping the sample in the dark for a long period 
before imaging to reduce background light emission.

Occasionally there is no way to eliminate the natural light emission of the sample. The 
natural light emission associated with living animals (autoluminescence) is a major area 
of interest in in vivo bioluminescent imaging. Most animals exhibit a low level of 
autoluminescence. Usually this is only a problem when looking for very low signals at the 
highest levels of sensitivity.

Figure E.1  Xenogen High Reflectance Hemisphere and a plastic marker pen
Left: Photographic image. Right: Photograph with luminescent overlay. The hemisphere is 
illuminated by phosphorescence emitted from the pen.



207

Living Image® Software User’s Manual

Xenogen Corporation has conducted tests to try to minimize the source of the background 
light emission in mice.

The sources of autoluminescence are not yet fully understood. No external sources have 
been proven to cause natural light emissions, so it is possible that a chemiluminescent 
process associated with metabolic activity in living animals is the source of animal 
background. This is supported by the observation that the level of background light drops 
significantly in euthanized animals.

In Figure E.2 the background light emission is clearly visible in the images of a control 
white-furred mouse and a nude mouse. The images are five minute, high-sensitivity (high 
binning) exposures. The average emission from a white-furred mouse and a nude mouse is 
approximately 1600 photons/s/cm2/sr and 1000 photons/s/cm2/sr, respectively. Since these 
values are well above the lower limit of detection of the IVIS® Imaging System (~100 
photons/s/cm2/sr), the background light emission from the mouse determines the limit of 
detection. 

An approximation of this background (determined by making similar measurements on 
either control animals or regions of the subject animal that do not contain the primary 
signal) can be subtracted from ROI measurements. (For more information on ROI 
measurements, see Chapter 5, page 69.) 

Note that the background light emission is not uniform over the entire animal. In Figure E.2 
images of control animals (mice) show a somewhat higher background component 
originating from the abdominal and thoracic regions. Therefore, care must be taken when 
selecting a representative background area.

Test Description Observation

Test 1: Subject animals were 
housed in the dark 12 hours prior 
to imaging.

Background emission levels were not reduced. A 
phosphorescent component in mouse fur or skin is not the 
source of light emission.

Test 2: White-furred animals 
were shaved prior to imaging

No increase or decrease in background emission levels.

Test 3: Alfalfa (known to be 
phosphorescent) was eliminated 
from the animal diet.

An alfalfa-free diet reduced background emission slightly, but 
not significantly.
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Usually only very low signals at the highest level of sensitivity require this type of 
background subtraction. For more information on how best to handle these types of 
measurements, please contact Xenogen technical support. 

Figure E.2  Background light emission
Background light emission from a female white furred (Swiss Webster) (left) and a female 
nude (Nu/nu) mouse (right). 

Photograph Luminescent 
overlay

Photograph Luminesce
nt overlay
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F.1 Description and Theory of Operation

System Components The IVIS® Imaging System 200 Series and IVIS Lumina offer built-in fluorescence 
imaging capability as standard equipment. The IVIS Imaging System 100 and 50 Series 
use the XFO-6 or XFO-12 Fluorescence Option to perform fluorescence imaging. The 
fluorescence equipment enables you to conveniently change between bioluminescent and 
fluorescent imaging applications (Figure F.1). For more details, see the IVIS Imaging 
System 200 Series System Manual, the IVIS Lumina System Manual, or the XFO-6 or XFO-
12 Fluorescence Option Manual.

 

A 150-watt quartz tungsten halogen (QTH) lamp with a dichroic reflector provides light 
for fluorescence excitation. The relative spectral radiance output of the lamp/reflector 

Figure F.1  Fluorescent imaging hardware

IVIS Lumina, 
IVIS Imaging System 50 or 100 SeriesIVIS Imaging System 200 Series
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combination provides high emission throughout the 400-950 nm wavelength range 
(Figure F.2). The dichroic reflector reduces infrared coupling (>700 nm) to prevent 
overheating of the fiber-optic bundles, but allows sufficient infrared light throughput to 
enable imaging at these wavelengths. The Living Image software controls the illumination 
intensity level (off, low, or high). The illumination intensity at the low setting is 
approximately 18% that of the high setting. 

The lamp output is delivered to the excitation filter wheel assembly located at the back of 
the IVIS® Imaging System (Figure F.3). Light from the input fiber-optic bundle passes 
through a collimating lens followed by a 25 mm diameter excitation filter. The IVIS 
Imaging System provides a 12-position excitation filter wheel, allowing you to select from 
up to 11 fluorescent filters (five filters on older systems). A light block is provided in one 
filter slot for use during bioluminescent imaging to prevent external light from entering 
the imaging chamber. The Living Image software manages the motor control of the 
excitation filter wheel.

Following the excitation filter, a second lens focuses light into a 0.25 inch fused silica 
fiber-optic bundle inside the imaging chamber. Fused silica fibers (core and clad), unlike 
ordinary glass fibers, prevent the generation of autofluorescence.

The fused silica fiber bundle splits into four separate bundles that deliver filtered light to 
four reflectors in the ceiling of the imaging chamber (Figure F.1). The reflectors provide a 

Figure F.2  Relative spectral radiance output for the quartz halogen lamp with dichroic reflector.

Figure F.3  Excitation filter wheel cross section.
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diffuse and relatively uniform illumination of the sample stage. Analyzing image data in 
terms of efficiency corrects for nonuniformity in the illumination profile. When the 
efficiency mode is selected, the measured fluorescent image is normalized to a reference 
illumination image. (For more details on efficiency, see page 201.)

The emission filter wheel at the top of the imaging chamber collects the fluorescent 
emission from the target fluorophore and focuses it into the CCD camera. All IVIS® 
Imaging Systems require that one filter position on each wheel always be open for 
bioluminescent imaging.

F.2 Filter Spectra

High quality filters are essential for obtaining good signal-to-background levels (contrast) 
in fluorescence measurements, particularly in highly sensitive instruments such as the 
IVIS® Imaging Systems. Figure F.4 shows typical excitation and emission fluorophore 
spectra, along with idealized excitation and emission filter transmission curves. The 
excitation and emission filters are called bandpass filters. Ideally, bandpass filters transmit 
all of the wavelengths within the bandpass region and block (absorb or reflect) all 
wavelengths outside the bandpass region. This spectral band is like a window, 
characterized by its central wavelength and its width at 50% peak transmission, or full 
width half maximum. Figure F.5 shows filter transmission curves of a more realistic nature.

Because the filters are not ideal, some leakage (undesirable light not blocked by the filter 
but detected by the camera) may occur outside the bandpass region. The materials used in 
filter construction may also cause the filters to autofluoresce. 

IVIS Imaging System Number of Emission Filter 
Wheel Positions

Number of Available 
Fluorescence Filters

200 Series 24 (two levels, each with 12 
positions)

22 (60 mm diameter)

Lumina 8 7

100 or 50 6 5 (75 mm diameter)
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In Figure F.5, the vertical axis is optical density, defined as OD = -log(T), where T is the 
transmission. An OD=0 indicates 100% transmission and OD=7 indicates a reduction of 
the transmission to 10-7. 

For the high quality interference filters in the IVIS® Imaging Systems, transmission in the 
bandpass region is about 0.7 (OD=0.15) and blocking outside of the bandpass region is 
typically in the OD=7 to OD=9 range. The band gap is defined as the gap between the 50% 
transmission points of the excitation and emission filters and is usually 25-50 nm.

There is a slope in the transition region from bandpass to blocking (Figure F.5). A steep 
slope is required to avoid overlap between the two filters. Typically, the slope is steeper 
at shorter wavelengths (400-500 nm), allowing the use of narrow band gaps of 25 nm. The 
slope is less steep at infrared wavelengths (800 nm), so a wider gap of up to 50 nm is 
necessary to avoid cross talk.

Fluorescent Filters and 
Imaging Wavelengths

Eight excitation and four emission filters come standard with a fluorescence-equipped 
IVIS Imaging System (Table F.1). Custom filter sets are also available. Fluorescent 

Figure F.4  Typical excitation and emission spectra for a fluorescent compound.
The graph shows two idealized bandpass filters that are appropriate for this fluorescent 
compound.

Figure F.5  Typical attenuation curves for excitation and emission filters.
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imaging on the IVIS Imaging System uses a wavelength range from 400-950 nm, enabling 
a wide range of fluorescent dyes and proteins for fluorescent applications. 

For in vivo applications, it is important to note that wavelengths greater than 600 nm are 
preferred. At wavelengths less than 600 nm, animal tissue absorbs significant amounts of 
light. This limits the depth to which light can penetrate. For example, fluorophores located 
deeper than a few millimeters are not excited. The autofluorescent signal of tissue also 
increases at wavelengths less than 600 nm. 

F.3 Working with Fluorescent Samples

There are a number of issues to consider when working with fluorescent samples, 
including the position of the subject on the stage, leakage and autofluorescence, 
background signals, and appropriate signal levels and f/stop settings. 

Tissue Optics Effects In in vivo fluorescence imaging, the excitation light must be delivered to the fluorophore 
inside the animal for the fluorescent process to begin. Once the excitation light is absorbed 
by the fluorophore, the fluorescence is emitted. However, due to the optical characteristics 
of tissue, the excitation light is scattered and absorbed before it reaches the fluorophore as 
well as after it leaves the fluorophore and is detected at the animal surface (Figure F.6). 

The excitation light also causes the tissue to autofluoresce. The amount of autofluorescence 
depends on the intensity and wavelength of the excitation source and the type of tissue. 
Autofluorescence can occur throughout the animal, but is strongest at the surface where the 
excitation light is strongest. 

Table F.1  Standard filter sets and fluorescent dyes and proteins used with IVIS Imaging Systems. 

Name Excitation Passband (nm) Emission Passband (nm) Dyes & Passband

GFP 445-490 515-575 GFP, EGFP, FITC

DsRed 500-550 575-650 DsRed2-1, PKH26, CellTracker™ Orange

Cy5.5 615-665 695-770 Cy5.5, Alexa Fluor® 660, Alexa Fluor® 680

ICG 710-760 810-875 Indocyanine green (ICG)

GFP Background 410-440 Uses same as GFP GFP, EGFP, FITC

DsRed Background 460-490 Uses same as DsRed DsRed2-1, PKH26, CellTracker™ Orange

Cy5.5 Background 580-610 Uses same as Cy5.5 Cy5.5, Alexa Fluor® 660, Alexa Fluor® 680

ICG Background 665-695 Uses same as ICG Indocyanine green (ICG)
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At 600-900 nm, light transmission through tissue is highest and the generation of 
autofluorescence is lower. Therefore it is important to select fluorophores that are active 
in the 600-900 nm range. Fluorophores such as GFP that are active in the 450-600 nm 
range will still work, but the depth of detection may be limited to within several 
millimeters of the surface.

Specifying Signal 
Levels and f/stop 
Settings

Fluorescent signals are usually brighter than bioluminescent signals, so imaging times are 
shorter, typically from one to 30 seconds. The bright signal enables a lower binning level 
that produces better spatial resolution. Further, the f/stop can often be set to higher values; 
f/2 or f/4 is recommended for fluorescence imaging. A higher f/stop improves the depth 
of field, yielding a sharper image. For more details on the f/stop, see Lens Aperture, 
page 191.

F.4 Image Data Display

Fluorescent image data can be displayed in units of counts or photons (absolute, 
calibrated), or in terms of efficiency (calibrated, normalized). For more details, see 
Quantifying Image Data, page 199. 

If the image is displayed in photons, you can compare images with different exposure 
times, f/stop setting, or binning level. When an image is displayed in terms of efficiency, 
the fluorescent image is normalized against a stored reference image of the excitation light 
intensity. Efficiency image data is without units and represents the ratio of emitted light 
to incident light. For more details on efficiency, see page 201.

Fluorescent Efficiency The detected fluorescent signal depends on the amount of fluorophore present in the 
sample and the intensity of the incident excitation light. At the sample stage, the incident 
excitation light is not uniform over the FOV. It peaks at the center of the FOV and drops 
of slowly toward the edges (Figure F.7). To eliminate the excitation light as a variable from 
the measurement, the data can be displayed in terms of efficiency (Figure F.8). 

Figure F.6  Illustration of the in vivo fluorescence process.
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When efficiency is selected, the fluorescent image data is normalized (divided) by a 
stored, calibrated reference image of the excitation light intensity incident on a highly 
reflective white plate. The resulting image data is without units, typically in the range of 
10-2 to 10-9.

NOTE
On every IVIS® Imaging System, a reference image of the excitation light intensity is 
measured for each excitation filter at every FOV and lamp power. The reference 
images are measured and stored in the Living Image folder prior to instrument 
delivery.

F.5 Fluorescent Background

Autofluorescence Autofluorescence is a fluorescent signal that originates from substances other than the 
fluorophore of interest and is a source of background. Almost every substance emits some 

Figure F.7  Illumination profiles for different FOVs on an IVIS Imaging System 100 Series 
measured from the center of the FOV.

Figure F.8  Fluorescent image data displayed in terms of efficiency

To enable a more 
quantitative 
comparison of 
fluorescent signals, 
choose Efficiency.
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level of autofluorescence. Autofluorescence may be generated by the system optics, 
plastic materials such as microplates, and by animal tissue. Filter leakage, which may also 
occur, is another source of background light.

The optical components of the IVIS® Imaging Systems are carefully chosen to minimize 
autofluorescence. Pure fused silica is used for all transmissive optics and fiber optics to 
reduce autofluorescence. However, trace background emissions exist and set a lower limit 
for fluorescence detection. 

To distinguish real signals from background emission, it is important to recognize the 
different types of autofluorescence. The following examples illustrate sources of 
autofluorescence, including microplates, other materials, and animal tissue.

Microplate Autofluorescence

When imaging cultured cells marked with a fluorophore, be aware that there is 
autofluorescence from the microplate as well as native autofluorescence of the cell.

Figure F.9 shows autofluorescence originating from four different plastic microplates. The 
images were taken using a GFP filter set (excitation 445-490nm, emission 515-575nm).

Two types of autofluorescent effects may occur:

Overall glow of the material - Usually indicates the presence of autofluorescence.

Hot spots - Indicates a specular reflection of the illumination source (Figure F.10). 
The specular reflection is an optical illumination autofluorescence signal reflecting 
from the microplate surface and is not dependent on the microplate material.

Figure F.9  Examples of microplate autofluorescence emission
The black polystyrene plate emits the smallest signal while the white polystyrene plate emits 
the largest signal. (Imaging parameters: GFP filter set, Fluorescence level Low, Binning=8, 
FOV=15, f/1, Exp=4sec.)

White polystyrene Clear polypropylene

Clear polystyrene Black polystyrene
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Black polystyrene microplates are recommended for in vitro fluorescent measurements. 
Figure F.9 and Figure F.10 show that the black polystyrene microplate emits the smallest 
inherent fluorescent signal, while the white polystyrene microplate emits the largest signal. 
The clear polystyrene microplate has an autofluorescent signal that is slightly higher than 
that of the black microplate, but it is still low enough that this type of microplate may be 
used. 

Control cells are always recommended in any experiment to assess the autofluorescence of 
the native cell.

Miscellaneous Material Autofluorescence

It is recommended that you place a black Lexan® sheet (Xenogen part no. 60104) on the 
imaging stage to prevent illumination reflections and to help keep the stage clean. 

NOTE
The black paper recommended for bioluminescent imaging (Swathmore, Artagain, 
Black, 9"x12", Xenogen part no. 445-109) has a measurable autofluorescent signal, 
particularly with the Cy5.5 filter set.

Figure F.11 shows a fluorescent image of a sheet of black Lexan on the sample stage, as 
seen through a GFP filter set. The image includes optical autofluorescence, light leakage, 
and low level autofluorescence from inside the IVIS® System imaging chamber. The ring-
like structure is a typical background autofluorescence/leakage pattern. The image 
represents the minimum background level that a fluorophore signal of interest must exceed 
in order to be detected.

Figure F.10  Specular reflection.
The four symmetric hot spots on this black polystyrene well plate illustrate the specular 
reflection of the illumination source. (Imaging parameters: GFP filter set, Fluorescence level 
Low, Binning=8, FOV=15, f/1, Exp=4sec.)
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Other laboratory accessories may exhibit non-negligible autofluorescence. The chart in 
Figure F.12 compares the autofluorescence of miscellaneous laboratory materials to that 
of black Lexan. For example, the autofluorescence of the agar plate with ampicillin is 
more than 180 times that of black Lexan. Such a significant difference in autofluorescence 
levels further supports the recommended use of black polystyrene well plates. 

NOTE
It is recommended that you take control measurements to characterize all materials 
used in the IVIS® Imaging System.

Figure F.11  Light from black Lexan 
This image shows the typical ring-like structure of light from a sheet of black Lexan, a low 
autofluorescent material that may be placed on the imaging stage to prevent illumination 
reflections. (Imaging parameters: GFP filter set, Fluorescence level High, Binning=16, 
FOV=18.6, f/2, Exp=5sec.)

Figure F.12  Comparison of autofluorescence of various laboratory materials to that of black 
Lexan
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Despite the presence of various background sources, the signal from most fluorophores 
exceeds background emissions. Figure F.13 shows the fluorescent signal from a 96-well 
microplate fluorescent reference standard (TR 613 Red) obtained from Precision 
Dynamics Co. Because the fluorescent signal is significantly bright, the background 
autofluorescent sources are not apparent.

Animal Tissue Autofluorescence

Animal tissue autofluorescence is generally much higher than any other background source 
discussed so far and is likely to be the most limiting factor in in vivo fluorescent imaging. 
Figure F.14 shows ventral images of animal tissue autofluorescence for the GFP, DsRed, 
Cy5.5, and ICG filter set in animals fed regular rodent food and alfalfa-free rodent food 
(Harlan Teklad, TD97184). Animals fed the regular rodent diet and imaged using the GFP 
and DsRed filter sets, show uniform autofluorescence, while images taken with the Cy5.5 
and ICG filter sets show the autofluorescence is concentrated in the intestinal area. 

The chlorophyll in the regular rodent food causes the autofluorescence in the intestinal 
area. When the animal diet is changed to the alfalfa-free rodent food, the autofluorescence 
in the intestinal area is reduced to the levels comparable to the rest of the body. In this 
situation, the best way to minimize autofluorescence is to change the animal diet to alfalfa-
free rodent food when working with the Cy5.5 and ICG filter sets. Control animals should 
always be used to assess background autofluorescence.

Figure F.13  96 well plate fluorescent reference standard (TR 613 Red)
The fluorescent signal is strong enough to exceed background emissions. (Imaging 
parameters: DsRed filter set, Fluorescence level Low, Binning=8, FOV=15, f/1, Exp=4sec.) 
Reference standard TR 613 Red is available through Precision Dynamics Co, http://
www.pdcorp.com/healthcare/frs.html.
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Figure F.15 shows a comparison of fluorescence and bioluminescence emission in vivo. In 
this example, 3× 106 PC3M-luc/DsRed prostate tumor cells were injected subcutaneously 
into the lower back region of the animal. The cell line is stably transfected with the firefly 
luciferase gene and the DsRed2-1 protein, enabling bioluminescent and fluorescent 
expression. The fluorescence signal level is 110 times brighter than the bioluminescence 
signal. However, the autofluorescent tissue emission is five orders of magnitude higher. 
In this example, fluorescent imaging requires at least 3.8× 105 cells to obtain a signal above 
tissue autofluorescence while bioluminescent imaging requires only 400 cells.

NOTE
When you make ROI measurements on fluorescent images, it is important to subtract 
the autofluorescence background. For more details, see Subtracting Tissue 
Autofluorescence, page 101.

Figure F.14  Images of animal tissue autofluorescence in control mice (Nu/nu females)
Animals were fed regular rodent food (top) or alfalfa-free rodent food (bottom). Images were 
taken using the GFP, DsRed, Cy5.5, or ICG filter set. The data is plotted in efficiency on the 
same log scale.

Figure F.15  Fluorescent (left) and bioluminescent (right) images of stably transfected, dual-
tagged PC3M-luc DsRed cells. 
The images show the signal from a subcutaneous injection of 3x106 cells in an 11-week old 
male Nu/nu mouse.
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F.6 Subtracting Instrument Fluorescent Background

The fluorescence instrumentation on an IVIS® Imaging System is carefully designed to 
minimize autofluorescence and background caused by instrumentation. However a 
residual background may be detected by the highly sensitive CCD camera. 
Autofluorescence of the system optics or the experimental setup, or residual light leakage 
through the filters can contribute to autofluorescence background. The Living Image 
software can measure and subtract the background from a fluorescence image.

Fluorescent background subtraction is similar to the dark charge bias subtraction that is 
implemented in luminescent mode. However, fluorescent background changes day-to-day, 
depending on the experimental setup. Therefore, fluorescent background is not measured 
during the night, like dark charge background is.

After you acquire a fluorescent image, inspect the signal to determine if a fluorescent 
background should be subtracted (Figure F.16). If background subtraction is needed, 
remove the fluorescent subject from the imaging chamber and measure the fluorescent 
background (select Acquisition → Fluorescent Background → Measure Fluorescent 
Background on the menu bar). In the Living Image® software, the Sub Fluor Bkg check 
box appears on the Control panel after a background has been acquired. You can toggle the 
background subtraction on and off using this check box.

NOTE
The fluorescence background also contains the read bias and dark charge. Dark 
charge subtraction is disabled if the Sub Fluor Bkg check box is checked.

F.7 Adaptive Background Subtraction

Adaptive background subtraction is a simple way to reduce the "instrument fluorescent 
background" by fitting and removing the background using the existing image (for 
example, the left image in Figure F.16). 

Figure F.16  Comparison of dark charge bias subtraction (left) and fluorescent background subtraction (right). 
The autofluorescence from the nose cone and filter leakage have been minimized in the image on the right by using Sub 
Fluor Bkg option.
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Unlike the method described in section F.6, Subtracting Instrument Fluorescent 
Background, where you acquire an actual instrument fluorescent background image by 
removing the fluorescent subject from the imaging chamber to correct the background, the 
new method uses software correction. To perform adaptive background subtraction:

• Identify the fluorescent subject in the original image using the photo mask

• The software automatically fits the instrument background to the whole image 
using the pixels outside of the subject

• The software subtracts the fitted instrument background from the original image

In most situations, such adaptive software correction works as effectively as the traditional 
method except the following cases:

• The subject is dark, making it is difficult to mask the subject using the photo (for 
example, experiments that use black well plates)

• The subject occupies most of the FOV (for example, high magnification or 
multiple mice in the FOV). As a result, there is not enough information outside the 
subject that can be used to help fit the background.
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6.8  Subtracting Tissue Autofluorescence Using Background Filters

High levels of tissue autofluorescence can limit the sensitivity of detection of exogenous 
fluorophores, particularly in the visible wavelength range from 400 to 700 nm. Even in the 
near infrared range, there is still a low level of autofluorescence. Therefore, it is desirable 
to be able to subtract the tissue autofluorescence from a fluorescent measurement. 

The IVIS® Imaging Systems implement a subtraction method based on the use of blue-
shifted background filters that emit light at a shorter wavelength (see Table 6.2, page 101). 
The objective of the background filters is to excite the tissue autofluorescence without 
exciting the fluorophore. The background filter image is subtracted from the primary 
excitation filter image using the Image Math tool and the appropriate scale factor, thus 
reducing the autofluorescence signal in the primary image data. (For more details, see 
Chapter 6, page 101.) The assumption here is that the tissue excitation spectrum is much 
broader than the excitation spectrum of the fluorophore of interest and that the spatial 
distribution of autofluorescence does not vary much with small shifts in the excitation 
wavelength.

Figure F.17 shows an example of this technique using a fluorescent marker. In this 
example, 1× 106 HeLa-luc/PKH26 cells were subcutaneously implanted into the left flank 
of a 6-8 week old female Nu/nu mouse. Figure F.18 shows the spectrum for HeLa-luc/
PKH26 cells and the autofluorescent excitation spectrum of mouse tissue. It also shows 
the passbands for the background filter (DsRed Bkg), the primary excitation filter 
(DsRed), and the emission filter (DsRed). Figure F.17 shows the IVIS® images using the 
primary excitation filter, the background excitation filer, as well as the autofluorescent-
corrected image. 

The corrected image was obtained using a background scale factor of 1.4, determined by 
taking the ratio of the autofluorescent signals on the scruff of the animal. The numbers 
shown in the figures are the peak radiance of the animal background within the region of 
interest. In the corrected image, the RMS error is used to quantify the background. The 
signal-to-background ratio of the original fluorescent image (DsRed filter) is 6.5. The 
ratio increases to 150 in the corrected image, an improvement factor of 23. This 
improvement reduces the minimum number of cells necessary for detection from 1.5× 105 
to 6.7× 103. 
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Figure F.17  Example of the autofluorescent subtraction technique using a background 
excitation filter.
a) primary excitation filter (DsRed), b) blue-shifted background excitation filter (DsRed Bkg), 
and c) corrected data. The corrected image was obtained by subtracting the scaled 
background filter image (multiplied by 0.47) from the primary filter image. The 6-week old 
female Nu/nu mouse was injected subcutaneously with 1× 106 HeLa-luc/PKH26 cells in the 
left flank.

Figure F.18  Spectral data describing the autofluorescent subtraction technique using a 
background filter.
The graph shows the excitation and emission spectrum of PKH26 and the autofluorescent 
excitation spectrum of mouse tissue. Also included are the spectral passbands for the blue-
shifted background filter (DsRed Bkg), the primary excitation filter (DsRed), and the emission 
filter used with this dye.
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The unique spectral signatures of the luciferase emission spectrum and the optical 
properties of tissue enable the Living Image software to determine the depth and intensity 
of light sources inside a living animal. The planar spectral imaging algorithm relies on a 
diffusion model of light propagation in tissue and assumes a point source of light 
embedded in a flat surface approximation of the mouse. The algorithm is designed to 
provide a fast and robust method to approximate source location and brightness. The 
analysis requires two or more single-view images at wavelengths between 560 and 660 nm.

The Diffuse Tomography (DLIT™) algorithm is a more complete and accurate model. It 
analyzes images of surface light emission to produce a three-dimensional (3D) 
reconstruction of the bioluminescent light sources in a subject. For more details on DLIT 
analysis, see Chapter 11, page 137 and Appendix H, page 233.

G.1 Planar Spectral Imaging Theory

An image acquired on an IVIS® Imaging System is a diffuse projection on the surface of 
the animal from the bioluminescent sources located deeper inside. Information about the 
depth of the bioluminescent cells can help quantify the source brightness and provide 
information on the location of the cells. 

The Living Image software uses spectroscopic information from a single-view image to 
estimate the depth of the bioluminescent cells. The method takes advantage of the fact that 
firefly luciferase bioluminescence is emitted from 500 to 700 nm, a region of the spectrum 
where there are major contrasts in tissue optical properties (Figure G.1).

In this portion of the spectrum, tissue absorption drops off dramatically between 500-580 
nm (green/yellow wavelengths) and 600-750 nm (red wavelengths), due mainly to the 
presence hemoglobin. As a result, the bioluminescent signal observed on the surface of the 
animal is dependent on both the wavelength and the thickness of the tissue through which 
it travels. 

The depth and absolute photon flux of a single point source can be determined from two or 
more images acquired at different wavelengths using relatively simple analytical 
expressions derived from the diffusion model of the propagation of light through tissue.
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Diffusion Model of 
Light Propagation 
Through Tissue

Light propagating through tissue undergoes scattering and absorption. The diffusion 
model assumes that scattering is the predominant phenomenon and the reduced scattering 
coefficient µ's >> absorption coefficient µa. This is valid mostly for wavelengths in the red 
and near infrared part of the spectrum. The model also assumes that the light is produced 
by a single point source and that the tissues are optically homogeneous. 

Under these conditions, if we model the animal surface as flat and infinite in extent and 
integrate the light that is collected over the animal surface, the total integrated intensity 
I(λ) is reduced to a relatively simple expression:

I(λ) = SK(λ) exp(-μeff d) (1)

where S is the absolute total photon flux emitted by the bioluminescent source and d is the 
source depth. 

The term µeff is the effective attenuation coefficient. It is determined by the tissue 
coefficient of absorption (µa) and reduced scattering (µ's) that quantify the two main 
phenomena light undergoes in tissue. 

The function K(λ) is a more complex expression that is derived from the model and 
includes terms that describe the effect of the tissue-air boundary on the light propagation. 
Both µeff and the function K are dependent on the wavelength, λ. 

Equation 1 shows that if the total integrated intensity (ROI measurement) is measured at 
several wavelengths, it is proportional to an exponential function of the product of the 
depth and the optical property, µeff. Therefore, the steps to planar spectral image analysis 
include:

• Acquire two or more images at different wavelengths.

• Measure the total integrated intensity on each image.

• Fit the measured values to the exponential function of Equation 1. 

Figure G.1  Optical Properties of Mouse Tissue and Firefly Luciferase Spectra
The bioluminescent signal from firefly luciferase (right) is emitted from wavelengths of 500-700 nm, which spans a region of 
the spectrum where there are major contrasts in the optical properties of mouse tissue (left). The firefly spectrum was 
measured at 37°C using PC3M cells.
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The results of the fit are the total flux of the bioluminescence source S and the source depth 
d.

G.2 Optical Properties

Planar spectral image analysis requires prior knowledge of the tissue optical properties at 
the wavelength used at image acquisition. The two main optical parameters are the:

• Absorption coefficient (µa) that defines the inverse of the mean path before photons 
are absorbed by the tissue.

• Reduced scattering coefficient (µ's) that defines the inverse of the mean path before 
photons are scattered isotropically in the tissue. 

The effective attenuation coefficient (µeff) is a function of the absorption and reduced 
scattering coefficients:

µeff = (3µa (µ's + µa))1/2 (2)

Calculation of the function K in Equation 1 requires all three coefficients (µa, µ's, and µeff) 
as input. The function K includes a term called the effective reflection coefficient to account 
for the reflection of light at the air-tissue boundary due to a mismatch in the index of 
refraction. The tissue index of refraction is generally assumed to be close to 1.4.

The model assumes that the tissues are optically homogeneous and the Living Image 
software provides several factory set tissue optical property values to choose from.

G.3 Luciferase Spectrum

Analyzing spectrally filtered images requires knowledge of the spectral dependence of 
bioluminescent light emission. The luciferase bioluminescence spectrum was measured in 
vitro at 37° C and pH≈ 7 in various cell lines. This spectrum is used to normalize the photon 
flux values that the software measures at each wavelength. 

Source spectra for several reporters are included in the database, including firefly, click 
beetle, renilla, and bacteria (Figure G.1).

NOTE
The firefly luciferase spectrum is temperature and pH dependent. The luciferase 
spectra included in the software are only valid for measurements performed at 37° C 
and pH 7.0-7.5. If you use other temperature or pH conditions for an experiment, the 
associated luciferase spectral curve is required for planar spectral image analysis. For 
more information on the pH and temperature dependence of the luciferase spectrum, 
please contact Xenogen Corporation.

G.4 An Example of Planar Spectral Imaging

Melanoma cells were injected intravenously into the tail vein of nude mice. After 13 days, 
metastases developed in the lungs, kidney, and hind limb bone. An image sequence was 
acquired on the IVIS® Imaging System 200 Series using filters at six wavelengths from 560 
to 660 nm, in 20 nm intervals. 



G. Planar Spectral Imaging

228  

NOTE
When using the 560 nm and 580 nm band pass filters, tissue optics result in a larger 
attenuation of light (due mainly to hemoglobin absorption). A longer exposure time is 
recommended at these wavelengths.

Figure G.2 shows the metastasis sites. The signals from the lungs and right kidney are well 
defined in both animals. However, in the lower back area of the left mouse, the signals are 
in close proximity, causing an artifact in the planar spectral analysis.

To perform the planar spectral analysis, draw a measurement ROI that captures the entire 
signal of each site of interest without including a neighboring metastasis (Figure G.3).

After the ROI is defined, start the planar spectral analysis (for more details, see page 107). 
The software:

• Measures the total flux inside the ROI on each filtered image. 

• Normalizes the data to the luciferase spectrum (Plot of Intensity vs. Lambda, 
Figure G.4).

• Fits the normalized data to the analytical expression in Equation 1, page 226 
where S = absolute total photon flux emitted by the bioluminescence source and d 
= source depth (Plot of Linear Fit Results, Figure G.4)

Figure G.2  Metastatic sites in nude mice.
Mice were imaged 13 days after a tail vein injection of 5x105 B16F10 melanoma cells. 
Imaging parameters: high sensitivity binning, f/stop=1, FOV = C (13 cm), exposure time = 
120 seconds at 560 and 580 nm, exposure time = 60 seconds at all other wavelengths. This 
resulted in signals of ~2000 counts on each image.
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Figure G.3  Metastatic site 
ROI includes the signal of the right kidney and separates it from other metastatic sites. The 
signal coming from the lower back area is spread out due to the presence of two bright spots. 
The dimmer signal in the lower bottom right of the image likely originates from the femoral 
bone of the animal.

Figure G.4  Planar spectral analysis results

After the analysis is completed, 
click a button to display graphical 
results.
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To estimate the cell count, divide the absolute photon flux by the flux per cell. This is best 
determined by making independent in vitro measurements of the cell line used in the 
experiment.

The Plot of Linear Fit Results is weighted by the uncertainty of the measured images and 
takes into account the uncertainty in the determination of the optical properties. The 
precision of the method is largely determined by the known precision of the optical 
properties. In most cases, the relative uncertainty in the depth determination is equal to the 
relative uncertainty in the optical properties. 

An analysis of the dorsal and ventral views of the mouse left lung in Figure G.5 results in 
total flux values that are very similar. The measured depth values are also close, indicating 
that the cells are distributed about the same distance from the front and back of the animal. 

Figure G.5  Planar spectral analysis results
Top: Dorsal view of the left lung, bottom: ventral view of the left lung
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G.5  Optimizing the Precision of Planar Spectral Analysis

The accuracy of the planar spectral analysis is highly dependent on the quality of the:

• Measured data for the firefly luciferase spectrum and the tissue optical properties.

• Fit of the experimentally measured total flux at each wavelength to μeff (effective 
attentuation coefficient).

In general, more experimental values produce a better fit of the data. It is particularly 
important to be able to extract signals at all wavelengths to optimize the quality of the fit. 
If the software detects no signal above the animal background level at 560 nm and 580 nm 
(the wavelengths that absorb the most light), the dynamic range of the optical properties is 
reduced and with it, the precision of the fit.

If a bioluminescent signal is dim or buried deep in the tissue, it may barely exceed the tissue 
autoluminescence at the shorter, more absorbing wavelengths (560 and 580 nm). In this 
case, it is recommended that you subtract the tissue autoluminescence from the image data. 
(For more details on subtracting tissue autoluminescence, see Appendix E, page 206). It is 
also recommended that you inspect all images in the sequence to confirm that the 
bioluminescent signal is greater than the tissue autoluminescence. If the bioluminescent 
signal does not exceed the tissue autoluminescence at a particular wavelength, do not 
include that wavelength in the analysis.



G. Planar Spectral Imaging

232  

[This page intentionally blank.]



233

Living Image® Software User’s Manual

Appendix H   3D Reconstruction of Light Sources
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Diffuse Tomography (DLIT) is a technique that analyzes images of the surface light 
emission from a living subject to generate a three-dimensional (3D) reconstruction of 
bioluminescent light source distribution inside the subject. 

Fluorescent Tomography (FLIT) analyzes images of surface light emission to generate 
a 3D reconstruction of fluorescent light source distribution inside the subject.

NOTE
To generate a 3D reconstruction of bioluminescent sources, the Living Image software 
requires a photographic image, a structured light image, and bioluminescent images 
obtained at two or more wavelength filters from 560-660 nm. To generate a 3D 
reconstruction of fluorescent sources, the software requires a structured light and 
fluorescent images obtained using the same excitation and emission filters at different 
transillumination source positions on the IVIS Spectrum.

To localize and quantify the light sources in a subject, the software:

• Reconstructs the subject surface topography (mesh) from structured light images. 
The mesh is defined by a set of connected polygons or surface elements.

• Maps the surface radiance (photons/s/cm2/steradian) to the photon density 
(photons/mm3) just beneath the surface of each element of the mesh. 

• Divides the interior of the subject into a solid mesh of volume elements or voxels. 
Each voxel is considered to contain a point light source at its center that contributes 
to the photon density at each surface element.

• Defines equations that relate the source strength of each voxel to the photon density 
at each surface element.

• Determines the optimum approximate solution to the system of linear equations to 
reconstruct the source strength in each voxel.

H.1 Determining Surface Topography

The software determines the surface topography or mesh from a structured light image. 
Parallel laser lines are projected onto the subject to produce a structured light image 
(Figure H.1). 

NOTE
If the Structure option is chosen in the Control panel, a structured light image is 
automatically acquired.

The surface topography of the subject is determined by analyzing the displacement (Δx) 
or bending of the laser lines as they pass over the subject. The displacement is defined 
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as the difference between where the line should fall on the stage in the absence of the 
subject and where it appears in the image due to occlusion by the subject.

The parallel lines are projected onto the surface of the subject at an angle (θ) . The angle 
is known by instrument calibrations of the distance between the structured light 
projector and the optical axis (D) and the distance between the stage and the structured 
light projector (l) (Figure H.2). 

D and l form two perpendicular sides of a triangle giving:

tan θ = D/l

Together Δx and h comprise a smaller version of this triangle. The height (h) can be 
determined from:

h = Δx/tan θ

by measuring the displacement Δx.

The software utilizes fast numerical methods to rapidly evaluate Δx over the entire 
image to determine the surface topography. The surface topography determination is 
limited to the topside of the object facing the lens.

Figure H.1  Parallel laser lines projected onto a subject.
Given knowledge of the angle θ, the height of the subject (h) can be determined by analyzing 
the displacement,  Δx, of the laser lines as they pass over the object.

Figure H.2  Structured light projector and subject.
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Converting Light 
Emission to a Photon 
Density Map

The input data to the FLIT algorithm for 3D reconstruction of fluorescent light sources 
includes: 

• A surface mesh that defines the surface of the subject.

• A sequence of images acquired at different transillumination source positions using 
the same excitation and emission filter at each position.

The input data to the DLIT algorithm for a 3D reconstruction of bioluminescent light 
sources includes:

• A surface mesh that defines the surface of the subject.

• A sequence of two or more images of the light emission from the surface of the 
subject acquired at different filter bandwidths (Table A.1)

The IVIS® Imaging System 200 Series and the IVIS Spectrum are absolutely calibrated 
so that the electron counts on each CCD pixel can be mapped back to the surface of the 
object to produce an absolute value of the surface radiance (photon/s/cm2/steradian) 
from each imaged surface element (Figure H.3).

The imaging system collects the light emitted from the surface element at an angle (θe) 
(measured with respect to the normal to the surface element) into the solid angle dΩ 
subtended by the entrance pupil. The value of the surface radiance L(θe) is directly 
related to the photon density ρ (photons/mm3) just inside the surface of the element. 

Defining the Linear 
Relationship Between 
a Source and Photon 
Density

The software divides the interior of the subject into a solid mesh of volume elements 
(voxels). Each voxel is considered to contain a point light source at its center. The index 
i enumerates the set of voxels. Si is the value of the strength (or flux in photons/sec) of 
the point source inside the ith voxel. The solid mesh defines a collection of point sources 
that approximate the actual source distribution. The accuracy of the approximation is 
improved by increasing the density of the solid mesh.

Table A.1  IVIS System filters for bioluminescence & fluorescence tomography

IVIS® Imaging System Filters Bandwidth (nm)

200 Series 6 emission filters, 550-670 nm 20

Spectrum 10 excitation filters, 415-760 nm

18 emission filters, 490-850 nm

20

Figure H.3  Light emission from a surface element passes through the lens entrance pupil and is 
recorded in the image.
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The reconstruction method is based on the principle that there is an approximately 
linear relationship between the source strength in each voxel (Si) and the photon density 
(ρj) at each surface element described by a Green’s function Gij. The photon density at 
the jth surface element is the sum of the contributions from all the voxels:

(1)

The Green's function contains information about the transport of photons through the 
tissue and the effects of the tissue-air boundary. By using a planar boundary 
approximation, the Green's function can be calculated analytically as a solution to the 
diffusion equation. Having an analytic expression for G allows Equation 1 to be 
computed very rapidly.

Finding the Best 
Approximate Solution 
to the Linear System

Once the Green's functions, Gij, are known, the goal is to solve Equation 1 for the 
source strength Si in each voxel. The DLIT algorithm attempts to minimize χ2 (Equation 
2) while requiring that the source strength in each voxel is positive (Equation 3).

(2)

(3)

A combination of methods called Simplex and Non-Negative Least Squares are used to 
find the approximate solution which minimizes χ2. In order to reduce the number of 
variables in the problem, the code only uses surface elements with signal above a 
certain threshold (minimum radiance) and only keeps the voxels that contribute 
significantly to these surface elements.

ρ j GijSi
i
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j
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Source & Tissue 
Properties

DLIT analysis of spectrally filtered images requires knowledge of the spectral 
dependence of bioluminescent light emission. Table H.1 shows the factory set source 
spectra provided by the software. 

NOTE
The source spectra is not an input to the 3D reconstruction of fluorescent sources.

NOTE
The firefly luciferase spectrum is dependent on temperature and pH. The data 
provided are valid only for measurements performed at 37° C and at pH 7.0-7.5. 
Selecting other temperature and pH conditions for a specific experiment requires the 
use of the associated spectral curve for the spectral analysis. For more information 
about pH and temperature dependence of the luciferase spectrum, please contact 
Caliper Life Sciences technical support.

Figure H.4  DLIT 3D reconstruction tools, Properties tab

Table H.1  Source spectra 

Source Spectrum Description

Bacteria Bacterial luciferase

CB Green Click beetle green luciferase

CB Red Click beetle red luciferase

Firefly Firefly luciferase

XPM-2-LED LED in the XPM-2 mouse phantom.

hRenilla Sea pansy (Renilla reniformis) luciferase

Select a tissue or organ from the 
drop-down list. The associated 
internal medium index of 
refraction is automatically 
entered.

Select a 
bioluminescent 
source spectrum.

Choose the Source Spectrum 
from the Plot drop-down list to 
display the selected spectrum.
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You can view tissue optical property values (μeff) in the Tissue Properties drop-down 
list. The tissue properties are plotted as a function of wavelength. Select the tissue or 
organ most representative of the source location. Muscle is a good choice for general 
reconstructions in vivo.

NOTE
Default tissue optical properties and source spectrum are specified in the 
Preferences box. For more details, see Appendix B, page 187.

H.2 Algorithm Parameters & Options

This section explains the user-modifiable DLIT algorithm parameters and options.

Analyze Tab

Wavelengths

For FLIT reconstruction of fluorescent sources, you must specify the transillumination 
source positions. It is recommended that you acquire images at a minimum of four 
source positions. (All images are acquired using the same excitation and emission 
filters.)

For DLIT reconstruction of luminescent sources, you must specify the acquisition 
wavelengths for the image sequence. It is generally recommended that you acquire 
image data using two to four wavelengths rather than a single wavelength so that more 
information is available for the analysis.

Ideally, chose wavelengths or source positions where the signal is well above zero (not 
buried in the CCD noise) and the optical property of the medium (μeff) exhibits a large 
change. The larger the difference in μeff, the higher the quality of information that the 

Figure H.5  3D reconstruction tools, Analyze tab, DLIT (left) and FLIT (right)

Active sequence 

If DLIT analysis 
results are 
open, the 3D 
tools are 
available. 

Select the 
acquisition 
wavelengths 
for the DLIT 
analysis. 

Tissue and 
source are 
specified in the 
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wavelength data adds to the analysis. The recommended wavelengths are 580-640 nm for 
tissue and 560-620 nm for the Xenogen XPM-2 tissue phantom.

Minimum Radiance

The minimum radiance determines the lower radiance [photons/sec/cm2/sr] threshold of 
the data to be used in the DLIT/FLIT analysis.

The software automatically computes a default minimum radiance value and this is the 
recommended starting point for an analysis. If too much noise is included in the 
analysis, increase the minimum radiance value. 

An optimum minimum radiance value can be evaluated by viewing the image data in 
photon units (photons/sec/cm2/sr) and adjusting the color bar Min to be above the level 
of noise in the image.

Parameters Tab

Angle Limit

The angle limit refers to the angle between the object surface normal and the optical 
axis. The optical axis can be considered to be a line perpendicular to the stage. The 
surface normal is a line perpendicular to a plane tangent to the surface point. For 
example, in a dorsal view of a mouse, the highest point on its back would have a normal 
line perpendicular to the stage. In this case the angle is zero. The side of a mouse 
abdomen would have a normal line parallel to the stage, so the angle here would be close 
to 90° .

The software uses luminescent image data for surface elements that are less than the 
angle limit. The default angle limit setting is 70°  for the IVIS® Imaging System 200 

Figure H.6  3D reconstruction tools, Parameters tab, DLIT (left) and FLIT (right)
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Series or the IVIS Spectrum. For IVIS Spectrum or 200 Series data, if there is 
significant signal on the side of the subject, a larger angle of 70-85°  can be used.

Kappa Limits (DLIT)

Kappa (κ) is a parameter that is searched during a reconstruction to determine the best 
fit to the image data. Small values of kappa tend to favor deeper sources, while large 
values favor more shallow sources.

The limits on kappa are minimum of 0.1 and a maximum of 10. The default range for 
kappa is 0.5-4. Kappa is doubled at each iteration, so for a selected range of 0.5-4, the 
kappa values for each iteration would be 0.5, 1, 2. and 4. Choosing a large range for 
kappa produces the most reliable solution, but requires more analysis time.

N Surface (FLIT)

The number of surface intensity points to use in the reconstruction at a given source 
position. 

N Surface Limits (DLIT)

This is the maximum number of surface intensity points to use in the reconstruction at 
a given wavelength. The range is 200 to 800 and the default is 200. The time required 
for reconstruction is shortest for smaller values of N (for example, 200). However, a 
large N value may give a more accurate result because more data are included in the fit.

Starting Voxel Size (FLIT)

Voxels are the small cubes of space inside a subject, each of which contains a quantity 
of fluorescent yield. The FLIT reconstruction begins with large voxels, specified by the 
starting voxel size (the length of a voxel cube side in mm). At each iteration, the 
algorithm reduces the size of the voxels by a factor of 2 until the optimum solution is 
determined.

Starting Voxel Size Limits (DLIT)

Voxels are the small cubes of space inside a subject, each of which contains a light 
source (much like a pixel in a 2D image). The DLIT reconstruction begins with large 
voxels, specified by the voxel size limit (the length of a side of the voxel cube in mm). 
At each iteration, the algorithm reduces the size of the voxel by a factor of two until the 
optimum solution is found.

The voxel size limits are a minimum of five and a maximum of 10. The default range 
is set to 6-9 mm. A larger range of voxel limits ensures a more reliable solution, but 
requires more computational time.

Voxel Size Increment (DLIT)

This is the step increment in voxel size, stepping from the minimum voxel size limit to 
the maximum voxel size limit. For example, if the voxel size limit ranges from 6-9 mm, 
a voxel size increment = 1 gives four starting voxel sizes (6, 7, 8, and 9 mm).

The default increment of 1 mm is usually adequate, however smaller increments can be 
used if you want to sample finer voxel sizes. Smaller increments will significantly 
increase the time required for reconstruction.
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Background (FLIT)

Choose this option to take the background fluorescence (for example, autofluorescence 
or non-specific probe in circulation) into account. Background fluorescence and 
fluorophore emission contribute to the photon density signal at the surface. The 
background fluorescence signal is modelled in order to isolate the signal due to the 
fluorophore only, where an average homogenous tissue background fluorescence yield 
is determined empirically.

Background fluorescence contribution to the photon density at the surface is forward-
modelled. Simulated photon density data due to background at the surface is subtracted 
from the measured photon density so that the subsequent photon density used in the fit 
consists only of signal that is associated with the fluorophore.

The background option specifies whether or not the background fluorescence should be 
fit. This is not necessary for the XFM-2, long wavelength data. It is important when 
there is non-specific dye in circulation or a lot of autofluorescence. 

Uniform Surface Sampling

If this option is chosen, the surface data for each wavelength will be sampled spatially 
uniformly on the signal area. If this option is not chosen, the maximum ‘N surface 
elements’ will be sampled for the data. This means that the N brightest surface elements 
will be used as data in the reconstruction. Typically, non-uniform sampling is 
recommended if there is a single bright source, while uniform sampling is preferred if 
there are several scattered sources.

NNLS Optimization + Simplex Optimization (DLIT)

If NNLS Optimization + Simplex option is chosen, the software uses a linear 
programming algorithm to seed the solution, followed by the NNLS optimization.

NNLS Weighted Fit

Choose this option to weight the data in the NNLS optimization.
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Appendix I   Menu Commands, Tool Bar, & Shortcuts

Figure I.1  Living Image toolbar

Table I.1  Menu bar commands and toolbar buttons

Menu Bar Command Toolbar 
Button

Description

File ➞ Open Displays the Open box so that you can select and open an image data file.

File ➞ Browse Displays the Browse For Folder box so that you can select and an image data 
folder. The selected folder is displayed in the Living Image browser.

File ➞ Browse Biotrue Opens the Biotrue® CDMS Browser. Note: The browser is only available if the 
system includes the Biotrue CDMS option.

File ➞ Save Saves (overwrites) the active image data.

File ➞ Save As Displays the Browse For Folder box so that you can specify a folder in which to 
save the image data. The original data is not overwritten.

File ➞ Import ➞Organ Atlas Opens a dialog box that enables you to import an organ atlas (.atlas).

File ➞ Import ➞ DICOM Opens a dialog box that enables you to import .dcm image data that can be 
viewed in the Living Image software.

File ➞ Import ➞ 3D Mesh Opens a dialog box that enables you to import a mesh (.xmh). Note: This 
command is only available if an appropriate sequence is active (DLIT or planar 
spectral imaging sequence).

File ➞ Import ➞ 3D Volume Opens a dialog box that enables you to import a source volume (voxels, .xsc). 
Note: This command is only available if an appropriate sequence is active (DLIT 
or planar spectral imaging sequence).

File ➞ Export DICOM Opens the Browse for Folder dialog box that enables you to export the active 
image data to DICOM format (.dcm).

File ➞ Export ➞ 3D Mesh Opens a dialog box that enables you to save the 3D mesh of the active data in 
Open Inventor format (.iv).

File ➞ Export ➞ 3D Volume Opens a dialog box that enables you to save the voxels from the active data in 
Open Inventor format (.iv). 

File ➞ Print Displays the Print box.

File ➞ Print Preview Displays the Print Preview box that shows what will be printed.

File ➞ Recent Files Shows recently opened data sets. Note: The number of files displayed can be 
set in the Preferences box (select Edit ➞Preferences and click the Customize 
tab).

File➞ Exit Closes the Living Image software.
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Edit ➞ Copy Copies the active image window to the system clipboard.

Edit ➞ Image Labels Opens the Edit Image Labels dialog box that enables you to edit the label set 
information for the active data.

Edit ➞ Preferences Opens the Preferences box.

View ➞ Tool Bar Choose this option to display the toolbar.

View ➞ Status Bar Choose this option to display the status bar at the bottom of the main window.

View ➞ Activity Window Displays the Activity window at the bottom of the main application window. The 
Activity window shows a log of the system activity.

View ➞ Tool Palette Choose this option to display the tool palette.

View ➞ Activity Window Choose this option to display the activity bar at the bottom of the main window. 
The activity bar lists a history of the recent software activities.

View ➞ Image Information Displays the Image Information box that shows the label set and image 
acquisition information for the active data.

View ➞ ROI Properties Displays the ROI Properties dialog box.

View ➞ ROI Measurements Displays the ROI Measurements table.

View ➞ Image Layout Window Opens the Image Layout window that enables you to paste an image of the 
active data in the window. 

View ➞ Acquisition Control 
Panel

Displays the control panel.

Tools ➞ Image Math for... Opens the Image Math window for the active data.

Tools ➞ Image Overlay for... Opens the Image Overlay window for the active data.

Tools ➞ Colorize xx_SEQ Opens the Colorized View tab for the active sequence. Note: This menu item is 
only available if “Show Advanced Options” is selected in the Preferences.

Tools ➞ Transillumination 
Overview

Combines the images of a FLIT sequence into a single image (intensities are 
summed) that can be analyzed using tools in the tool palette.

Acquisition ➞ Background ➞ 
Replace

Opens a dialog box that enables you to select an instrument luminescent 
background. This background measurement is subtracted from luminescent 
images.

Acquisition ➞ Background ➞ 
View Available Dark Charge

Opens a dialog box that enables you to view the dark charge measurements for 
the system.

Acquisition ➞ Background ➞ 
Clear Available Dark Charge

Opens a dialog box that enables you to remove the dark charge measurements 
from the system.

Acquisition ➞ Background ➞ 
Measure

Opens a dialog box that enables you to acquire a dark charge measurement.

Acquisition ➞ Fluorescent 
Background ➞ Add or Replace 
Fluorescent Background

Opens a dialog box that enables you to select an instrument fluorescent 
background measurement for the active image data. If the Sub Fluor Bkg option 
is chosen in the control panel, the background measurement is subtracted from 
the image data.

Acquisition ➞ Fluorescent 
Background ➞ Measure 
Fluorescent Background

Starts a measurement of the instrument fluorescent background.

Acquisition ➞ Fluorescent 
Background ➞ Add or Replace 
Fluorescent Background

Opens a dialog box that enables you to select a fluorescent background 
measurement.

Table I.1  Menu bar commands and toolbar buttons

Menu Bar Command Toolbar 
Button

Description
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Acquisition ➞ Fluorescent 
Background ➞ Clear Available 
Fluorescent Background

Opens a dialog box that enables you to remove the fluorescent background 
measurements from the system.

Acquisition ➞ Fluorescent 
Background ➞ View Available 
Fluorescent Background

Opens a dialog box that displays the fluorescent background measurements for 
the system. If a fluorescent background is selected, the Sub Fluor Bkg option 
appears in the control panel. Choose the Sub Fluor Bkg option to subtract the 
user-specified background measurement from the image data.

Window ➞ Close Closes the active image window.

Window ➞ Close All Closes all image windows.

Window ➞ Cascade Organizes the open image windows in a cascade arrangement (see page 48).

Window ➞ Tile Organizes the open image windows in a tiled arrangement (see page 49).

Window ➞ 1. xx

Window ➞ 2. xx

Window ➞ etc.

A list of the open data. Select the data of interest to it the active window and 
display it on top of all other open windows.

Window ➞ Other Windows ➞ 
Browser Window

If the Living Image browser is open, makes it the active window and displays it 
on top of all other open windows.

Help ➞ User Guide Displays the online help.

Help ➞ About Living Image Displays the online help index.

Click this button, then click an item in the user interface to display information 
about the item.

Table I.1  Menu bar commands and toolbar buttons

Menu Bar Command Toolbar 
Button

Description

Table I.2  Keyboard shortcuts

Keys Shortcut Description

Ctrl + B Opens the Living Image browser.

Ctrl + C Copies the active image to the system clipboard.

Ctrl + D Arranges open windows in a cascade.

Ctrl + O Displays a dialog box that enables you to open data.

Ctrl + P Open the Print dialog box.

Ctrl + S Saves the active file or window.

Ctrl + T Tiles the open windows.

Ctrl + W Closes the active window.

Shift + F1 Changes the mouse pointer to the “What’s This” tool . 

Click this button, then click an item in the user-interface to display information about the item.
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Index

Numerics
3D fluorescent sources 142–143
3D image

rotate or move 152
3D luminescent sources 138–141
3D perspective 155
3D reconstruction

fluorescent sources 142–143
parameters & options 238–241

3D reconstruction results 144–146
3D tools 148–173

Animation tab 168–169
Mesh tab 156–157
Organs tab 161–162
Volume tab 158–159

A
acquire

image sequence 30–31
single bioluminescence image 14–17
single fluorescence image (epi-illumination) 17–18
single fluorescence image (trans-illumination) 

19–21
adaptive fluorescent background subtraction 221
adjusting image appearance 52
angle limit 239
animation 168–173

custom 171–172
edit an animation setup 172–173
preset 170–171

auto exposure feature 13
autofluorescence 79, 215

miscellaneous material 217–219
See tissue autofluorescence.
subtract using background filters 223–224
well plate 216–217

autoluminescence 79
automatically draw ROIs 76–77
average background ROI 70, 79

B
background

adaptive fluorescent background subtraction 221
fluorescent 215–221

light on sample 204–206
tissue autofluorescence 223–224

background light
from sample 206–208
on sample 204–206

background-corrected signal 79–81
band gap 212
bandpass filter 211
binning 55, 56, 192–194
bioluminescence image 14–17
browse image data 35–37
browser 36

C
Caliper Corporation

technical support 3
cascade images 48
color table 197
colorize data 63–64
composite image 98–101
control panel 13, 177–180
conventions 2
copy

ROI measurements 92
correction/filtering tools

binning 55
cosmic correction 55
dark background subtraction 55
flat field correction 55
smoothing 55

cosmic correction 55
cosmic ray corrections 202
counts 199
crop box 62

D
dark background subtraction 55
dark charge 204
dark current 203
data

graphic image 197
scientific image 197

detection efficiency 191
detection sensitivity
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adjusting the lens aperture 191
exposure time 192
field of view 192

diffusion model 226
display modes 46
display units

counts 199
efficiency 201
photons 200

DLIT
troubleshooting 175

DLIT results 144–146
manage 173

drift correction 203

E
edit

image sequence 28–30
edit image sequence 42–43
efficiency 201, 211, 214–215
electronic background

dark charge 204
dark current 203
drift 203
read bias 203

export image data 34
exposure time 192

F
f/stop

fluorescent imaging 214
field of view 192
filter

bandpass 211
fluorescent 212

filter spectra 211
flat field correction 55
flat fielding 202
FLIT

troubleshooting 175
FLIT results 144–146

manage 173
fluorescence

adaptive background subtraction 221
reconstruct 3D sources 142–143

fluorescence efficiency 214–215
fluorescence image (epi-illumination) 17–18

fluorescence image (trans-illumination) 19–21
fluorescence imaging components 209–211
fluorescent filters 212
fluorescent imaging

efficiency 211
f/stop 214
normalization 211

focus manually 32–33
FOV settings 180

G
graphic image data 197

H
High Reflectance Hemisphere 205
histogram 59

I
image

adjusting appearance 52
cascade 48
correct or filter 55–56
correcting/filtering tools 55–56
histogram 59
image window 45–46
information 49
label 51
line profile 60
magnify or pan 54
measurements 61
pixel data 58
tag 48
thumbnails 40
tile 48

image analysis tools 8
image data

browse 35–37
colorize 63–64
export 34
open 37–39
save manually 33

image information 56–57
image layout window 66–67
image math 98–101
image overlay tool 104–106
image sequence 40–43

acquire 30–31
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analyses 8
application-specific 22
create from individual images 43–44
edit 28–30, 42–43
imaging wizard 23–25
manual setup 25–27

image window 16
3D perspective 155
display modes 46

image window (single image) 45–46
imaging & image analysis

example workflow 7
overview 5–8

imaging wizard 23–25
index of refraction 145
information about an image 49
initialization

See system initialization.
instrument fluorescent background

background
instrument fluorescent background 221

IVIS Imaging System
fluorescence imaging components 209–211

K
kappa 145
kappa limits 145, 240

L
lens aperture 191
line profile 60
Living Image browser 36
Living Image software

help 10
starting 9

luciferase spectrum 227
luminescence

reconstruct 3D sources 138–141

M
magnify image 54
manual

focusing 32–33
save data 33

manual conventions 2
measurement ROI

automatically draw 76–77

measurement ROIs 70, 74–77
free draw 78

measurements 61
menu commands 243
mesh

drawing style 153
lighting style 153

miscellaneous material autofluorescence 217–219
multiple reporters per photograph 104–106

N
N surface limits 145, 240
NNLS

optimization 145, 241
weighted fit 145, 241

normalization 211

O
open image data 37–39
optical density 212
optical properties for planar spectral imaging 227
organ atlas 167
organs 162–166
overlay 198
overlaying images 104–106
overview

imaging & image analysis 5–8

P
pan image 54
PCA biplot 122
PCA explained variance 123
photon density 146
photon density map

measured 146
simulated 146

photon radiance 200
photons 200
pixel 197
pixel data 58
planar spectral analysis

optimizing precision 231
planar spectral image analysis 107–109
planar spectral imaging 225–231

diffusion model 226
intensity graph 111
linear fit graph 111
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luciferase spectrum 227
optical properties 227
results 110
tools 109–110

point source fitting 129–133
results 134–135
tools 129–132

preferences 181–189
pseudocolor image 197

R
radiance

photon 200
radiance units 200
read bias 203
reconstruct 3D fluorescent sources 142–143
reconstruct 3D luminescent sources 138–141
reduced Chi2 145
ROI 69

automatically draw 76–77
background-corrected signal 79–81
delete 90
edit dimensions 86
edit position 86
free draw 78
managing 82
manually draw 75–76
measurement ROI

free draw 78
measurement ROIs 74–77
Measurements table 74
move 85
move or edit label 88
quick guide 73
ROI line 87
save 89
subject 78
tools 71–72

ROI Measurements table 91–93
configure 93–95
copy or export 95

ROI properties 82–84
ROI types

average background 70, 79
measurement 70
subject 70

S
save

ROI 89
save data manually 33
scientific image data 197
segment 28
smoothing 55, 56, 194
source spectrum 146
spectral imaging

See planar spectral imaging.
spectral unmixing 113–116

options 120–121
parameters 118–119
PCA biplot 122
PCA explained variance 123
results 117–118

starting the software 9
starting the system

See system initialization.
steradian 200
subject ROI 70, 78
surface topography 125–126
system

FOV 180
initialization 11
optics autofluorescence 221
temperature 12

T
tag an image 48
technical support 3
temperature 12
threshold angle 145
tile images 48
tissue autofluorescence 223–224

eliminate by spectral unmixing 113–116
subtracting with background filters 101–103

tissue properties 146
tool palette 40

3D tools 148–173
correcting/filtering 55–56
image information 56–57
point source fitting 129–132
ROI tools 71

toolbar 243
total source flux 144
transillumination overview 65
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troubleshooting guide 175

U
uniform surface sampling 145, 241
units

See display units.
user preferences 181–189

V
voxel 159, 235

size increment 240
size increments 145
size limits 145, 240

vsize
final 145
starting 145

W
well plate autofluorescence 216–217

X
x,y coordinates 160
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